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บทคัดยอ 
 

การวิจัยครั้งนี้มีวัตถุประสงคเพ่ือพัฒนาบทเรียนผานเครือขายอินเทอรเน็ต เรื่อง โปรแกรม
คอมพิวเตอรกราฟกเบื้องตน ของนักเรียนชั้นมัธยมศึกษาปที่ 1 ที่มีคุณภาพและประสิทธิภาพ และ
เพ่ือเปรียบเทียบผลสัมฤทธิ์ทางการเรียนของนักเรียนที่เรียนดวยบทเรียนผานเครือขายอินเทอรเน็ต 
เรื่อง โปรแกรมคอมพิวเตอรกราฟกเบ้ืองตน ระหวางกอนเรียนกับหลังเรียน กลุมตัวอยางท่ีใชในการ
วิจัย คือ นักเรียน จํานวน 40 คน โรงเรียนอนุบาลเมืองนครสวรรค (เขากบ วิวรณสุขวิทยา) 
ชั้นมัธยมศึกษาศึกษาปที่ 1 เครื่องมือในการวิจัยในครั้งนี้ประกอบดวย บทเรียนผานเครือขาย
อินเทอรเน็ต เร่ือง โปรแกรมคอมพิวเตอรกราฟกเบื้องตน  แบบประเมินคุณภาพของบทเรียนและ
แบบทดสอบวัดผลสัมฤทธิ์ทางการเรียน ซี่งมีคาความยากงาย (p) ระหวาง 0.38-0.76 คาอํานาจ
จําแนก (r) ระหวาง 0.29-0.76 และมีคาความเชื่อถือได (KR-20) เทากับ 0.87 สถิติที่ใชในการ
วิเคราะห คือ คารอยละ คาเฉลี่ย สวนเบี่ยงเบนมาตรฐาน และการทดสอบคาที (t-test) ชนิดสองกลุม
ไมเปนอิสระตอกัน  

บทเรียนผานเครือขายอินเทอรเน็ต เรื่อง โปรแกรมคอมพิวเตอรกราฟกเบ้ืองตน มีคุณภาพ
ดานเนื้อหา และเทคนิคการออกแบบในระดับดีมาก (  = 4.71 , S = 0.46) และมีคุณภาพดาน
เทคโนโลยีมัลติมีเดียในระดับดี (  = 4.46 , S = 0.58) มีคาประสิทธิภาพของกระบวนการตอผลลัพธ
เทากับ 80.33/80.08 และนักเรียนมีผลสัมฤทธิ์ทางการเรียนหลังเรียนสูงกวากอนเรียนอยางมี
นัยสําคัญทางสถิติที่ระดับ .01 
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ABSTRACT 
 

The objective of this research was to develop the quality of the Web-Based 
Instruction (WBI) on Basic Computer Graphic Programs for seven grade students and 
to compare learning achievement of the students before and after learning the WBI 
with the instruction. The sample of the study comprised of 40 seven grade students 
at Anuban Mueang Nakhon Sawan School ( Khao Kop Wiworn Sukkha Wittaya) . 
The research instruments were Web-Based Instruction on Basic Computer Graphic 
Programs, a Web- Based Instruction assessment form and learning achievement test 
(with p = 0.38-0.76 , r = 0.29-0.76 and KR-20 = 0.87) The data were analyzed by using 
percentage, arithmetic mean, standard deviation and t-test for dependent samples. 

The result of the research was found as follows; the Web-based Instruction 
on Basic Computer Graphic Programs was at a high level in the Content quality and 

design techniques (  =  4.71 , S =  0.46)  and at the a highest level in the media 

technology quality (  =  4.49 , S =  0.58) was 80.33/80.08. In addition, the students’ 
achievement is higher than before learning at the .01 level of significance. 
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บทท่ี 1  

บทน ำ 

 
1.1  ควำมเป็นมำและควำมส ำคัญของปัญหำ 
 

กระทรวงศึกษาธิการ เป็นองค์กรหลักในการผลิตและพัฒนาทรัพยากรบุคคลของชาติ 
เพ่ือสร้างความเป็นอยู่ที่ดี สร้างความมั่งคั่งทางด้านเศรษฐกิจและความมั่นคงทางสังคมให้กับประเทศ
ด้วยฐานความรู้ ความคิดสร้างสรรค์และศักยภาพของประเทศ โดยมีพันธกิจในการพัฒนา ยกระดับ
และจัดการศึกษาเพ่ือเพ่ิมศักยภาพ และขีดความสามารถให้ประชาชนได้มีอาชีพที่สามารถสร้างรายได้
ที่มั่งคั่งและมั่นคง เพ่ือให้เป็นบุคลากรที่มีวินัยเปี่ยมไปด้วย คุณธรรม จริยธรรม มีส านึกความ
รับผิดชอบต่อตนเอง ผู้อ่ืน และสังคม (แผนแม่บทเทคโนโลยีสารสนเทศและการสื่อสารเพ่ือการศึกษา
กระทรวงศึกษาธิการ. 2556 : 6) ในด้านการจัดการศึกษาโดยเฉพาะด้านการพัฒนาการใช้เทคโนโลยี
สารสนเทศเพ่ือการศึกษาให้ทัดเทียมกับนานาชาตินั้น เป็นนโยบายที่มีความส าคัญยิ่ง โดยรัฐบาลได้
ก าหนดแนวนโยบายที่ชัดเจนเพื่อเร่งพัฒนาการใช้เทคโนโลยีสารสนเทศเพ่ือการศึกษาให้เป็นเครื่องมือ
ยกระดับคุณภาพและกระจายโอกาสทางการศึกษาให้มีระบบการเรียนแบบอิเล็กทรอนิกส์แห่งชาติ
เป็นกลไกในการปรับเปลี่ยนกระบวนทัศน์ของการเรียนรู้โดยเน้นผู้เรียนเป็นศูนย์กลางและเอ้ือให้เกิด
การเรียนรู้ตลอดชีพ (ส านักเทคโนโลยีเพ่ือการเรียนการสอน ส านักงานคณะกรรมการการศึกษาขั้น
พ้ืนฐาน. 2555 : 2) 

การศึกษาไทยในอดีต นักเรียนจะค้นคว้าหาความรู้ได้จากแหล่งข้อมูลเฉพาะห้องสมุด 
ในสถานศึกษาและหน่วยงานการศึกษาบางแห่งเท่านั้น สถานที่ในการเรียนการสอนจะถูกจัดไว้ 
ตามห้องเรียนเพียงอย่างเดียวนักเรียนไม่สามารถจัดการเวลาในการเรียนได้  ต้องเข้าเรียน  
ตรงตามเวลาและสถานที่ตามระบุ ไว้ เท่ านั้ น  สถานศึกษาบางแห่ ง เมื่ อนักเรียนขาดเรียน  
เกินเกณฑ์ก าหนด ส่งผลให้ไม่มีสิทธิ์สอบวัดผลได้ เมื่อเข้าสู่ยุค สมัยของเครือข่ายสารสนเทศ 
และการสื่อสาร (ICT) ที่มีความก้าวหน้าไปอย่างรวดเร็ว สถานศึกษาต่าง ๆ ได้พยายามปรับตัว 
เพ่ือน าเอาสื่อ ICT มาช่วยจัดการเรียนการสอนอย่างเป็นรูปธรรมมากขึ้น การเรียนการสอนด้วยสื่อ 
ICT ไม่ได้เพ่ิงเริ่มเกิดขึ้น แต่มีมานานแล้วและถูกน าไปใช้อย่างแพร่หลาย เมื่อเครือข่ายอินเทอร์เน็ต
ขยายตัวมากขึ้น การศึกษาแบบใหม่ที่เน้นเอาสื่อ ICT มาช่วยในการจัดการเรียนการสอนได้แพร่หลาย
ไปยังสถานศึกษาต่าง ๆ บางแห่งมีการจัดการศึกษาโดยขยายโอกาสและสร้างวิทยาเขตเพ่ิมมากขึ้น 
การเรียนการสอนใช้สื่อ ICT มาแลกเปลี่ยนสร้างสังคมแห่งการเรียนรู้อย่างต่อเนื่องรูปแบบที่พบเห็น
และมีใช้กันมากที่สุดคือการสร้างระบบการบริหารจัดการการเรียนรู้ หรือ Learning Management 
System (LMS) เพ่ือให้ครูและนักเรียนสามารถเข้ามาใช้ร่วมกันได้ ระบบดังกล่าวประกอบด้วยเนื้อหา 
หลักสูตรและเครื่องมือการเรียนการสอนต่าง ๆ ที่มีไว้ให้บริการ เพ่ือสร้างการเรียนแบบไม่จ ากัด
สถานที่และเวลา (Anywhere Anytime) บทเรียนการสอนจะถูกปรับใช้เป็นสื่อการสอนที่ทันสมัย
ผ่านเครือข่ายอินเทอร์เน็ต (ส านักเทคโนโลยีเพ่ือการเรียนการสอน ส านักงานคณะกรรมการการศึกษา
ขั้นพ้ืนฐาน. 2555 : 94) 
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ปัจจุบันจึงได้มีการพัฒนาระบบการเรียนการสอนขึ้นมาใช้งานบนเครือข่ายอินเทอร์เน็ต 
กลายเป็ นบท เรียนช่ วยสอนบนอิน เทอร์ เน็ ต  (WBI:Web-Based Instruction) คื อบทเรียน
คอมพิวเตอร์ช่วยสอนบนเครือข่ายอินเทอร์เน็ต ผู้เรียนกับครูผู้สอนสามารถติดต่อสื่อสารถึงกันได้โดย
ผ่านทางเครือข่ ายอิน เทอร์ เน็ ต  และมีการใช้คอมพิวเตอร์ช่ วยสอน (Computer Assisted 
Instruction: CAI) หมายถึง การน าคอมพิวเตอร์มาเป็นเครื่องมือสร้างให้เป็นโปรแกรมคอมพิวเตอร์
เพ่ือให้ผู้เรียนน าไปเรียนรู้ด้วยตนเองและเกิดการเรียนรู้ โปรแกรมจะประกอบไปด้วยเนื้อหาวิชา
แบบฝึกหัด แบบทดสอบ นอกจากนี้ยังมี ลักษณะในการน าเสนออาจมีทั้งตัวหนังสือ ภาพกราฟิก 
ภาพเคลื่อนไหว สี หรือเสียง เพ่ือดึงดูดให้ผู้เรียนเกิดความสนใจมากยิ่งขึ้น อีกท้ังยังแสดงผลการเรียน
ให้ทราบทันทีด้วยข้อมูลย้อนกลับแก่ผู้เรียน (นันทนา หนูช่วย. 2554 : 78) 
             โรงเรียนอนุบาลเมืองนครสวรรค์(เขากบ วิวรณ์สุขวิทยา) เป็นโรงเรียนขยายโอกาส สังกัด 
ส านักงานเขตพ้ืนที่การศึกษาประถมศึกษานครสวรรค์ เขต 1 ตั้งอยู่ในเขตเทศบาลนครนครสวรรค์ 
จังหวัดนครสวรรค์ เปิดท าการสอนตั้งแต่ระดับชั้นปฐมวัยถึงระดับชั้นมัธยมศึกษาตอนต้น มีนักเรียน
ทั้งหมด 1,542 คน นักเรียนส่วนใหญ่มีฐานะยากจน และเป็นเด็กพิเศษ นักเรียนที่เป็นเด็กพิเศษมักจะ
มีความสามารถในการเรียนรู้และรับความรู้ค่อนข้างช้า ในการที่ผู้วิจัยได้จัดการเรียนการสอนรายวิชา
การงานอาชีพและเทคโนโลยี เรื่อง โปรแกรมคอมพิวเตอร์กราฟิกเบื้องต้น ของนักเรียนชั้น
มัธยมศึกษาปีที่ 1 จากการจัดการเรียนการสอนที่ผ่านมาพบว่า เมื่อนักเรียนเกิดปัญหาไม่เข้าใจใน
เนื้อหาที่เรียน และเรียนรู้ได้ช้า อีกทั้งมีข้อจ ากัดด้านเวลา และสถานที่ ในการพูดคุยและซักถาม
ระหว่างครผูู้สอนและนักเรียน ท าให้นักเรียนไม่สามารถเรียนรู้ และซักถามในเนื้อหาที่ไม่เข้าใจไดอ้ย่าง
เต็มที่ จากการสัมภาษณ์ครูผู้สอนระดับชั้นมัธยมศึกษาปีที่ 1 โรงเรียนอนุบาลเมืองนครสวรรค์(เขากบ 
วิวรณ์สุขวิทยา) ในรายวิชาอ่ืน 3-5 คน พบว่านักเรียนขาดทักษะการท างานอย่างเป็นระบบ ขาดการ
ปฏิสัมพันธ์กับคนรอบข้าง และขาดทักษะทางสังคม แนวทางในการแก้ไขปัญหานี้ ที่มีความน่าสนใจก็คือ
การน าเทคโนโลยีการเรียนการสอนด้วยบทเรียนผ่านเครือข่ายอินเทอร์เน็ต มาใช้ร่วมกับการจัดการ
เรียนรู้ในรายวิชาเทคโนโลยีสารสนเทศทีน่ักเรียนสามารถเข้ามาศึกษา และทบทวนเนื้อหารายละเอียด
ของบทเรียนได้ตลอดเวลา ช่วยขจัดข้อจ ากัด เรื่องเวลา และสถานที่ ส่งเสริม และพัฒนาให้นักเรียนให้
สามารถเรียนรู้ได้ด้วยตนเองตามระดับความรู้ และความสามารถที่แตกต่างกันของนักเรียนแต่ละ
บุคคล ช่วยให้นักเรียน เกิดการแลกเปลี่ยนประสบการณ์การเรียนรู้ และมีปฏิสัมพันธ์ทางสังคม 
ส่งเสริมให้นักเรียนสร้างองค์ความรู้ด้วยตนเอง ลดข้อจ ากัดด้านความขาดแคลน เวลา สถานที่ และ
เพ่ิมช่องทางการติดต่อสื่อสารระหว่างครูผู้สอนกับนักเรียน 

จากความส าคัญที่กล่าวมา ท าให้ผู้วิจัยมีความสนใจในการพัฒนาบทเรียนผ่านเครือข่าย
อินเทอร์เน็ต เรื่อง โปรแกรมคอมพิวเตอร์กราฟิกเบื้องต้น ของนักเรียนชั้นมัธยมศึกษาปีที่  1 
โดยนักเรียนสามารถศึกษาจากบทเรียนออนไลน์ของระบบการจัดการเรียนรู้ (LMS) และนักเรียน
สามารถเข้าศึกษาบทเรียน และทบทวนเนื้อหารายละเอียดของบทเรียนได้ตลอดเวลา ส่งเสริมและ
พัฒนาให้นักเรียนสามารถเรียนรู้ได้ด้วยตนเองตามระดับความรู้ และความสามารถที่แตกต่างกันของ
นักเรียนแต่ละบุคคล โดยนักเรียนสามารถเรียนรู้ได้ด้วยตนเอง หรือร่วมกับเพ่ือนในห้องเรียน เกิดการ
แลกเปลี่ยนเรียนรู้ มีทักษะในการท างาน และเรียนรู้ร่วมกัน อีกทั้งเห็นคุณค่าของตนเอง และยอมรับ
ความคิดเห็นของผู้อ่ืน เกิดการเรียนรู้อย่างมีประสิทธิภาพ ท าให้ผลสัมฤทธิ์ทางการเรียนสูงขึ้น และ
เป็นแนวทางในการจัดกระบวนการเรียนรู้ให้มีประสิทธิภาพมากยิ่งขึ้น เพ่ือประโยชน์ต่อการศึกษาต่อไป 
 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 
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1.2  วัตถุประสงค์ของกำรวิจัย 
 

1.2.1  เพ่ือพัฒนาบทเรียนผ่านเครือข่ายอินเทอร์เน็ต เรื่อง โปรแกรมคอมพิวเตอร์กราฟิก
เบื้องต้น ของนักเรียนชั้นมัธยมศึกษาปีที่ 1 ที่มีคุณภาพและประสิทธิภาพ 
 

1.2.2  เพ่ือเปรียบเทียบผลสัมฤทธิ์ทางการเรียนของนักเรียนก่อนกับหลังเรียนด้วยบทเรียน 
ผ่านเครือข่ายอินเทอร์เน็ต เรื่อง โปรแกรมคอมพิวเตอร์กราฟิกเบื้องต้น ของนักเรียนชั้นมัธยมศึกษา 
ปีที่ 1 
 
1.3  สมมติฐำนของกำรวจัิย 
 

ผลสัมฤทธิ์ทางการเรียนของนักเรียนที่เรียนด้วยบทเรียนผ่านเครือข่ายอินเทอร์เน็ต เรื่อง 
โปรแกรมคอมพิวเตอร์กราฟิกเบื้องต้น ของนักเรียนชั้นมัธยมศึกษาปีที่ 1 หลังเรียนสูงกว่าก่อนเรียน 
 
1.4  กรอบแนวคิดที่ใช้ในกำรวิจัย 
 

1.4.1  กรอบแนวคิดในกำรพัฒนำบทเรียน 
ในการวิจัยครั้งนี้ผู้วิจัยได้น าแนวคิดในการพัฒนาบทเรียนผ่านเครือข่ายอินเทอร์เน็ต  

โดยใช้ขั้นตอนในรูปแบบ ADDIE Model ของ Roderic, Slims มาปรับปรุงขั้นตอนให้เป็นขั้นตอน
การพัฒนาบทเรียนคอมพิวเตอร์ โดยครอบคลุมสาระส าคัญในการออกแบบบทเรียนคอมพิวเตอร์
ทั้งหมด (อ้างใน มนต์ชัย เทียนทอง. 2548 : 131) ซึ่งประกอบด้วย 5 ขั้นตอน ดังนี้ 

1.  การวิเคราะห์ (Analysis) 
2.  การออกแบบ (Design) 
3.  การพัฒนา (Development) 
4.  การน าไปใช้ (Implementation) 
5.  การประเมินผล (Evaluation) 

 

1.4.2  กำรหำคุณภำพของบทเรียนบนครือข่ำยอินเทอร์เน็ต 
ผู้วิจัยน าแนวคิดของไพโรจน์ ตีรณธนากุล และคณะ (2546 : 197-214) มาประยุกต์เป็น

กรอบแนวคิดในการหาคุณภาพของบทเรียนผ่านเครือข่ายอินเทอร์เน็ต เรื่อง โปรแกรมคอมพิวเตอร์
กราฟิกเบื้องต้น ของนักเรียนชั้นมัธยมศึกษาปีที่ 1  ซึ่งแบ่งเป็น 2 ด้าน ดังนี้ 

1.4.2.1  ด้านเนื้อหาและเทคนิคการออกแบบ ความถูกต้องเหมาะสมของการ
น าเสนอเนื้อหาบนหน้าจอกราฟิกและการออกแบบเนื้อหา และเทคนิคการออกแบบบทเรียน 
ความถูกต้องของเนื้อหาที่น าเสนอโดยสื่อที่เหมาะสม ความถูกต้องของวิธีน าเสนอสื่อ 

1.4.2.2  ด้านเทคโนโลยีมัลติมีเดีย การออกแบบตัวอักษร ความเหมาะสมของการ
ใช้ภาพ ความเหมาะสมของการใช้เสียง และปฏิสัมพันธ์ของผู้เรียนกับบทเรียน การน าเสนอมัลติมีเดีย 
การตรวจสอบการปฏิสัมพันธ์โครงสร้างของบทเรียน 
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1.4.3  กรอบแนวคิดในกำรหำประสิทธิภำพของบทเรียน 
ผู้วิจัยได้น าแนวคิดการค านวณหาประสิทธิภาพของบทเรียนของชัยยงศ์ พรหมวงศ์ (2542 : 

136) ด้วยวิธี (E1/E2) 
ประสิทธิภาพของกระบวนการ (E1) ซึ่งคิดจากคะแนนเฉลี่ยของนักเรียนทั้งหมด

จากการท าแบบฝึกหัดท้ายหน่วยการเรียนด้วยบทเรียน 
ประสิทธิภาพของผลลัพธ์  (E2) ซึ่งคิดจากคะแนนเฉลี่ยของนักเรียนทั้งหมด 

ที่ท าแบบทดสอบหลังเรียนด้วยบทเรียน 
 

1.4.4  กรอบแนวคิดของกำรวัดผลสัมฤทธิ์ทำงกำรเรียน 
ในการวัดผลสัมฤทธิ์ทางการเรียน ผู้วิจัยใช้กรอบแนวคิดของ Bloom (1976 : 167-176) 

กล่าวถึงการประเมินผลการเรียนด้านสติปัญญา หรือ ความรู้ความคิด 6 ระดับ แต่ในการวิจัยครั้งนี้ 
ผู้วิจัยได้ใช้การประเมิน 3 ระดับ ได้แก่ 

1.  ความรู้ความจ า (Knowledge) 
2.  ความเข้าใจ (Comprehension) 
3.  การน าความรู้ไปประยุกต์ (Application) 

 
1.5  ขอบเขตของกำรวิจัย 
 

1.5.1  ประชำกร 
นักเรียนชั้นมัธยมศึกษาปีที่ 1 ภาคเรียนที่ 2 ปีการศึกษา 2561 โรงเรียนอนุบาลเมือง

นครสวรรค์ (เขากบ วิวรณ์สุขวิทยา) สังกัดส านักงานเขตพ้ืนที่การศึกษาประถมศึกษานครสวรรค์ 
เขต 1 จ านวน 4 ห้องเรียน จ านวน 160 คน 
 

1.5.2  กลุ่มตัวอย่ำง 
นักเรียนชั้นมัธยมศึกษาศึกษาปีที่ 1 ภาคเรียนที่ 2 ปีการศึกษา 2561 โรงเรียนอนุบาลเมือง

นครสวรรค์ (เขากบ วิวรณ์สุขวิทยา) สังกัดส านักงานเขตพ้ืนที่การศึกษาประถมศึกษานครสวรรค์ 
เขต 1 ที่ได้มาจากการสุ่มตัวอย่างแบบแบ่งกลุ่ม (Cluster Random Sampling) จ านวน 1 ห้องเรียน 
จ านวน 40 คน 
 

1.5.3  ตัวแปรที่ศึกษำ 
1.5.3.1  คุณภาพของบทเรียนผ่านเครือข่ายอินเทอร์เน็ต เรื่อง โปรแกรม

คอมพิวเตอร์กราฟิกเบื้องต้น จ าแนกเป็น 
(1)  คุณภาพด้านเนื้อหาและเทคนิคการออกแบบ 
(2)  คุณภาพด้านเทคโนโลยีมัลติมีเดีย 

1.5.3.2  ประสิทธิภาพของบทเรียนผ่านเครือข่ายอินเทอร์เน็ต เรื่อง โปรแกรม
คอมพิวเตอร์กราฟิกเบื้องต้น ของนักเรียนชั้นมัธยมศึกษาปีที่ 1 

1.5.3.3  เปรียบเทียบผลสัมฤทธิ์ทางการเรียนด้วยบทเรียนผ่านเครือข่าย
อินเทอร์เน็ต เรื่อง โปรแกรมคอมพิวเตอร์กราฟิกเบื้องต้น ตัวแปรจ าแนกเป็น 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆท้ังสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกคร้ังที่มีการนำไปใช้



5 
 

(1)  ตัวแปรต้น ได้แก่ การเรียนด้วยบทเรียนผ่านเครือข่ายอินเทอร์เน็ต 
เรื่อง โปรแกรมคอมพิวเตอร์กราฟิกเบื้องต้น ของนักเรียนชั้นมัธยมศึกษาปีที่ 1 

(2)  ตัวแปรตาม ได้แก่ ผลสัมฤทธิ์ทางการเรียนของนักเรียนด้วยบทเรียน
ผ่านเครือข่ายอินเทอร์เน็ต เรื่อง โปรแกรมคอมพิวเตอร์กราฟิกเบื้องต้น ของนักเรียนชั้นมัธยมศึกษาปีที่ 1 
 

1.5.4  ขอบเขตเนื้อหำ 
เนื้อหาของบทเรียนผ่านเครือข่ายอินเทอร์เน็ต เรื่อง โปรแกรมคอมพิวเตอร์กราฟิกเบื้องต้น 

ของนักเรียนชั้นมัธยมศึกษาปีที่ 1 ที่พัฒนาขึ้นเป็นเนื้อหาของวิชาเทคโนโลยีสารสนเทศ สาระการ
เรียนรู้การงานอาชีพและเทคโนโลยี รหัสวิชา ง 21202 แบ่งออกเป็น 5 หน่วยการเรียนรู้ ดังนี้ 

หน่วยการเรียนรู้ที่  1  ความรู้เบื้องต้นเกี่ยวกับคอมพิวเตอร์กราฟิก 
หน่วยการเรียนรู้ที่  2  หลักการสร้างงานกราฟิก และใช้ข้อมูลพื้นฐาน 
หน่วยการเรียนรู้ที่  3  การตัดต่อภาพ และการจัดวาง 
หน่วยการเรียนรู้ที่  4  การจัดข้อความ และเลเยอร์ 
หน่วยการเรียนรู้ที่  5  การตกแต่งภาพ และสร้างงานกราฟิกอย่างสร้างสรรค์ 

 
1.6  นิยำมศัพท์เฉพำะที่ใช้ในกำรวิจัย 
 

1.6.1  บทเรียนผ่ำนเครือข่ำยอินเทอร์เน็ต หมายถึง บทเรียนคอมพิวเตอร์ เรื่อง 
โปรแกรมคอมพิวเตอร์กราฟิกเบื้องต้น ของนักเรียนชั้นมัธยมศึกษาปีที่ 1 ผู้สอนออกแบบเนื้อหาโดยมี
การล าดับความส าคัญที่มีความต่อเนื่องกันของเนื้อหา มีการน าเสนอผ่านเครือข่ายอินเทอร์เน็ต 
ซึ่งบทเรียน และกิจกรรมการเรียนการสอนถูกจัดไว้อย่างเป็นระบบ สร้างขึ้นโดยใช้โปรแกรม Moodle 
โดยบทเรียนประกอบกิจกรรมการเรียนการสอนการทบทวน การท าแบบฝึกหัด และแบบวัดผล
สัมฤทธิ์ทางการเรียนผ่านระบบเครือข่ายอินเทอร์เน็ต 
 

1.6.2  โปรแกรมคอมพิวเตอร์กรำฟิกเบื้องต้น หมายถึง โปรแกรมส าเร็จรูปส าหรับท างาน
สร้างสรรค์ศิลปะดิจิตอลได้อย่างรวดเร็ว และง่ายดาย มีเครื่องมือในการตกแต่งภาพมากมาย 
เป็นโปรแกรมท่ีมคีวามสามารถที่หลากหลาย ยืดหยุ่นในการสร้าง จัดการ และแก้ไขภาพกราฟิก 
 

1.6.3  คุณภำพของบทเรียนผ่ำนเครือข่ำยอินเทอร์เน็ต หมายถึง ผลที่ได้จากการประเมิน
บทเรียนผ่านเครือข่ายอินเทอร์เน็ตของผู้ทรงคุณวุฒิ เรื่องโปรแกรมคอมพิวเตอร์กราฟิกเบื้องต้นของ
นักเรียนมัธยมศึกษาปีที่ 1 ที่ได้จากการประเมินคุณภาพของผู้ทรงคุณวุฒิ 2 ด้าน คือ 

(1)  ด้านเนื้อหาและเทคนิคการออกแบบ ประเมินจากผู้ทรงคุณวุฒิ 3 ท่าน 
(2)  ด้านเทคโนโลยีมัลติมีเดีย ประเมินจากผู้ทรงคุณวุฒิ 3 ท่าน 

 

1.6.4  ประสิทธิภำพของบทเรียนผ่ำนเครือข่ำยอินเทอร์เน็ต หมายถึง อัตราส่วนของ
คะแนนเฉลี่ย ซึ่งคิดเป็นร้อยละจากประสิทธิภาพของกระบวนการกับประสิทธิภาพของผลลัพธ์ 
ตามเกณฑ์ที่ก าหนด (E1/E2) 

ประสิทธิภาพของกระบวนการ (E1) ซึ่งคิดจากคะแนนเฉลี่ยของนักเรียนทั้งหมดจากการท า
แบบฝึกหัดท้ายหน่วยการเรียนด้วยบทเรียน 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆท้ังสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกคร้ังที่มีการนำไปใช้
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ประสิทธิภาพของผลลัพธ์ (E2) ซึ่ งคิดจากคะแนนเฉลี่ยของนักเรียนทั้ งหมดที่ท า
แบบทดสอบหลังเรียนด้วยบทเรียน 
 

1.6.5  ผลสัมฤทธิ์ทำงกำรเรียน หมายถึง คะแนนที่นักเรียนได้จากการท าแบบทดสอบ 
วิชาเทคโนโลยีสารสนเทศ เรื่อง คอมพิวเตอร์กราฟิกเบื้องต้น ซึ่ งเป็นข้อสอบที่ผู้วิจัยสร้างขึ้น 
โดยแบ่งเป็นผลสัมฤทธิ์ทางการเรียนระหว่างเรียน และหลังเรียน และวัดพฤติกรรมการเรียนรู้ 3 ด้าน
คือ ความรู้ความจ า ความเข้าใจ และการน าไปใช้ 
 

1.6.6  นักเรียน หมายถึง นักเรียนชั้นมัธยมศึกษาปีที่ 1 โรงเรียนอนุบาลเมืองนครสวรรค์ 
(เขากบ วิวรณ์สุขวิทยา) อ าเภอเมือง จังหวัดนครสวรรค์ สังกัดส านักงานเขตพ้ืนที่การศึกษา
ประถมศึกษานครสวรรค์ เขต 1 ภาคเรียนที่ 2 ปีการศึกษา 2561 ที่เรียนวิชาเทคโนโลยีสารสนเทศ 
รหัสวิชา ง21202 เรื่อง โปรแกรมคอมพิวเตอร์กราฟิกเบื้องต้น 
 

1.6.7  โรงเรียน หมายถึง โรงเรียนอนุบาลเมืองนครสวรรค์ (เขากบ วิวรณ์สุขวิทยา)  
อ าเภอเมือง จังหวัดนครสวรรค์ สังกัดส านักงานเขตพ้ืนที่การศึกษาประถมศึกษานครสวรรค์ เขต 1 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 
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บทท่ี 2 
เอกสารและงานวิจยัที่เกี่ยวข้อง 

 
ในการวิจัยการพัฒนาบทเรียนผ่านเครือข่ายอินเทอร์เน็ต เรื่อง โปรแกรมคอมพิวเตอร์

กราฟิกเบื้องต้น ของนักเรียนชั้นมัธยมศึกษาปีที่ 1 ผู้วิจัยได้ศึกษาเอกสาร และงานวิจัยที่เกี่ยวข้องดังนี้ 
 2.1  หลักสูตรรายวิชาเทคโนโลยีสารสนเทศ 
 2.2  บทเรียนผ่านเครือข่ายอินเทอร์เน็ต 
 2.3  การพัฒนาบทเรียนผ่านเครือข่ายอินเทอร์เน็ต 
 2.4  โปรแกรมท่ีใช้ในการพัฒนาบทเรียนผ่านเครือข่ายอินเทอร์เน็ต 
 2.5  การหาคุณภาพของบทเรียนผ่านเครือข่ายคอมพิวเตอร์ 
 2.6  การหาประสิทธิภาพของบทเรียนผ่านเครือข่ายคอมพิวเตอร์ 
 2.7  ทฤษฎีการเรียนรู้ของ Bloom 
 2.8  การหาผลสัมฤทธิ์ทางการเรียน 
 2.9  งานวิจัยที่เกี่ยวข้อง 
 
2.1  หลกัสูตรรายวิชาเทคโนโลยีสารสนเทศ 
 

หลักสูตรวิชาเทคโนโลยีสารสนเทศ ชั้นมัธยมศึกษาปีที่ 1 กลุ่มสาระการเรียนรู้การงาน
อาชีพ และเทคโนโลยี รหัสวิชา ง21202 เทคโนโลยีสารสนเทศ มีรายละเอียดดังนี้ 
 

2.1.1  ค าอธิบายรายวิชา 
ง21202 เทคโนโลยีสารสนเทศ กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยี 

ชั้นมัธยมศึกษาปีที่ 1 เวลา 40 ชั่วโมง 
ศึกษาวิเคราะห์เนื้อหา ล าดับรูปแบบงาน และใช้กระบวนการเทคโนโลยีสารสนเทศ 

ในการสืบค้นข้อมูล รวบรวมข้อมูล เรียนรู้การท างานของโปรแกรมกราฟิก การสร้างภาพกราฟิกจาก
โปรแกรมคอมพิวเตอร์กราฟิก เพ่ือน าไปใช้สร้างชิ้นงาน การออกแบบงานกราฟิกต่าง ๆ และการ
น าเสนอผลงาน รู้จักแก้ปัญหา และท างานอย่างมีประสิทธิภาพ 

โดยให้ผู้เรียนแสดงออกด้วยการเรียนรู้ในเรื่องการใช้งานโปรแกรมคอมพิวเตอร์กราฟิกและ
น าความรู้ที่ได้ไปประยุกต์ใช้ให้เหมาะสมกับตนเอง และใช้ในชีวิตประจ าวันได้อย่างคุ้มค่า 
 

2.1.2  จุดประสงค์การเรียนรู้ 
2.1.2.1  นักเรียนรู้ความหมาย และความส าคัญของโปรแกรมคอมพิวเตอร์กราฟิก 

 2.1.2.2  นักเรียนสามารถบอกส่วนประกอบ และการใช้งานโปรแกรมคอมพิวเตอร์กราฟิก 
 2.1.2.3  นักเรียนสามารถสร้างงานกราฟิกด้วยโปรแกรมคอมพิวเตอร์กราฟิก 
 
 
 
 
 
 
 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 
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2.1.3  เนื้อหา วิชาเทคโนโลยีสารสนเทศ ชั้นมัธยมศึกษาปีท่ี 1 
 

ตารางท่ี  2.1  โครงสร้างรายวิชาเทคโนโลยีสารสนเทศ 

หน่วยการเรียนรู้ สาระส าคัญ 
เวลา

(ชั่วโมง) 

1.  ความรู้เบื้องต้นเกี่ยวกับคอมพิวเตอร์
กราฟิก 

- ความหมายของโปรแกรมคอมพิวเตอร์
กราฟิก 
- ประเภทของไฟล์ภาพในงาน
คอมพิวเตอร์กราฟิก 
- ระบบสีในงานคอมพิวเตอร์กราฟิก 

4 

2.  หลักการสร้างงานกราฟิกและใช้ข้อมูล
พ้ืนฐาน 

- โปรแกรม Photoshop CS6 
- ส่วนประกอบของโปรแกรม 
Photoshop CS6 
- เครื่องมือ Toolbox และ Palette 
- การท างานกับ Layers 

6 

3.  การตัดต่อภาพ และ 
การจัดวาง 

- ชุดเครื่องมือส าหรับการเลือกพ้ืนที่ 
- การตัดพ้ืนหลังอย่างง่าย 
- การปรับรูปทรงของภาพด้วย 
Transform 

7 

4.  การจัดข้อความ และ 
เลเยอร์ 

- ชุดเครื่องมือส าหรับการสร้างข้อความ 
- ชุดเครื่องมือส าหรับการวาด 

8 

5.  การตกแต่งภาพและสร้างงานกราฟิก
อย่างสร้างสรรค์ 

- การปรับแต่งและแก้ไขสีให้กับภาพ 
- การใช้งาน Filter 
- การออกแบบปกแฟ้มสะสมผลงาน 

15 

 รวมชั่วโมงทั้งหมด 40 
 
2.2  บทเรียนผ่านเครือข่ายอินเทอร์เน็ต 
 

2.2.1  ความหมายของบทเรียนผ่านเครือข่ายอินเทอร์เน็ต 
การเรียนการสอนโดยใช้เทคโนโลยีสารสนเทศในปัจจุบันมีหลากหลายรูปแบบ เช่น

สื่อคอมพิวเตอร์ช่วยสอน (CAI : Computer Aided Instruction) สื่อการเรียนการสอนที่อยู่บนฐาน
ของเทคโนโลยีเว็บ (WBI : Web-Based Instruction) สื่อการเรียนการสอนในรูปแบบ E-Learning 
การศึกษาทางไกล เป็นต้น ซึ่งการเรียนโดยใช้เทคโนโลยีสารสนเทศจะส่งผลให้มีการปฏิสัมพันธ์
ระหว่างผู้เรียนกับผู้สอน เนื่องจากสื่อเป็นตัวกลางในการถ่ายทอดความรู้ ความเข้าใจ ทักษะต่าง ๆ 
จากผู้สอนไปยังผู้เรียนได้เป็นอย่างดี เปรียบเสมือนสะพานเชื่อมความคิดระหว่างกันและกัน หากสื่อ
ได้รับการออกแบบ พัฒนาอย่างดี ก็จะสามารถสร้างความเข้าใจในประเด็นที่ต้องการน าเสนอได้อย่าง
ถูกต้องด้วย การเรียนการสอนที่อยู่บนฐานของเทคโนโลยีเว็บ (Web-Based Instruction) เป็นการ
ผสมผสานกันผ่านเทคโนโลยีปัจจุบันกับกระบวนการออกแบบการเรียนการสอน  เพ่ือเพ่ิม

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆท้ังสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกคร้ังที่มีการนำไปใช้
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ประสิทธิภาพทางการเรียนรู้และแก้ปัญหาในเรื่องข้อจ ากัดทางด้านสถานที่และเวลา โดยการสอนบน
อินเทอร์เน็ตจะประยุกต์ใช้คุณสมบัติและทรัพยากรของเวิลด์ไวด์เว็บในการจัดสภาพแวดล้อม  
ที่ส่งเสริมและสนับสนุนการเรียนการสอน ซึ่งการเรียนการสอนที่จัดขึ้นผ่านเว็บนี้ อาจ เป็นบางส่วน
หรือทั้งหมดของกระบวนการเรียนการสอนก็ได้ (ถนอมพร เลาหจรัสแสง. 2545 : 87-94) จะเห็นได้ว่า 
การสอนผ่านเครือข่ายอินเทอร์เน็ตเป็นรูปแบบหนึ่งของการการสอนแบบเน้นผู้เรียนเป็นศูนย์กลาง 
เป็นแนวคิดที่มุ่งเน้นให้ ผู้เรียนได้มีบทบาท มีส่วนร่วมในการเรียนการสอนมากขึ้น ผู้เรียนจะเกิดการ
เรียนรู้โดยการลงมือ กระท า ปฏิบัติ แก้ปัญหาหรือศึกษาค้นคว้าด้วยตนเองและสามารถที่จะพัฒนา
ศักยภาพของตนเอง ซึ่งจะเป็นประโยชน์เป็นอย่างยิ่งส าหรับการจัดการเรียนการสอนในโรงเรียน 
 

2.2.2  หลักการออกแบบบทเรียนผ่านเครือข่ายอินเทอร์เน็ต  
  กระบวนการออกแบบบทเรียนและสร้างบทเรียนคอมพิวเตอร์ช่วยสอนสามารถแบ่ง
ขั้นตอนการพัฒนาตามโมเดล ADDIE ได้ดังนี้ (มนต์ชัย เทียนทอง. 2554 : 44) 

 
    

 
 
 
 
 
 
 

ภาพที่ 2.1  ขั้นตอนการพัฒนา ADDIE Model 
 

(1)  การวิเคราะห์ (Analysis) ประกอบด้วยขั้นตอนต่าง ๆ ดังนี้ 
(1.1)  ก าหนดหัวเรื่องและก าหนดวัตถุประสงค์ทั่วไป (Specify Title and Define 

General Objective) การพิจารณาเลือกหัวเรื่องที่น ามาสร้างบทเรียนคอมพิวเตอร์ช่วยสอน 
ควรค านึงถึงลักษณะของเนื้อหาวิชาให้เหมาะสมส าหรับการเรียนการสอนรายบุคคล เนื่องจากการ
เรียนด้วยบทเรียนคอมพิวเตอร์ช่วยสอนเป็นการเรียนรู้รายบุคคล ดังนั้นหัวเรื่องที่เหมาะสม ส าหรับ
การเรียนการสอนเป็นกลุ่มหรือเรียนด้วยวิธีอ่ืน หากน ามาสร้างเป็นบทเรียนคอมพิวเตอร์ช่วยสอนแล้ว
อาจไม่ได้ผลเท่าที่ควร จากผลการวิจัยส่วนมากเป็นที่ประจักษ์ว่า ลักษณะเนื้อหาวิชาที่ใช้ได้ผลดีกับ
บทเรียนคอมพิวเตอร์ช่วยสอน ได้แก่ วิชาทางด้านทฤษฎีที่เน้นความรู้ความเข้าใจในเนื้อหาส่วนวิชา
ทางด้านปฏิบัติหรือวิชาประลอง จะสร้างเป็นบทเรียนคอมพิวเตอร์ช่วยสอนได้ยาก อีกทั้งยังใช้ได้ผล
น้อยกว่าวิชาที่เน้นทางด้านพุทธิพิสัย 

เมื่อพิจารณาหัวเรื่องได้แล้ว สิ่งที่ต้องปฏิบัติตามมา ได้แก่ การก าหนดวัตถุประสงค์ทั่วไป
ของหัวเรื่องดังกล่าว ซึ่งจะเป็นตัวก าหนดเค้าโครง ขอบเขต และมโนมติของเนื้อหา ที่จะน าเสนอเป็น
บทเรียนคอมพิวเตอร์ช่วยสอน ผ่านเว็บ วัตถุประสงค์ทั่วไปที่ก าหนดขึ้นนี้ จะใช้เป็นแนวทางในการ
ออกแบบบทเรียนในขั้นต่อ ๆ ไปว่าควรจะเน้นเนื้อหาทางด้านใดผู้รับการฝึกจึงจะบรรลุเป้าหมายใน
การเรียน 

Analysis 

Evaluation 

Development 

Implementation Design 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 
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(1.2)  การวิเคราะห์ผู้เรียน (Audience Analysis) ส าหรับการเรียนการสอนปกติ 
ในชั้นเรียน ผู้สอนสามารถปรับเปลี่ยนกระบวนการเรียนรู้ให้สอดคล้องกับผู้เรียนได้โดยง่าย เนื่องจาก
เป็นการด าเนินการแบบเผชิญหน้า (Face to Face) แต่การเรียนการสอนด้วยบทเรียนคอมพิวเตอร์
ช่วยสอนจะน าเสนอเนื้อหาค่อนข้างตายตัวไม่สามารถปรับเปลี่ยนตามสถานการณ์ของผู้เรียนได้ ดังนั้น
การออกแบบบทเรียนคอมพิวเตอร์ช่วยสอนจึงมีความจ าเป็นต้องวิเคราะห์ผู้เรียนเกี่ยวกับข้อมูลต่าง ๆ 
เช่น ระดับชั้น อายุ ความรู้พ้ืนฐาน ประสบการณ์เดิม ระดับ 

ความรู้ความสามารถ และความสนใจต่อการเรียน เป็นต้น เพ่ือน าข้อมูลเหล่านี้ เป็น
แนวทางในการออกแบบบทเรียนให้สอดคล้องกับกลุ่มผู้เรียนอย่างแท้จริง เป็นต้นว่าผู้เรียนระดับเล็ก
อาจต้องการบทเรียนที่น าเสนอด้วยภาพหรือการ์ตูนมากกว่าผู้เรียนระดับโต บทเรียนส าหรับเด็กเก่ง
อาจมีมีความซับซ้อนมากกว่าบทเรียนส าหรับเด็กที่เรียนอ่อน เป็นต้น การวิเคราะห์ผู้เรียนยิ่งถูกต้อง
มากเท่าใดย่อมส่งผลให้การออกแบบบทเรียนมีประสิทธิภาพดียิ่งขึ้น 

(1.3)  การวิเคราะห์วัตถุประสงค์เชิงพฤติกรรม (Behavioral Analysis) วัตถุประสงค์
เชิงพฤติกรรมเป็นสิ่งส าคัญส าหรับการออกแบบบทเรียนคอมพิวเตอร์ช่วยสอนโดยบ่งบอกถึงสิ่งที่
บทเรียนคาดหวังจากผู้รับการฝึกว่า ผู้รับการฝึกจะสามารถแสดงพฤติกรรมใด ๆ ออกมาภายหลัง
สิ้นสุดกระบวนการเรียนรู้ โดยที่พฤติกรรมดังกล่าวผู้รับการฝึกไม่ เคยท าได้มาก่อนและต้องเป็น
พฤติกรรมใช้ค ากริยาชี้เฉพาะ เช่น อธิบาย วาด เขียน อ่าน แยกแยะ เปรียบเทียบ วิเคราะห์ เป็นต้น 

ในทางการเรียนการสอนสิ่งที่ผู้สอนคาดหวังให้ผู้รับการฝึกมีการเปลี่ยนแปลงพฤติกรรม  
ไปในทางที่พึงประสงค์เรียกว่าเกิดการเรียนรู้ขึ้น จ าแนกได้ 3 ด้าน ได้แก่ ด้านพุทธิศึกษา (Cognitive 
Domain) ด้านทักษะศึกษา (Psychomotor Domain) และด้านจริยศึกษา (Affective Domain) 
ในการวิเคราะห์วัตถุประสงค์เชิงพฤติกรรมของบทเรียนคอมพิวเตอร์ช่วยสอน จึงต้องพิจารณาด้วยว่า
จะมุ่งเน้นทางด้านใด หรือให้ครอบคลุมทั้งสามด้าน ทั้งนี้เนื่องจากแต่ละด้านมีความแตกต่างกัน 

การก าหนดวัตถุประสงค์เชิงพฤติกรรมของบทเรียนเป็นเรื่องละเอียดอ่อนต้องวิเคราะห์ 
และพิจารณาอย่างถี่ ถ้วน เพ่ือให้ ได้มาซึ่ งวัตถุประสงค์ที่ ดี  สามารถน าไปใช้ เป็นแนวทาง  
ในการวิเคราะห์เนื้อหาขั้นต่อไป นอกจากนี้ยังต้องจัดล าดับวัตถุประสงค์ตามหลักประสบการณ์ 
การเรียนรู้จากง่ายไปยาก และจากสิ่งที่รู้แล้วไปยังสิ่งที่ยังไม่รู้ 

(1.4)  การวิเคราะห์เนื้อหา (Content Analysis) ขั้นตอนนี้นับว่ามีความส าคัญและ 
ใช้เวลามากในการที่จะได้มาซึ่งเนื้อหาบทเรียน โดยอาศัยวัตถุประสงค์เชิงพฤติกรรมของบทเรียน  
ในขั้นตอนที่ผ่านมาเป็นแนวทางในการรวบรวมเนื้อหาให้สอดคล้องกับความต้องการมากที่สุด 
เป็นที่ยอมรับกันโดยทั่วไปว่า ผู้สอนที่มีความเชี่ยวชาญด้านการสอนจะสามารถออกแบบบทเรียน
คอมพิวเตอร์ช่วยสอนได้ดีกว่านักคอมพิวเตอร์ที่มีความเป็นเลิศด้านโปรแกรม เนื่องจากผู้สอนสามารถ
วิเคราะห์เนื้อหาและรู้ยุทธวิธีการน าเสนอเนื้อหาดังกล่าวได้ดี ดังนั้นในขั้นตอนนี้จึงจ าเป็นต้องอาศัย
ผู้เชี่ยวชาญด้านการสอนเป็นผู้วิเคราะห์หรือให้เป็นผู้ตรวจสอบเนื้อหาก่อนที่จะไปสร้างเป็นบทเรียน
คอมพิวเตอร์ช่วยสอน 

เพ่ือให้การวิเคราะห์เนื้อหาเป็นระบบและสะดวกยิ่งขึ้น สามารถใช้วิธีการต่าง ๆ ในการ
รวบรวมเนื้อหา เช่น ใช้แบบปะการัง (Coral Pattern) ช่วยรวบรวมเนื้อหาแต่ละวัตถุประสงค์และ
เขียน Network Diagram เพ่ือจัดล าดับความสัมพันธ์ของเนื้อหาแต่ละหัวเรื่องย่อย นอกจากนี้ 
ยังสามารถใช้วิธีอ่ืน ๆ ที่จะอ านวยความสะดวกในการรวบรวมเนื้อหาให้สมบูรณ์ที่สุด 
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(1.5)  การออกแบบบทเรียน (Design) ประกอบด้วยขั้นตอนต่าง ๆ ดังนี้ 
(1.5 .1 )  การออกแบบคอร์สแวร์  (Courseware Design) เป็ นบท เรียน

คอมพิวเตอร์ช่วยสอนมาจากพ้ืนฐานเดียวกันกับบทเรียนโปรแกรม แนวความคิดในการน าเสนอ
เนื้อหาจึงใกล้เคียงกัน จะมีส่วนที่แตกต่างกันอยู่บ้างตรงที่การจัดการบทเรียนเท่านั้น ดังนั้นหลักการ
ออกแบบบทเรียนจึ งเหมือนกัน  เริ่มต้นด้ วยการกล่ าวน าเพ่ือสร้างแรง จู งใจในการเรียน 
บอกวัตถุประสงค์ท าแบบทดสอบก่อนเรียน น าเสนอเนื้อหา และท าแบบทดสอบหลังเรียน 
เรียงตามล าดับจนครบกระบวนการเรียนรู้ ตามหลักการของ Robert Gagne ในขั้นตอนนี้จึงเป็นการ
ออกแบบตัวบทเรียน กระบวนการดังกล่าวนี้รวมถึงรูปแบบการน าเสนอบทเรียน การตัดสินค าตอบ 
การเสนอสิ่งเร้าและการให้ข้อมูลย้อนกลับ การเสริมแรง และส่วนอ่ืน ๆ ที่เกี่ยวข้อง บทเรียนที่ได้จาก
ขั้นตอนนี้ เรียกว่าคอร์สแวร์ (Courseware) ซึ่งหมายถึง ตัวบทเรียนที่พร้อมส าหรับน าไปสร้างเป็น
บทเรียนคอมพิวเตอร์ช่วยสอนซึ่งประกอบด้วยเนื้อหา กิจกรรมการเรียน สื่อการเรียนการสอน ค าถาม
ระหว่างบทเรียน แบบทดสอบหลังเรียน และส่วนอ่ืน ๆ ที่ผ่านการออกแบบโดยใช้หลักการของ
บทเรียนโปรแกรม 

(1 .5 .2)  การออกแบบผั งงานและบทด าเนิ นเรื่อง (Lesson Flowchart and 
Storyboard Design) ผังงาน (Flowchart) หมายถึง แผนภูมิที่แสดงความสัมพันธ์ของบทด าเนินเรื่อง
ซึ่งเป็นการจัดล าดับความสัมพันธ์ของเนื้อหาแต่ละส่วนว่าส่วนใดเกี่ยวข้องกับส่วนใดและส่วนใด  
มาก่อนหลังเพ่ือใช้เป็นแนวทางในการพัฒนาบทเรียน โดยทั่วไปมักจะเขียนผังงานก่อนบทด าเนินเรื่อง
แต่อาจเขียนพร้อม ๆ กันก็ได้ ส่วนบทด าเนินเรื่อง (Storyboard) หมายถึง เรื่องราวของบทเรียน
ประกอบด้วยเนื้อหาที่แบ่งออกเป็นเฟรมสุดท้าย บทด าเนินเรื่องประกอบด้วยข้อความ ภาพค าถาม -
ค าตอบ รวมทั้งรายละเอียดอ่ืน ๆ ในกระบวนการเรียนการสอน ซึ่งมีลักษณะเช่นเดียวกันกับบท
สคริปต์ของการถ่ายท าสไลด์หรือภาพยนตร์ การออกแบบบทด าเนินเรื่องจะยึดตัวบทเรียนเป็นหลัก 
เพ่ือใช้เป็นแนวทางการสร้างบทเรียนในขั้นต่อไป การออกแบบบทด าเนินเรื่องจึงต้องมีความละเอียด
และสมบูรณ์ เพ่ือให้การสร้างบทเรียนง่ายขึ้นและเป็นระบบ อีกทั้งยังสะดวกต่อการแก้ไขบทเรียน 
ในภายหลังอีกด้วย 

(1.5.3)  การออกแบบจอภาพ (Screen Design) หมายถึง การจัดพ้ืนที่ของ
จอภาพของคอมพิวเตอร์ให้เป็นสัดส่วนในการน าเสนอเนื้อหา ภาพ ปุ่มควบคุมบทเรียน และส่วนอื่น ๆ 
ที่จ าเป็นส าหรับการน าเสนอบทเรียน ซึ่งนับว่าเป็นส่วนส าคัญยิ่งส าหรับบทเรียนคอมพิวเตอร์ช่วยสอน
ที่จะช่วยเร้าความสนใจของผู้รับการฝึกไม่ให้เกิดความเมื่อยล้าหรือเบื่อหน่ายโดยง่าย ทั้งนี้เนื่องจาก 
ผู้รับการฝึกต้องศึกษาบทเรียนเป็นเวลานาน นอกจากจะเป็นการเร้าความสนใจในบทเรียนแล้วการ
จัดการหน้าจอภาพที่ดีจะช่วยให้ผู้รับการฝึกเกิดความคุ้นเคยและคล่องตัวสามารถใช้บทเรียนได้โดยไม่
มีอุปสรรคใด ๆ การออกแบบจอภาพจะมีองค์ประกอบที่เกี่ยวข้องหลายประการ ได้แก่ ความสามารถ
ในการแสดงสีของเครื่องคอมพิวเตอร์ ความละเอียดของภาพ ขนาดของจอ รูปแบบอักษร ขนาดของ
ตัวอักษร สีของตัวอักษร พ้ืนหลัง และวิธีการการปฏิสัมพันธ์ องค์ประกอบเหล่านี้นับว่าเป็น
องค์ประกอบหลักท่ีท าให้น้าจอภาพของบทเรียนน่าสนใจและชวนติดตาม ในทางปฏิบัติการออกแบบ
ผังงาน การออกแบบบทด าเนินเรื่องและการออกแบบหน้าจอภาพ จะต้องพิจารณาควบคู่ไปด้วยกัน
เนื่องจากทั้งสามส่วนมีความสัมพันธ์กัน 
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(2)  การพัฒนา (Development) ประกอบด้วยขั้นต่าง ๆ ดังนี้ 
(2.1) การเตรียมการ (Preparation Phase) เมื่อได้บทเรียนที่อยู่ในรูปของบทด าเนิน

เรื่องและผังงาน พร้อมทั้งมีแนวทางในการจัดหน้าจอภาพเรียบร้อยแล้ว การพัฒนา เป็นบทเรียน
คอมพิวเตอร์ช่วยสอนจะเป็นเรื่องที่ง่ายขึ้น ในขั้นตอนนี้จะต้องด าเนินการโดยนักคอมพิวเตอร์ที่มีความ
ช านาญด้านการใช้โปรแกรมคอมพิวเตอร์หรือระบบนิพนธ์บทเรียนเท่านั้นอย่างไรก็ตามผู้สอนที่มี
ประสบการณ์ด้านการสอนหรือผู้เชี่ยวชาญเฉพาะด้านก็ยังมีความจ าเป็นที่จะต้องคอยให้ค าปรึกษา
แนะน าการพัฒนาบทเรียนเพ่ือปรับปรุงให้บทเรียนมีคุณภาพที่ดี ก่อนจะพัฒนาบทเรียนคอมพิวเตอร์
ช่วยสอน ต้องเตรียมวัสดุต่าง ๆ เช่น ภาพ ข้อความ และเสียง โดยหาจากแหล่งต่าง ๆ หรือใช้
คอมพิวเตอร์ที่สร้างข้ึนมาแล้วเก็บบันทึกไว้ก่อน เพ่ือน าไปใช้พัฒนาบทเรียนในขั้นต่อไป 

(2.2)  การสร้างบทเรียน (Develop the Lesson) หลังจากเตรียมข้อความ ภาพ เสียง 
และเตรียมโปรแกรมคอมพิวเตอร์ที่ใช้ประกอบบทเรียนแล้ว ขั้นต่อไปก็คือการสร้างบทเรียน
คอมพิวเตอร์ช่วยสอนคามบทด าเนินเรื่องทีละเฟรม ๆ จนครบทุกเฟรม โดยใช้โปรแกรมคอมพิวเตอร์
หรือระบบนิพนธ์บทเรียน หลังจากนั้นจะเป็นการเชื่อมโยงความสัมพันธ์ระหว่างเนื้อหาแต่ละเฟรมเข้า
ด้วยกันตามผังงานที่ออกแบบไว้ในขั้นตอนแรก จัดรูปแบบการน าเสนอ เขียนโปรแกรมการจัดการ
บทเรียน และจัดหน้าจอภาพตามท่ีออกแบบไว้ 

ในขั้นตอนนี้จึงเป็นการใช้ข้อมูลที่เตรียมการมาทั้งหมดในขั้นตอนแรก เพ่ือสร้างบทเรี ยน
คอมพิวเตอร์ช่วยสอน ในส่วนของข้อความซึ่งเป็นเนื้อหาบทเรียนหรือค าอธิบาย อาจจะพิมพ์เข้า
โดยตรงในขั้นตอนนี้ก็ได้ หากมิได้เตรียมไว้ก่อนในขั้นของการเตรียมการ โดยเฉพาะอย่างยิ่งถ้าสร้าง
บทเรียนโดยใช้ระบบนิพนธ์บทเรียน เนื่องจากโปรแกรมเหล่านี้ได้เอ้ืออ านวยประโยชน์ต่ อการพิมพ์
ข้อความในส่วนของเนื้อหาเป็นอย่างมาก รวมทั้งการสร้างค าถามระหว่างบทเรียน แบบทดสอบ 
การประเมินผลคะแนนและการจัดการฐานข้อมูลขั้นต้น 

(2.3)  การท าเอกสารประกอบบทเรียน (Documentation) เอกสารประกอบบทเรียน 
ได้แก่ คู่มือการงาน การแนะน า และการติดตั้ง การบ ารุงรักษาบทเรียนคอมพิวเตอร์ช่วยสอนเป็น
สิ่งจ าเป็นเพ่ือชี้แนะให้ผู้รับการฝึกทราบถึงข้อแนะน าต่าง ๆ รวมถึงวิธีการติดตั้งบทเรียนเข้ากับ
คอมพิวเตอร์ นอกจากนี้ยังรวมถึงแผนการเรียนรู้ (Learning Map) เพ่ือแนะแนวทางการเรียน 

(3)  การทดลองใช้ (Implementation) ในขั้นตอนนี้เป็นการน าบทเรียนคอมพิวเตอร์ช่วย
สอนไปทดลองใช้กับกลุ่มเป้าหมาย โดยผ่านการตรวจสอบจากผู้เชี่ยวชาญก่อน เมื่อได้รับผลการ
ประเมินแก้ไขปรับปรุงจนเป็นที่พอใจแล้วจึงน าไปใช้ วิธีที่ยึ ดเป็นแนวทางปฏิบัติโดยทั่วไปคือ 
การน าไปใช้รายบุคคลกับผู้รับการฝึกกลุ่มย่อยประมาณ 2-3 คน ก่อนเพ่ือตรวจสอบความเหมาะสม
ของบทเรียนเกี่ยวกับค าสั่งที่ใช้ เนื้อหาบทเรียน ค าถาม แบบทดสอบก่อนและหลังเรียนและส่วนอื่น ๆ 
ที่เกี่ยวข้อง เพ่ือน าข้อมูลที่ได้ไปปรับปรุงแก้ไขอีกครั้งหนึ่งก่อนที่จะน าไปใช้อีกครั้งกับกลุ่มเป้าหมายที่
เป็นผู้รับการฝึกจริงอย่างน้อย 10 ขึ้นไป เพ่ือหาประสิทธิภาพของบทเรียนในขั้นตอนต่อไป 

(4)  การประเมินผล (Evaluation) คือ การประเมินผลเพ่ือหาประสิทธิภาพของบทเรียน
คอมพิวเตอร์ช่วยสอนผ่านเว็บท าได้หลายวิธี ได้แก่ วิธีการหาประสิทธิภาพของบทเรียนโดยใช้
หลักสูตรที่มีนักการศึกษาคิดค้นขึ้น เป็นต้นว่า การเปรียบเทียบคะแนนเฉลี่ยของผู้รับการฝึกที่ท าได้
จากแบบฝึกหัดระหว่างบทเรียน หรือคะแนนเฉลี่ยจากค าถามระหว่างบทเรียนกับคะแนนที่ผู้รับการ
ฝึกท าได้จากแบบทดสอบหลังบทเรียน 
 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆท้ังสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกคร้ังที่มีการนำไปใช้
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2.3  การพัฒนาบทเรียนผ่านเครือข่ายอินเทอร์เน็ต 
 

ถนอมพร เลาหจรัสแสง (2545 : 6-16) ได้กล่าวถึงสื่อมัลติมี เดียเพ่ือการศึกษา และ
ความหมายของสื่อมัลติมีเดียเพ่ือการศึกษาแต่ละประเภท ดังนี้ 
 

2.3.1  E-learning 
สามารถน าเสนอเนื้อหาบทเรียนในรูปของสื่อมัลติมีเดียทางคอมพิวเตอร์ นอกจากนี้รูปแบบ

การเรียนการสอนทั้งสองยังถือเป็นสื่อรายบุคคล ซึ่งมุ่งเน้นให้ผู้เรียนมีโอกาสอ่านและท าความเข้าใจ
เนื้อหาตามความสามารถของตน สามารถที่จะทบทวนเนื้อหาตามความพอใจหรือจนกว่าจะเข้าใจ 
ส าหรับในด้านของการโต้ตอบกับบทเรียน และการให้ผลป้อนกลับนั้น E-learning จะขึ้นอยู่กับระดับ
ของการน าเสนอและการน าไปใช้  หากมีการพัฒนา E-learning อย่างเต็มรูปแบบในระดับ 
Interactive Online หรือ High Quality Online และน าไปใช้ในลักษณะสื่อเติมหรือสื่อหลัก ผู้เรียน
ไม่เพียงจะสามารถโต้ตอบกับบทเรียนได้อย่างมีความหมาย แต่ยังจะสามารถโต้ตอบกับผู้สอนและ  
กับผู้เรียนอื่น ๆ ได้อย่างสะดวกผ่านทางระบบของ e-learning นอกจากนี้ผู้เรียนยังสามารถที่จะได้รับ
ผลป้อนกลับจากแบบฝึกหัดและกิจกรรมที่ได้ออกแบบไว้ รวมทั้งจากครูผู้สอนทางออนไลน์ได้อีกด้วย 
ในขณะที่ CAI นั้นลักษณะส าคัญของ CAI ที่ขาดไม่ได้เลยก็คือ การออกแบบให้มีกิจกรรมที่ผู้เรียน
สามารถโต้ตอบกับบทเรียนได้อย่างมีความหมาย รวมทั้งการจัดให้มีผลป้อนกลับโดยทันทีให้กับผู้เรียน
เมื่อผู้เรียนตรวจสอบความเข้าใจของตนจากการท าแบบฝึกหัด หรือแบบทดสอบ 

ข้อแตกต่างส าคัญระหว่าง e-learning กับ CAI อาจอยู่ที่ การที่ E-learning จะใช้เว็บ
เทคโนโลยีเป็นส าคัญ ในขณะที่ CAI เป็นลักษณะของการน าเอาคอมพิวเตอร์มาใช้ ในการเรียน 
การสอนตั้งแต่ยุค 1960 ซึ่งแต่เดิมมานั้นไม่ได้มีการใช้เว็บเทคโนโลยีความหมายของค านี้จึงค่อนข้าง
ยึดติดกับการน าเสนอบนเครื่อง Stand – Alone ไม่จ าเป็นต้องมีการเชื่อมต่อกับเครือข่ายใด ๆ แม้ว่า
ในระยะหลังจะมีความพยายามใช้การใช้ค าว่า CAI on Web บ้างแต่ก็ไม่ได้รับความนิยมในการเรียก
เท่าใดนัก ความหมายของ CAI จึงค่อนข้างจ ากัดอยู่ในลักษณะ Off – line ดังนั้นเทคโนโลยีที่ใช้ 
ในการพัฒนาบทเรียน (Authoring System) ของ CAI และ E-learning จึงมีความแตกต่างกัน 
ตามไปด้วยผู้เรียนที่ศึกษาจาก CAI จึงมักจะเป็นการศึกษาจากซีดีรอมเป็นหลัก ในขณะที่ E-learning 
นั้นผู้เรียนสามารถที่จะศึกษาในลักษณะใดระหว่างซีดีรอมหรือจากเว็บก็ได้ 

ในปัจจุบันแม้ว่าจะมีความพยามในการสนับสนุนให้ Authoring System สามารถปรับให้
ใช้แสดงบนเว็บได้ แต่ยังพบปัญหาในด้านขนาดของแฟ้มข้อมูลที่ใหญ่และส่งผลให้การโหลดข้อมูลช้า 
รวมทั้งปัญหาในด้านการท างานซึ่งไม่สมบูรณ์นัก E-learning และ WBI ต่างก็เป็นผลจากการ
ผสมผสานระหว่างเว็บเทคโนโลยีกับกระบวนการออกแบบการเรียนการสอน เพ่ือเพ่ิมประสิทธิภาพ
ทางการเรียนรู้และแก้ปัญหาในเรื่องข้อจ ากัดทางด้านสถานที่ และเวลาในการเรียน นอกจากนี้
เช่นเดียวกันกับ WBI การพัฒนา E-learning จะต้องมีการน าเทคโนโลยีระบบบริหารจัดการรายวิชา 
(Course Management System) มาใช้ด้วย เพ่ือช่วยในการเตรียมเนื้อหาและจัดการกับการสอน 
ในด้านการจัดการ (Management) อ่ืน ๆ เช่นในเรื่องของค าแนะน าการเรียน การประกาศต่าง ๆ 
ประมวลรายวิชา รายละเอียดเกี่ยวกับผู้สอนรายชื่อผู้ลงทะเบียนเรียน การมอบหมายงาน การจัดหา
ช่องทางการติดต่อสื่อสารระหว่างผู้เรียนกับผู้สอน และผู้เรียนด้วยกัน ค าแนะน าต่าง ๆ การสอบ  
การประเมินผล รวมทั้งการให้ผลป้อนกลับซึ่งสามารถที่จะท าในลักษณะออนไลน์ได้ทั้งหมด ผู้สอนเอง

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆท้ังสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกคร้ังที่มีการนำไปใช้
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ก็สามารถใช้ระบบบริหารจัดการรายวิชานี้ในการตรวจสอบพฤติกรรมการเรียนของผู้เรียน ในกรณีที่ใช้
การถ่ายทอดเนื้อหาในลักษณะออนไลน์ รวมทั้งการตรวจสอบความก้าวหน้าของผู้เรียนจากการท า
แบบทดสอบหรือแบบฝึกหัดที่ได้จัดไว้ส าหรับความแตกต่างระหว่าง E-learning กับ WBI นั้นแทบจะ
ไม่มีเลยก็ว่าได้ ความแตกต่างอาจได้แก่การที่ E-learning เป็นค าศัพท์ (Term) ที่เกิดขึ้นภายหลัง 
ค าว่า WBI จึงเสมือนเป็นผลของวิวัฒนาการจาก WBI และเมื่อเว็บเทคโนโลยีโดยรวมมีการพัฒนาไป
อย่างรวดเร็ว สิ่งที่เคยท าไม่ได้ส าหรับ WBI ในอดีต ก็สามารถท าได้ส าหรับ E-learning ในปัจจุบัน 
ตัวอย่างเช่นในช่วง 4-5 ปีที่แล้วเมื่อมีการพูดถึง WBI การโต้ตอบ (Interaction) ค่อนข้างจ ากัดอยู่ที่
การโต้ตอบกับครูผู้สอนหรือกับเพ่ือนเป็นหลักโดยที่เทคโนโลยีการโต้ตอบกับเนื้อหาเป็นสิ่งที่ท าได้ยาก 
อย่างไรก็ดีเมื่อกล่าวถึง E-learningในปัจจุบันหากมีการพัฒนา E-learning อย่างเต็มรูปแบบอย่าง
เต็มรูปแบบในระดับ Interactive Online หรือ High Quality Online การโต้ตอบสามารถท าได้
อย่างไม่มีข้อจ ากัดอีกต่อไป เพราะปัจจุบันเรามีเว็บเทคโนโลยีที่ช่วยส าหรับการออกแบบบทเรียน  
ให้มีการโต้ตอบอย่างมีความหมายกับผู้เรียน และดังนั้นจึงส่งผลให้เกิดการพัฒนาในด้านการน าไป
ประยุกต์ใช้ที่ยืดหยุ่นมากขึ้นกว่าเดิมมากนอกจากนี้เดิมทีความหมายของ WBI จะจ ากัดอยู่ที่การสอน
บนเว็บเท่านั้นเพราะแนวความคิดหลักก็คือเพื่อใช้ประโยชน์จากทรัพยากรสารสนเทศบนเว็บเป็นหลัก
และการเรียนการสอนมักจะเน้นเนื้อหาในลักษณะตัวหนังสือ (Text –Based) และภาพประกอบหรือ
วีดิทัศน์ที่ไม่ซับซ้อนเท่านั้น ในขณะที่ในปัจจุบันผู้ที่ศึกษาจาก E-learning จะสามารถเรียกดูเนื้อหา
ออนไลน์ก็ได้ หรือสามารถเรียกดูจากแผ่น CD-ROM ก็ได้ โดยที่เนื้อหาสารสนเทศที่ออกแบบส าหรับ 
e-learning นั้นจะใช้เทคโนโลยีเชิงโต้ตอบ (Interactive Technology) รวมทั้งมีการใช้เทคโนโลยี
มัลติมีเดีย (Multimedia Technology) เป็นส าคัญ 
 
ตารางที่  2.2  การเปรียบเทียบการเรียนห้องเรียนปกติกับการเรียนแบบ e-learning 

ลักษณะ  ห้องเรียนปกติ  E-learning  
สถานที่เรียน  ต้องมีสถานที่ส าหรับท าการเรียน

การสอน ซึ่งอาจจะเป็นที่โรงเรียน 
หรือสถานที่ที่จัดไว้  

จะมีห้องเรียนหรือไม่มีก็ได้ แต่โดยปกติ
มักจะไม่อาศัย ห้องเรียน ซึ่งเป็นจุดเด่น
อย่ างหนึ่ งในการเรียนแบบ E-learning 
(เพียงขอให้ผู้เรียนมีเครื่องคอมพิวเตอร์ที่ 
สามารถต่อระบบเครือข่ายได้)  

การเตรียม 
การสอน 

การเตรียมการสอนในห้องเรียน
ปกติจะง่ายกว่าการ เตรียมการสอน
ของE-learning เพ ราะอาจ ารย์
เตรียม การสอนตามปกติ  เช่น 
เอกสารประกอบการสอน แผ่นใส 
วีดิ ทั ศน์  เทป เสี ย ง ห รือการใช้ 
PowerPoint ก็ได้  

ส าหรับ  E-learning จะมีการเตรียมการ
ส อ น ที่ ย า ก ก ว่ า  เพ ร าะ เมื่ อ อ า จ า ร ย์
เตรียมการสอนส าหรับสอนในห้องเรียนปกติ
แล้ว ก็ต้องน า ทุกอย่าง มาแปลงให้อยู่ในรูป
ของไฟล์คอมพิวเตอร์ ซึ่ งสามารถน าไป  
เปิดใช้งานโดยโปรแกรมเบราเซอร์ต่าง ๆ  
ไม่ว่าจะเป็น IE หรือ Netscape 
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ผู้สอน ผู้เรียน 
เห็นหน้ากัน  

เห็นหน้ากันหมด ซึ่งเป็นข้อดีอย่าง
หนึ่งของการเรียนใน ห้องเรียนปกติ 
เพราะผู้เรียนสามารถพบปะพูดคุย
กัน แลกเปลี่ยนความคิดเห็นอย่าง
อิสระ(คุยกันในห้องเรียน) และอาจ
มีข้อจ ากัดบ้างในเรื่องของการถาม
ตอบ เพราะ ผู้ เรี ยนจะเขินอาย
กันเองหากตอบค าถามไม่ได้หรือ 
จะถาม ในส่วนใดส่วนหนึ่ งของ
เนื้อหาที่ไม่เข้าใจ 

ขึ้นอยู่ กับการออกแบบว่าเป็นอย่ างไร  
ซึ่ งอาจจะมี การเก็บภาพวีดิทั ศน์  ของ
อาจารย์ไว้แล้วให้ผู้เรียนเปิดดูพร้อมเนื้อหา
โดยผ่านระบบเครือข่าย หรือจะเป็นการ
เรียนการสอนโดยอาจารย์สอนผ่านกล้องที่
ต่อคอมพิวเตอร์ ผ่านในระบบเครือข่าย 
ผู้เรียนก็จะสามารถเรียนกับผู้สอนได้โดย
ทันที (Live) แต่ในเวลานี้ยังอยู่ในระดับที่
พอใช้ได้ เทคโนโลยียังคงต้องรอการพัฒนา 
เพ่ือให้อยู่ในระดับดี และดีมากในอนาคต
ต่อไป 

ต้องมาเรียน
พร้อมกัน  

มีความจ าเป็นมากที่ต้องมาเรียน
พ ร้ อ ม  ๆ  กั น ใน ก า ร เรี ย น  ใน
ห้ องเรียนปกติ  ถ้ าใครไม่มาก็มี
โอกาสตามไม่ทัน พอมาเรียนอีกวัน
ก็ไม่สามารถเรียนในเนื้อหาต่อไปได้ 
และอาจารย์จะต้องมาสอนทุกแม้ว่า
จะมีผู้เรียนมาเรียนกี่คนก็ตาม  

แต่ถ้าเป็นการเรียนแบบ e-learning ใครจะ
มาเรียนเมื่อไรก็ได้ เวลาไหนก็ได้ ที่ไหนก็ได้
(ที่มีคอมพิวเตอร์ต่อกับระบบเครือข่าย) 
อาจารย์ผู้สอนก็ไม่จ าเป็น ต้องมานั่งเฝ้าสอน
อีกต่อไป โดย e-learning จะเปิดโอกาสให้
ผู้ เรียนที่ เรียน ไม่  ทั นสามารถทบทวน
บทเรียนที่ เรียนมาแล้วได้  อีกทั้ งใช้เวลา
ศึกษาได้นานซ้ า ไปซ้ ามาได้ไม่จ ากัดเวลาใน
การเรียนรู้  

คุณภาพ 
ในการสอน  

คุณภาพในการเรียนการสอนจะ
ขึ้นอยู่กับอาจารย์ผู้สอน เป็นหลัก
ถึงแม้ว่าจะเป็นเนื้อหาวิชาเดียวกัน 
หนั งสื อ เล่ ม  เดี ยวกันแต่ก็ ใช่ ว่ า
ผู้ เรียนจะได้รับเนื้อหาที่สมบูรณ์
หรือ เข้าใจในเนื้อหาที่เหมือนกัน 
เพราะอาจารย์แต่ละท่ าน  จะมี
เทคนิคในการถ่ายทอดความรู้ที่
แตกต่างกันไปตาม ประสบการณ์ 
และการที่อาจารย์ต้องสอนในเรื่อง
เดียวกัน ซ้ า ๆ บ่อย ๆ 

การเรียน e-learning คุณภาพการเรียนการ
สอนจะเท่ากัน ค าว่าเท่ากันนี้ หมายความว่า 
เนื้อหาในบทเรียนนี้ เป็นเนื้อหาบทเรียน
เดียวกัน ผู้เรียนสามารถเปิดดูซ้ ากี่ครั้งก็ได้ 
ไม่เข้าใจก็สามารถดูซ้ าจนเข้าใจได้ ถ้ายังไม่
เข้าใจอีกก็สามารถ e-mail มาถามอาจารย์
หรือเข้า Web board เพ่ือแลกเปลี่ยนความ
คิดเห็นกันระหว่างผู้เรียนกันเอง 
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เรียนไป 
พร้อม ๆ กัน 
เท่า ๆ กัน  

การเรียนในห้องเรียนปกติผู้ เรียน
จะต้องตั้งใจฟังเนื้อหาไป พร้อม ๆ
กันและต้องเข้าใจเนื้อหาที่อาจารย์
สอนในเวลาที่รวดเร็ว เพราะถ้าไม่
เข้าใจแล้วให้อาจารย์อธิบายซ้ า 
บ่อย ๆ จะท าให้ผู้เรียนอื่น เสียเวลา
ในการเรียนเนื้อหาถัดไปหรือเบื่อ
หน่ายได้ 

เรียนกับe-learningไม่ต้องรอกันใครเข้าใจ
ก่อนก็สามารถเรียนในเนื้อหา ถัดไปได้เลย 
ส่วนใครที่ไม่สามารถเข้าใจในเนื้อหานั้น ๆ  
ก็สามารถใช้เวลา ท าความเข้าใจในเนื้อหา
นั้นได้มากขึ้นโดยไม่ต้องกังวลว่าจะท าให้คน
อ่ืนช้าไปด้วย  

การวัดผล 
การเรียน  

ในห้องเรียนการวัดผลการเรียนต้อง
ท าการสอบ  มี การเก็บข้อสอบ 
อาจารย์ต้องมาตัดเกรดเองและ
ประกาศผลเอง  

e-learning สามารถวัดผลการเรียนรู้ของ
ผู้ เรี ยน ได้ โดยทั นที  คื อถ้ าท าข้ อ ใดผิ ด 
ก็จะแจ้ งผลย้อนกลับทั นที (Feedback) 
ซึ่งผู้สอนอาจจะ มีค าอธิบายที่ให้ผู้เรียนได้
เข้าใจว่าที่ถูกเป็นเช่นไร ท าให้ผู้เรียนเข้าใจ 
และจดจ าในวิชานั้น ๆ ได้ดียิ่งขึ้น ข้อควร
ค านึงที่อาจจะดูว่ายุ่งยากก็คือ จะต้องมีการ
ออกข้อสอบให้มากกว่าที่ใช้สอบจริง 2- 3 
เท่าให้มีข้อสอบมาก ๆ ในอยู่ในลักษณะของ
คลังข้อสอบ e-learning จะท าการเลือก 

การวัดผล 
การเรียน 

 ข้อสอบแบบสุ่ม ให้ตามจ านวนข้อที่ต้องการ
ใช้สอบ ถ้าคิด กันให้ดีการท าอย่างนี้จะช่วย
ให้  สามารถประหยัด เวลาในการออก
ข้อสอบบ่อย ๆ และคลังข้อสอบจะช่วยให้ 
ผู้เรียนไม่สามารถลอกข้อสอบกันได้เพราะ
จะได้ข้อสอบที่มีข้อแตกต่างกัน 

ต้นทุนการ
เตรียม 
การสอน  

ต่ ากว่า เพราะแผ่นใส, ปากกาเขียน
แผ่นใส(ฟรี) สื่ออ่ืน ๆ ก็สามารถยืม
ได้  

สูงกว่า เพราะทางมหาวิทยาลัยต้องมีการ
ล งทุ น ใน ด้ า น ต่ า ง  ๆ เ พ่ื อ ให้ มี ร ะบ บ                   
e-learning  

ต้นทุนเม่ือ 
ท าการสอน  

สูงกว่า เพราะมหาวิทยาลัยต้องซื้อ
อุปกรณ์การสอนและสื่อต่าง ๆ และ
ต้องบ ารุงรักษา  

ต่ ากว่า เพราะลงทุนไปแล้ว เวลาสอนก็จะ
ไม่ต้องลงทุนซ้ าอีก เพียงแต่เพ่ิมหรือปรับ
เนื้อหาให้ทันสมัยอยู่ตลอดเวลา  

จ านวนผู้เรียน 
ในห้องเรียน  

ต้องมีการจ ากัดจ านวนผู้ เรียน   
หากมีผู้ เรียนจ านวนมาก ก็ต้อง
แบ่ งกลุ่ ม เข้ าเรียน  ท าให้ ผู้ สอน
เหนื่อยซ้ าหลายครั้ง  

e-learning สามารถเข้าเรียนได้โดยไม่จ ากัด
จ านวนผู้เรียน และไม่มีเข้าเรียนสาย  

   
   

ตารางท่ี 2.2  (ต่อ) 
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ผู้เรียน
สามารถ
ค้นคว้า 
เพิ่มเติมได้  

มีโอกาสไปศึกษาด้วยตนเองน้อย 
เพราะเมื่อเรียนเสร็จ ก็จะกลับบ้าน 
ห้องสมุดเองก็เปิดในเวลาหลังเลิก
เรียนได้ไม่นาน ก็ต้องปิด  

ผู้เรียนสามารถค้นคว้าเพ่ิมเติมในขณะเรียน
ได้เลยเพราะมี  Link ที่ให้ค้นคว้าได้ทันที 
แล้วกลับมาศึกษาต่อหรือควบคู่กันไปก็ยังได้  

ความเป็น
ส่วนตัว  

มีน้อยกว่า เพราะอยู่รวมกันหลาย
คน จะไอ จะจาม ก็คงล าบาก หรือ
ทานขนมขบเค้ียวไปด้วยก็ท าไม่ได้  

อันนี้คงไม่ต้องบรรยายมาก หากอยู่ที่บ้านใส่
ชุดนอนเข้าเรียนก็ได้ ไม่มีใครห้าม หรือกิน
ข้าวเช้าไปด้วยก็ได้ 

 
2.3.2  ระบบจัดการบทเรียน (Learning Management System: LMS) 
LMS เป็นระบบจัดการเรียนการสอน Online เป็นซอฟต์แวร์เพ่ือการบริหารจัดการเรียน

การสอนผ่านระบบอินเทอร์เน็ต ระบบดังกล่าวมักจะประกอบไปด้วยเครื่องมืออ านวยความสะดวก
ให้แก่ผู้สอน ผู้เรียน และผู้ดูแลระบบ ผู้สอนสามารถน าเนื้อหาและสื่อการสอนขึ้นเว็บไซต์ รายวิชา
ตามที่ได้ขอให้ระบบจัดไว้ให้โดยสะดวก ผู้เรียนเข้าถึงเนื้อหา กิจกรรมต่าง ๆ ได้โดยผ่านเว็บ ผู้สอน
และผู้เรียนติดต่อสื่อสารกันได้ผ่านทางเครื่องมือการสื่อสารที่ระบบจัดไว้ให้ นอกจากนั้นแล้วยังมี
องค์ประกอบที่ส าคัญคือการเก็บบันทึกข้อมูลกิจกรรมการเรียนรู้ของผู้เรียนไว้บนระบบ เพ่ือผู้สอน
สามารถน าไปวิเคราะห์เพ่ือติดตามและประเมินผลการเรียนการสอนในรายวิชานั้นได้อย่างมี
ประสิทธิภาพ ระบบจัดการบทเรียนจะท าหน้าที่เหมือนกับโรงเรียนแห่งหนึ่งที่ประกอบไปด้วยระบบ
จัดการด้านต่าง ๆ ที่ส าคัญอยู่ 3 ระบบ คือ  
                      2.3.2.1  ระบบจัดการหลักสูตร 
 เป็นส่วนของการจัดการเกี่ยวกับระบบการเรียนการสอน ซึ่งเป็นหน้าที่ของครูผู้สอน 
ที่จะเป็นผู้จัดท า ระบบจัดการหลักสูตรถือเป็นหัวใจส าคัญของ e-learning โดยประกอบไปด้วยระบบ
ย่อย ๆ 2 ระบบ คือ  
                                  (1)  ระบบจัดการบทเรียน เป็นระบบการจัดท าบทเรียนโดยการศึกษา 
วิเคราะห์เนื้อหาจากหลักสูตรแล้ว ก าหนดจุดประสงค์การเรียนรู้ ออกแบบกิจกรรมการเรียนรู้ จัดท า
สื่อ จัดหาแหล่งข้อมูล แหล่งเรียนรู้ที่ส าคัญและจ าเป็น รวมถึงการตกแต่งหน้า Web Pages ให้จูงใจใน
การเรียน  
                                  (2)  ระบบการวัดและประเมินการเรียนรู้ เป็นระบบการจัดท าแบบฝึกหัด 
แบบทดสอบส าหรับผู้เรียน เพ่ือฝึกทักษะ ความสามารถในการคิด รวมถึงเป็นการวัดความรู้ ความคิด
ผู้เรียนที่ได้เรียนรู้จากบทเรียน เป็นการประเมินศักยภาพในการเรียนรู้ของผู้เรียน และผู้เรียนจะทราบ 
ผลการทดสอบทันทีหลังจากสอบเสร็จ หรืออาจมีการเฉลยค าตอบ หรือวิธีการอ่ืน ๆ แล้วแต่ 
การออกแบบระบบของผู้สอน  

2.3.2.2  ระบบส่งเสริมการเรียนรู้  
                      เป็นระบบช่วยเหลือในการจัดท าบทเรียนของครูผู้สอน และช่วยในการเรียนรู้ของ
ผู้เรียน ประกอบด้วยโปรแกรมจัดท าบทเรียน ที่ครูผู้สอนสามารถบรรจุข้อมูล เนื้อหา ค าสั่งกิจกรรม 
และข้อมูลอ่ืน ๆ ลงในระบบได้โดยง่าย รวมถึงการใส่ภาพประกอบ ภาพเคลื่อนไหว วิดีโอ หรือ
ไฟล์ข้อมูลต่าง ๆ ซึ่งผู้เรียนก็สามารถสร้างเนื้อหาตามที่ครูผู้สอนก าหนดกิจกรรมไว้ได้ด้วยวิธีการ

ตารางท่ี 2.2  (ต่อ) 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 
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เดียวกันกับครูผู้สอน นอกจากนี้ ระบบส่งเสริมการเรียนรู้ยังมีระบบการติดต่อสื่อสารระหว่างผู้สอนกับ
ผู้เรียนได้แก่ กระดานข่าว (Web board) กระดานสนทนา (Chat) จดหมายอิเลคทรอนิกส์ (e-mail) 
และ/หรือ การติดต่อผ่านกล้องวิดีโอ (Web cam) ในกรณีทีใ่ช้เครือข่ายสัญญาณความเร็วสูง  
                      2.3.2.3  ระบบจัดการข้อมูล  
                      เป็นระบบจัดการด้านฐานข้อมูล ซึ่งจะเก็บรวบรวมข้อมูลต่าง ๆ ของครูผู้สอน 
ข้อมูลของผู้เรียน สถิติต่าง ๆ เช่น สถิติการเข้ามาเรียน วันที่ เวลา ระยะเวลา ข้อมูลส่วนตัว รหัสผ่าน 
สถิติการท าแบบฝึกหัด แบบทดสอบ คะแนนที่ได้ ฯลฯ  
 
2.4  โปรแกรมที่ใช้ในการพัฒนาบทเรียนผ่านเรียนบนเครือข่ายอินเทอร์เน็ต 
 

2.4.1  Moodle 
Moodle (Modular Objected Dynamic Learning Environment) คือระบบจัดการ

เรียนการสอน (LMS) หรือ ระบบจัดการคอร์ส (CMS) ที่ช่วยในการจัดกิจกรรมการเรียนการสอนใน
ระบบการเรียนแบบออนไลน์ให้มีบรรยากาศเหมือนเรียนในห้องเรียนผ่านระบบเครือข่ายอินเทอร์เน็ต 
Dr.Martin Dougiamas เป็นผู้พัฒนา ผู้ดูแลระบบการเรียนการสอนออนไลน์ Curtin University 
ประเทศออสเตรเลีย 

2.4.1.1  ความสามารถ 
(1)  สามารถน าเอกสารหรือไฟล์รูปแบบต่าง ๆ เข้าไปได้ เช่น Word, 

PowerPoint, PDF, Webpage (html) Video และ Image  
 (2)  มีระบบติดต่อสื่อสารครบทุกประเภท เช่น Web Board, Chat etc.  
 (3)  มีระบบการท าแบบฝึกหัด และแบบทดสอบ ส่งและรับการบ้าน  
 (4)  มีการ UPLOAD ขึ้นเครื่องแม่ข่าย ได้โดยใช้ Zip  
 (5)  มีการปรับโปรแกรมเป็นภาษาไทยที่ใช้งานได้ดี  

2.4.1.2  ปรัชญาการสร้าง Moodle 
 (1)  การเรียนรู้แบบสร้างองค์ความรู้ด้วยตนเอง (Constructivism) คนเรา
นั้นจะมีการสร้างความรู้ใหม่เสมอหากมีสภาวะแวดล้อมเอ้ืออ านวย การเรียนรู้แบบเดิมที่มาจากการ 
ฟัง เห็น ล้วนเป็นการเรียนรู้ทางเดียวนั่นคือเราเป็นผู้รับสารและเก็บเอาไว้จึงมีการเรียกผู้ที่มีความจ าดี
ว่า “พจนานุกรมเดินได้” หากแต่เราจะเรียนรู้ได้มากกว่าหากเป็นการถ่ายทอดจากสมองสู่สมองนั่นคือ
มี่การแลกเปลี่ยนทัศนะและเรียนรู้จากประสบการณ์ของผู้อ่ืน 
 (2)  การเรียนรู้แบบคิดเอง สร้างเอง (Constructionism) การเรียนรู้แบบ
คิดเองสร้างเองคือการเรียนรู้ด้วยการลงมือท าไม่ว่าจะเป็นการพูด การโพสต์แสดงความคิดเห็นบน
กระดานเสวนา ตัวอย่างเช่น ปกติอ่านหนังสือพอวางหนังสือก็จะลืม แต่ถ้าได้อธิบายให้คนอ่ืนฟังจะท า
ให้จ าได้มากข้ึน 
 (3)  การเรียนรู้แบบสร้างองค์ความรู้ในสังคม (Social Constructivism)  
 (4)  การเรียนรู้ร่วมกันเป็นหมู่คณะโดยอาศัยหลักการว่าความส าเร็จของ
หมู่คณะ คือความส าเร็จของตน  

- ทุกคนสามารถเป็นครูและนักเรียนได้ในเวลาเดียวกัน  
- เรียนรู้ด้วยการสร้างสิ่งใดสิ่งหนึ่งให้ผู้อื่นเห็น  

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 
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- เรียนรู้ด้วยการสังเกตการณ์การกระท าของเพ่ือนร่วมชั้นเรียน  
- เชื่อมโยงความรู้ใหม่กับบริบทส่วนบุคคลของผู้เรียน (เรียกว่า

transformative knowledge and constructivism) 
- มีความสามารถในการปรับเปลี่ยนและปรับแต่งได้ เนื่องจากทุกคนใน

ห้องเรียนออนไลน์มีส่วนร่วมในการสร้างห้องเรียน 
 2.4.1.3  การเชื่อมโยงและการแยกส่วน (Connected and Separated Knowing)  
 ผู้ที่มีพฤติกรรมแบบเชื่อมโยงภายในกลุ่มจะเป็นผู้ที่ช่วยกระตุ้นให้เกิดการเรียนรู้
นอกจากจะท าให้คนในกลุ่มมีความสนิทสนมกันมากขึ้นแล้วยังช่วยให้แต่ละคนได้สะท้อนความคิดของตน 
 Moodle เป็นซอฟต์แวร์ Open Source ที่ ใช้ส าหรับท าคอร์สหรือบทเรียน
ออนไลน์ที่ เราเรียกกันติดปากว่าระบบ LMS หรือ  Learning Management System โดยที่ 
Moodle นับเป็นทูลตัวหนึ่งที่มีความสามารถสูง ตามมหาวิทยาลัยและโรงเรียนต่าง ๆ เลือกใช้ ตัว 
Moodle เองมีระบบ Backend (ระบบจัดการคอร์ส ที่ดีตัวหนึ่ง) ผู้ควบคุมสามารถแบ่งแยกระหว่าง
อาจารย์ ผู้เรียน ได้อย่างง่าย และเป็นซอร์ฟแวร์ที่มีลิขสิทธิ์แบบ GPL (General Public License) 
หรือลิขสิทธิ์แบบฟรีนั่นเอง ผู้น าไปใช้สามารถพัฒนาต่อยอดได้ 
 

2.4.2  โปรแกรมคอมพิวเตอร์กราฟิก 
เป็นโปรแกรมส าเร็จรูปส าหรับท างานสร้างสรรค์ศิลปะดิจิตอลได้อย่างรวดเร็วและง่ายดาย

มีเครื่องมือในการตกแต่งภาพมากมาย เป็นโปรแกรมที่มีความสามารถที่หลากหลาย ยืดหยุ่น  
ในการสร้าง จัดการ และแก้ไขภาพคอมพิวเตอร์กราฟิก 
 
2.5  การหาคุณภาพของบทเรียนคอมพิวเตอร์ 
 

การตรวจสอบคุณภาพของเนื้อหาบทเรียนจะแบ่งเป็นการตรวจสอบประสิทธิภาพด้านต่าง ๆ 
(ไพโรจน์ ตีรณธนกุล, ไพบูรณ์ เกียรต ิโกมล และเสกสรรค์ แย้มพินิจ.  2546 : 197-214) ดังนี้ 

 

2.5.1  การตรวจสอบคุณภาพของเนื้อหาบทเร ียนออนไลน ์ 
ต้องมีการตรวจสอบล าด ับเนื้อหานั้นจะมีการตรวจสอบ 2 ขั้นตอน คือ 
1.  การตรวจสอบความต่อเนื่องของเนื้อหาในหน่วยการเรียนเดียวกัน เพ่ือดูว่ามีความ

เหมาะสมต่อเนื่องกันหรือไม่ และตอบสนองวัตถุประสงค์เชิงพฤติกรรมครบถ้วนหรือไม่ 
2.  การตรวจสอบความเชื่อมโยงของเนื้อหาในแต่ละหน่วยการเรียน เพ่ือดูว่าการเชื่อมโยง

ของเนื้อหาแต่ละหน่วยเป็นไปตามท่ีได้วิเคราะห์ไว้หรือไม่ 
ภายหลังจากการตรวจสอบล าดับของเนื้อหาอย่างถูกต้องแล้ว ให้ท าการตรวจสอบความ

ถูกต้องของเนื้อหาที่พัฒนาขึ้น โดยท า 2 ด้านต่อเนื่องกันคือ 
1.  การตรวจสอบความถูกต้องของเนื้อหา โดยผู้เชี่ยวชาญด้านเนื้อหา ประเมินให้คะแนน

โดยใช้แบบฟอร์มที่เป็นปลายเปิด 
2.  น าไปทดลองกับกลุ่มเป้าหมายที่จะเรียนเนื้อหานั้น ๆ ภายหลังจากประเมินความ

ถูกต้องของเนื้อหาโดยผู้เชี่ยวชาญ และปรับแก้แล้ว  ขั้นตอนต่อไปคือน าไปทดลองกับกลุ่มเป้าหมายที่
จะเรียนเนื้อหานั้น ๆ เพ่ือทดสอบความเข้าใจในการเรียนเนื้อหา และการสื่อความหมายของส านวนที่
ใช้ตลอดจนรูปแบบเพ่ือความหมายต่อผู้เรียน ในขั้นนี้จะต้องใช้กลุ่มเป้าหมายจริง โดยคัดเลือก

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 
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http://www.opensource.org/
http://www.gnu.org/copyleft/gpl.html
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ประมาณ 9 – 12 คน ให้ทดลองเรียนเนื้อหา และหากสงสัยหรือไม่เข้าใจตรงไหนให้ผู้เรียนเขียนไว้
จากนั้นจึงรวบรวมข้อมูลที่ได้มาปรับแก้ให้สมบูรณ์ และตรวจสอบโดยผู้เชี่ยวชาญอีกครั้ง หลังจาก
ปรับปรุงแก้ไขจนสมบูรณ์แล้วถือว่าจบขั้นตอนการตรวจสอบความถูกต้องของเนื้อหา 
 

2.5.2  การตรวจสอบคุณภาพของการน าเสนอบทเรียน 
เป็นการตรวจสอบคุณภาพในการออกแบบการสอน (Instructional Design) และการวาง

แผนการซึ่งจะต้องมีการออกแบบให้เหมาะสมกับเนื้อหา และกลุ่มเป้าหมาย โดยเลือกวิธีการสอน  
สื่อการสอนที่เหมาะสมใช้ 

เป้าหมายส าคัญในการออกแบบคือ การให้ผู้ เรียนเกิดการเรียนรู้ตามวัตถุประสงค์ 
เชิงพฤติกรรมที่ตั้งไว้ ในการออกแบบนั้นจะต้องค านึงถึงกระบวนการน าเสนอทั้งหมด ซึ่งจะมีการ
น าเข้าบทเรียน การน าเสนอเนื้อหาสาระ การทบทวนเสริมความเข้าใจ และการสรุปบทเรียน รวมทั้ง
การใช้เทคนิควิธีการสอน การใช้สื่อต่าง ๆ ที่เหมาะสม และสิ่งที่ส าคัญที่การออกแบบทั่วไปไม่มีก็คือ
จะต้องออกแบบ ปฏิสัมพันธ์ระหว่างบทเรียนกับผู้เรียนซึ่งเป็นสิ่งที่คอมพิวเตอร์สามารถท าได้โดยใน
การก าหนดกลวิธีในการน าเสนอและเขียนวัตถุประสงค์เชิงพฤติกรรมของเนื้อหานั้นผู้ด าเนินการเรียน
ควรเป็นที่มีความเชี่ยวชาญใน 2 ด้าน คือ เชี่ยวชาญด้านเนื้อหา และผู้เชี่ยวชาญด้านการออกแบบ
บทเรียนคอมพิวเตอร์ร่วมด้วย 

ในการออกแบบบทเรียนนั้น จ าเป็นจะต้องมีความเชี่ยวชาญทางด้านต่าง ๆ ดังนี้ ความ
เชี่ยวชาญด้านเนื้อหาเทคนิคการน าเสนอเนื้อบทเรียน การเลือกใช้สื่อมัลติมีเดียอย่างเหมาะสม  
และมีความรู้ในการวัดผลการเรียนอย่างมีประสิทธิภาพดังนั้น ควรท างานเป็นทีมทั้งผู้เชี่ยวชาญด้าน
เนื้อหาทางด้านการออกแบบการสอน  (Instructional Design) และทางด้านมัลติมีเดียด้วย แต่หาก
ผู้ เชี่ยวชาญทางด้านเนื้อหามีความช านาญในการออกแบบบทเรียนและมัลติมีเดีย ก็สามารถ
ด าเนินการด้วยตนเองได ้
 

2.5.3  การตรวจสอบคุณภาพของแบบทดสอบ 
การเขียนข้อสอบได้ตามจ านวนที่ต้องการ ต้องน าข้อสอบที่เขียนเสร็จแล้วน ามาตรวจสอบ

คุณภาพดังนี้ 
1.  น าข้อสอบที่เขียนเสร็จแล้วมาตรวจสอบ โดยคณะกรรมการผู้เชี่ยวชาญด้านเนื้อหา เพื่อ

พิจารณาการใช้ภาษาส านวนในการสื่อความหมายต่าง ๆ และตรวจสอบความถูกต้องตามหลักการ
ออกแบบข้อสอบ หากมีข้อสอบข้อนั้นต้องปรับปรุงแก้ไขต้องเขียนข้อปรับปรุงลงไปในด้านหลังของ
บัตรออกข้อสอบข้อนั้น 

2.  ตรวจสอบความเที่ ยงตรงเนื้ อหาและวัตถุประสงค์ เชิ งพฤติกรรม ( Index of 
Consistency : IOC) เป็นคุณภาพของแบบทดสองที่สามารถวัดได้ตรงตามลักษณะหรือจุดประสงค์ 
ที่จะวัด ซึ่งเป็นคุณสมบัติที่ส าคัญมากของแบบทดสอบ ในขั้นตอนนี้จะให้คณะกรรมการผู้เชี่ยวชาญ
ด้านเนื้อหาวิชาพิจารณาว่าข้อทดสอบแต่ละข้อนั้น สามารถวัดได้ตรงตามตารางวิเคราะห์รายละเอียด
หรือไม่ ซึ่งเป็นการวิเคราะห์ดัชนีความเที่ยงตรง (Index of Consistency) เริ่มต้นจากการพิจารณา
ความสอดคล้องระหว่างข้อสอบกับจุดประสงค์เชิงพฤติกรรม ดังตาราง 
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ตารางท่ี  2.3  แสดงการพ ิจารณาความสอดคล้องระหว่างข้อสอบกับจุดประสงคเ์ชิงพฤติกรรม 
 

วัตถุประสงค์เชิงพฤติกรรม รายละเอียดข ้อสอบ การพิจารณา 

สามารถบวกเลขไม่เกิน 2 
หลักได้ถูกต ้อง 

10 + 24 มีค ่าเท่าไร  
     ก. 32 

ข. 33  
ค. 34  
ง. 35 

 

+ 1 
 

0 
 

- 1 

ที่มา : อ้างอิงในไพโรจน์ ตีรณธนกุล, ไพบูรณ์ เกียรติโกมล และเสกสรรค์แย้มพินิจ. 2546 : 140 
 

จากตารางที่  2.3  คณะกรรมการจะพิจารณาว่าข้อสอบวัดได้ ตรงตามจุดประสงค์ 
เชิงพฤติกรรมหรือไม่ ถ้าแน่ใจว่าตรงจะกาเครื่องหมายในช่อง +1 ถ้าแน่ใจว่าไม่ตรงจะกาเครื่องหมาย 
ในช่อง -1 และถ้าไม่แน่ใจว่าตรงหรือไม่จะกาเครื่องหมายในช่อง 0 การพิจารณาค่า IOC นี้จะต้องมีค่า
มากว่า หรือเท่ากับ 0.5 จึงถือว่าวัดได้สอดคล้องกัน จากค่า IOC ที่ค านวณได้นี้ แสดง ว่าข้อสอบวัด 
ไมส่อดคล้องกับจุดประสงค์เชิงพฤติกรรม 

ภายหลังจากสร้างแบบทดสอบเสร็จแล้ว ขั้นต่อไป คือ  
(1)  การน าแบบทดสอบไปทดสอบกับกลุ่มตัวอย่างเพ่ือหาคุณภาพของแบบทดสอบ 

ส าหรับกลุ่มตัวอย่างที่ใช้ในการทดสอบหาคุณภาพของ แบบทดสอบ จะเป็นกลุ่มผู้ที่มีความรู้ หรือเคย
เรียนเนื้อหานั้นมาแล้ว 

(2)  การวิเคราะห์ข้อสอบเป็นรายข้อ หาระดับความยากง่ายของข้อสอบ โดยข้อสอบที่ดี
จะต้องไม่ยากมากเกินไป และไม่ง่ายจนเกินไป โดยทั่วไปแล้วจะน าแบบทดสอบแต่ละข้อมาค านวณหา
ความง่ายซึ่งแสดงคุณสมบัติของข้อสอบชุดนั้นว่า นักเรียนท าถูกกี่คน ในจ านวน นักเรียนที่ท าข้อสอบ
ข้อนั้นทั้งหมด 

(3)  การวิเคราะห์ข้อสอบ หาอ านาจจ าแนกของข้อสอบ เป็นค่าดัชนีที่บ่งบอกถึงว่าข้อสอบ
ข้อนั้นสามารถจ าแนกนักเรียนออกเป็น 2 กลุ่ม คือกลุ่มที่มีคะแนนสูงหรือกลุ่มเก่ง กับกลุ่มคะแนนต่ า
หรือ กลุ่มอ่อนค่าอ านาจจ าแนกนี้มีค่าอยู่ระหว่าง -1 ถึง + 1 โดยทั่วไปแล้วข้อสอบที่มีค่าอ านาจ
จ าแนก ใช้ได้จะมีค่ามากกว่าหรือเท่ากับ 0.20 และถ้าข้อสอบนั้นมีค่าอ านาจจ าแนกใกล้ +1  
ก็แสดงว่าข้อสอบ นั้นสามารถจ าแนกคนเก่ง และคนอ่อนได้ถูกต้องสูงมาก แต่ถ้าข้อ ใดมีค่าอ านาจ
จ าแนกเป็นลบหรือค่า ใกล ้0 แสดงว่าข้อสอบนั้นจ าแนกคนเก่งคนอ่อนได้ไม่ด ี

(4)  การวิเคราะห์ข้อสอบเพ่ือหาความเชื่อมั่นของข้อสอบ คือค่าคงที่ของ คะแนนที่ได้จาก
การสอบนักเรียนคนเดียวกันหลายครั้งในแบบทดสอบชุดเดิม ควรพิจารณาเฉพาะ ค่าที่เป็นบวก
เท่านั้น ควรจะมีค่ามากกว่า 0.70 จึงจะเป็นแบบทดสอบท่ีมีค่าความเชื่อมั่นได้ 
 

2.5.4  การตรวจสอบคุณภาพด้านเทคโนโลยีมัลติมีเดีย 
เป็นการตรวจสอบคุณภาพด้านเทคโนโลยีมัลติมีเดีย ของบทเรียนที่สร้างขึ้นเสร็จแล้ว 

โดยให้ผู้เชี่ยวชาญด้านมัลติมีเดียเป็นผู้ตรวจสอบ ซึ่งอาจจะตรวจสอบสื่อต่าง  ๆ เช่น สีตัวอักษร  
และสีพ้ืนหลังว่ามีความเหมาะสมหรือไม่ คุณภาพของเสียงดีหรือไม่ ภาพที่น ามาใช้มีความสวย 
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ความคมชัดเจน และมีขนาดภาพที่เหมาะสมหรือไม่ การออกแบบหน้าจอ รวมทั้งการเชื่อมโยง  
ของกรอบการสอนในแต่ละกรอบ 

ขั้นตอนนี้เป็นการตรวจสอบคุณภาพมัลติมีเดียของบทเรียนที่สร้างเสร็จแล้วใน 2 ด้าน คือ 
1.  ตรวจสอบคุณภาพด้านสื่อ โดยผู้ เชี่ยวชาญทางด้านเทคโนโลยีมัลติมี เดีย และ 

นักเทคโนโลยีทางการศึกษาหรือเทียบเท่า 
2.  ตรวจสอบคุณภาพทางด้านเนื้อหาบนหน้าจอ โดยผู้เชี่ยวชาญด้านเนื้อหา  ในการ

ตรวจสอบคุณภาพมัลติมีเดียของบทเรียนนี้ มีจุดมุ่งหมายส าคัญเพ่ือตรวจสอบบทเรียนคอมพิวเตอร์
การสอนที่สร้างขึ้น ซึ่งแตกต่างจากการตรวจสอบที่ผ่านมา คือเน้นเนื้อหาที่จัดเตรียมบนกระดาษ 
การตรวจจุดนี้ เน้นการตรวจสอบตัวบทเรียนที่แสดงบทคอมพิวเตอร์แล้ว หรือ  Computer 
Instruction Package ซึ่งจะเป็นการตรวจสอบคุณภาพของสื่อ การน าเสนอหน้าจอ ความสมบูรณ์ 
ในด้านการเชื่อมโยงเนื้อหาและเทคนิคต่าง ๆ เช่น ลักษณะปฏิสัมพันธ์ของบทเรียน เป็นต้น 
 

2.5.5  ผู้เชี่ยวชาญด้านเทคโนโลยี 
ผู้เชี่ยวชาญด้านเทคโนโลยีมัลติมีเดีย เป็นผู้เชี่ยวชาญที่มีความเชี่ยวชาญในการพัฒนา  

สื่อมัลติมีเดียทางการศึกษา มีหน้าที่ให้ค าปรึกษาด้านการผลิตกับเจ้าหน้าที่เทคนิค รวมทั้งมีหน้าที่ 
ในการตรวจสอบคุณภาพของสื่อ และเทคนิคในการน าเสนอบทเรียนที่สร้างขึ้น อาจจะเป็นผู้เชี่ยวชาญ
ด้าน เทคโนโลยีมัลติมีเดียหรือนักเทคโนโลยีการศึกษา 

นอกจากการตรวจสอบคุณภาพมัลติมีเดียของบทเรียนด้านดังกล่าวแล้ว จะต้องมีการ
ตรวจสอบ ความถูกต้องของเนื้อหาอีกครั้ง เนื่องจากในการจัดลงโปรแกรมอาจมีความคลาดเคลื่อน
จากสิ่งที่เข้าใจ ไม่ตรงกัน ดังนั้น เพ่ือป้องกันความผิดพลาดที่จะเกิดขึ้น จึงต้องมีการตรวจสอบความ
ถูกต้องของ เนื้อหาโดยผู้เชี่ยวชาญด้านเนื้อหาด้วย ผู้เชี่ ยวชาญด้านเนื้อหาจะต้องตรวจสอบความ
ถูกต้องของการ น าเสนอเนื้อหา ความถูกต้องของสื่อประกอบเนื้อหาต่าง ๆ ที่นามาใช้ในหน่วยการ
เรียน รวมทั้งการ ตรวจสอบความถูกต้องอ่ืน ๆ ซึ่งอาจจะเกิดจากความผิดพลาดขณะเขียนโปรแกรม
จะเห็นได้ว่าผู้เชี่ยวชาญด้านเนื้อหามีบทบาทส าคัญมากในการผลิตบทเรียน เพราะจะต้องดูแลการ
ผลิตด้านเนื้อหาอย่างใกล้ชิด ตั้งแต่ขั้นตอนการวิเคราะห์เนื้อหาจนกระทั่งผลิตออกมาเป็นบทเรียน 
ซึ่งสิ่งนี้จะท าให้มั่นใจได้ว่าบทเรียนที่พัฒนาขึ้นมามีความถูกต้อง 
 

2.5.6  เกณฑ์ในการตรวจสอบคุณภาพมัลติมีเดียของบทเรียน 
โดยปกติแล้วในการตรวจสอบคุณภาพมัลติมีเดียของบทเรียน จะต้องมีเกณฑ์ที่เชื่อถือได้ 

ทั้งนี้ เพ่ือให้มีเกณฑ์ในการพิจารณาที่เป็นเกณฑ์เดียวกัน ในเนื้อหานี้จึงขอเสนอเกณฑ์หัวข้อหลัก  ๆ 
ที่ควรค านึงถึงในการตรวจสอบคุณภาพมัลติมีเดียของบทเรียน 

เกณฑ์ในการตรวจสอบคุณภาพมัลติมีเดียของบทเรียน โดยการตรวจสอบจากผู้เชี่ยวชาญ 
ทั้ง 2 ด้าน คือ 

1.  การตรวจสอบโดยผู้เชี่ยวชาญด้านเนื้อหา การตรวจสอบจากผู้เชี่ยวชาญทางด้านเนื้อหา 
ได้แบ่งเกณฑ์ออกเป็น 3 ส่วน ดังนี้  

1.1  เกณฑ์ตรวจสอบเนื้อหา 
1.2  เกณฑ์ตรวจสอบการปฏิสัมพันธ์ 
1.3  เกณฑ์ตรวจสอบโครงสร้างของบทเรียน 
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2.  การตรวจสอบโดยผู้ เชี่ยวชาญด้านเนื้อเทคโนโลยีมัลติมีเดีย  การตรวจสอบโดย
ผู้เชี่ยวชาญด้านเนื้อเทคโนโลยีมัลติมีเดีย ได้แบ่งเกณฑ์ออกเป็น 3 ส่วน ดังนี้ 

2.1  เกณฑ์พิจารณาการน าเสนอมัลติมีเดีย 
2.2  เกณฑ์ตรวจสอบการปฏิสัมพันธ์ 
2.3  โครงสร้างบทเรียน 

 
2.6  การหาประสิทธิภาพของบทเรียนคอมพิวเตอร์ 
 

ชัยยงค์ พรหมวงษ์ (2520 : 135 - 143) ได้ให้แนวคิดและหลักปฏิบัติไว้ว่า เมื่อได้ผลิตสื่อ
หรือชุดการสอนแล้ว ก่อนน าไปใช้จะต้องน าสื่อหรือชุดการสอนที่ผลิตขึ้นไปทดสอบประสิทธิภาพ 
เพ่ือดูว่า สื่อหรือชุดการสอนท าให้ผู้ เรียนมีความรู้เพ่ิมขึ้นหรือไม่  มีประสิทธิภาพในการช่วยให้
กระบวนการเรียนการสอนด าเนินไปอย่างมีประสิทธิภาพเพียงใด มีความสัมพันธ์กับผลลัพธ์หรือไม่ 
และผู้เรียนมีความพึงพอใจต่อการเรียนจากสื่อหรือสื่อหรือชุดการสอนในระดับใด ดังนั้นผู้ผลิตสื่อ 
การสอนจ าเป็นจะต้องน าสื่อหรือชุดการสอนไปหาคุณภาพ เรียกว่า การทดสอบประสิทธิภาพ 
 

2.6.1  ความหมายของประสิทธิภาพ  
 ประสิทธิภาพ (Efficiency) หมายถึง สภาวะหรือคุณภาพของสมรรถนะในการด าเนินงาน 
เพ่ือให้งานหรือความส าเร็จโดยใช้เวลา ความพยายาม และค่าใช้จ่ายคุ้มค่าที่สุดตามจุดมุ่งหมาย 
ที่ก าหนดไว้ เพื่อให้ได้ผลลัพธ์ โดยก าหนดเป็นอัตราส่วนหรือร้อยละระหว่างปัจจัยน าเข้า กระบวนการ
และผลลัพธ์ (Ratio between input, process and output) ประสิทธิภาพเน้นการด าเนินการ 
ที่ถูกต้องหรือกระท าสิ่งใด ๆ อย่างถูกวิธี (Doing the thong right) ค าว่าประสิทธิภาพมักสับสน 
กับค าว่า ประสิทธิผล (Effectiveness) ซึ่งเป็นค าที่คลุมเครือ ไม่เน้นปริมาณ และมุ่งหวังให้บรรลุ
วัตถุประสงค์ และเน้น การท าสิ่งที่ถูกที่ควร (Doing the right thing) ดังนั้น สองค านี้จึงมักใช้คู่กัน 
คือ ประสิทธิภาพและประสิทธิผล 
 

2.6.2  ความหมายของการทดสอบประสิทธิผล   
             การทดสอบประสิทธิภาพของสื่อหรือชุดการสอน จึงหมายถึงการหาคุณภาพของสื่อหรือชุด
การสอน โดยพิจารณาตามขั้นตอนของการพัฒนาสื่อหรือชุดการสอนแต่ละขั้น ตรงกับภาษาอังกฤษว่า 
“Developmental Testing” การทดสอบประสิทธิภาพของชุดหรือสื่อการสอน ตรงกับภาษาอังกฤษ
ว่า Developmental Testing 2 Developmental Testing คือ การทดสอบคุณภาพของการผลิต
สื่อหรือชุดการสอนตามลาดับขั้นเพ่ือตรวจสอบคุณภาพของแต่ละองค์ประกอบของต้นแบบชิ้นงานให้
ด าเนินไปอย่างมีประสิทธิภาพ  

ส าหรับการผลิตสื่อและชุดการสอน การทดสอบประสิทธิภาพ หมายถึง การน าสื่อหรือชุด
การสอนไปทดสอบด้วยกระบวนสองขั้นตอน คือ การทดสอบประสิทธิภาพใช้เบื้องต้น (Try Out) 
ไปและทดสอบประสิทธิภาพสอนจริง (Trial Run) เพ่ือหาคุณภาพของสื่อตามขั้นตอนที่ก าหนด 
ใน 3 ประเด็น คือ การท าให้ผู้เรียนมีความรู้เพ่ิมขึ้น การช่วยให้ผู้เรียนผ่านกระบวนการเรียนและ 
ท าแบบประเมินสุดท้ายได้ดี และการท าให้ผู้เรียนมีความพึงพอใจ น าผลที่ได้มาปรับปรุงแก้ไข 
ก่อนที่จะเผยแพร่เป็นจ านวนมาก 
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2.6.3  ความจ าเป็นที่จะต้องหาประสิทธิภาพ 
การทดสอบประสิทธิภาพของสื่อหรือชุดการสอนมีความจาเป็นด้วยเหตุผล 3 ประการ คือ 

 ส าหรับหน่วยงานผลิตสื่อหรือชุดการสอน การทดสอบประสิทธิภาพช่วยประกันคุณภาพ
ของสื่ อหรือชุดการสอนว่าอยู่ ในขั้นสู ง เหมาะสมที่ จะลงทุนผลิตออกมาเป็นจ า นวนมาก 
หากไม่มีการทดสอบประสิทธิภาพเสียก่อนแล้ว เมื่อผลิตออกมาใช้ประโยชน์ไม่ได้ดี ก็จะต้องผลิต  
หรือท าขึ้นใหม่เป็นการสิ้นเปลืองทั้งเวลา แรงงาน และเงินทอง  

ส าหรับผู้ใช้สื่อหรือชุดการสอน สื่อหรือชุดการสอนที่ผ่านการทดสอบประสิทธิภาพจะท า
หน้าที่เป็นเครื่องมือช่วยสอนได้ดี ในการสร้างสภาพการเรียนให้ผู้เรียนได้เปลี่ยนแปลงพฤติกรรมตามที่
มุ่งหวัง บางครั้งชุดการสอนต้องช่วยครูสอน บางครั้งต้องสอนแทนครู (อาทิ ในโรงเรียนครูคนเดียว) 
ดังนั้น ก่อนน าสื่อหรือชุดการสอนไปใช้ ครูจึงควรมั่นใจว่า ชุดการสอนนั้นมีประสิทธิภาพในการช่วยให้
นักเรียนเกิดการเรียนจริง การทดสอบประสิทธิภาพตามลาดับขั้นจะช่วยให้เราได้สื่อหรือชุดการสอนที่
มีคุณค่าทางการสอนจริงตามเกณฑ์ที่ก าหนดไว้  

ส าหรับผู้ผลิตสื่อหรือชุดการสอน การทดสอบประสิทธิภาพจะท าให้ผู้ผลิตมั่นใจได้ว่าเนื้อหา
สาระที่บรรจุลงในสื่อหรือชุดการสอนมีความเหมาะสม ง่ายต่อการเข้าใจ อันจะช่วยให้ผู้ผลิตมีความ
ช านาญสูงขึ้น เป็นการประหยัดแรงสมอง แรงงาน เวลาและเงินทองในการเตรียมต้นแบบ 
 

2.6.4  ขั้นตอนการหาประสิทธิภาพของบทเรียนผ่านเครือข่ายอินเทอร์เน็ต 
ประสิทธิภาพของกระบวนการ (E1) หมายถึง ประเมินพฤติกรรมย่อย ๆ จากการท า

กิจกรรมของผู้เรียนในบทเรียนทุกกิจกรรม(ทุกกรอบ/ข้อ)หรือจากการที่นักเรียนได้อ่านบทเรียนถูก
มากน้อยเพียงใดนั่นเอง 

ประสิทธิภาพของผลลัพธ์ (E2) หมายถึง การประเมินผลลัพธ์ (Product) ของนักเรียนโดย
พิจารณาจากผลการทดสอบหลังเรียน (Post-test) 

ในการเขียนประสิทธิภาพของนวัตกรรมนั้นมักเขียนในลักษณะของ E1 / E2 เช่น 70/70, 
80/80, 90/90 เป็นต้น 

2.6.4.1  การก าหนดเกณฑ์การหาประสิทธิภาพ 
การก าหนดเกณฑ์ E1 / E2  ให้มีค่าเท่าใด ควรก าหนดไว้ก่อนว่าในครั้งนี้ว่าจะให้

มาตรฐานหรือเกณฑ์มาตรฐานเท่าใด  โดยยึดเกณฑ์ในการพิจารณาก าหนดเกณฑ์มาตรฐาน ดังนี้ 
 (1) เนื้อหาวิชาที่เป็นความรู้ ความจ า ควรตั้งเกณฑ์ให้สูงไว้ คือ 80/80, 85/85, 
90/90 
 (2)  เนื้อหาวิชาที่เป็นทกัษะหรือเจตคติ ควรตั้งเกณฑ์ให้ต่ าลงมาเล็กน้อย 
คือ 70/70, 75/75 แต่อาจตั้งเกณฑ์สูงกว่านี้ก็ได้ 
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 2.6.4.2  การค านวณหาประสิทธิภาพ 
 การค านวณหาประสิทธิภาพ คือ การหาค่าประสิทธิภาพของกระบวนการ (E1) และ
ประสิทธิภาพของผลลัพธ์ (E2) ซึ่งมีแนวทางการค านวณ ดังนี้ 
  (1)  การค านวณหาประสิทธิภาพของกระบวนการ (E1) 

   1001 




 X

E  

    
  เมื่อ 1E  คือ ประสิทธิภาพของกระบวนการ 
              X  คือ คะแนนรวมของแบบฝึกหัดหรือกิจกรรมในบทเรียน 
     คือ คะแนนเต็มของแบบฝึกหัดหรือกิจกรรมในบทเรียน 
     คือ จ านวนผู้เรียน 
 (2)  การค านวณหาประสิทธิภาพของผลลัพธ์ (E2) 

   1002 




 F

E  

 
  เมื่อ 2E  คือ ประสิทธิภาพของผลลัพธ์ 
            2X  คือ คะแนนรวมของแบบทดสอบหลังเรียน 
     คือ คะแนนเต็มของแบบทดสอบหลังเรียน 
     คือ จ านวนผู้เรียน 

2.6.4.3  การยอมรับประสิทธิภาพ 
 (1)  สูงกว่าเกณฑ์ คือ ตั้งเกณฑ์ E1 / E2 ไว้ แล้วได้ค่าประสิทธิภาพสูงกว่า
เกณฑ์ที่ก าหนดไว้ เช่น ตั้งเกณฑ์มาตรฐานไว้ 90/90 แล้วค านวณค่าประสิทธิภาพบทเรียนส าเร็จรูปได้ 
95/95 
 (2)  เท่าเกณฑ์ คือ ตั้งเกณฑ์ E1 / E2 ไว้ แล้วได้คา่ประสิทธิภาพเท่ากับ
เกณฑ์ที่ตั้งไว้พอดี เช่น ตั้งเกณฑ์มาตรฐานไว้ 90/90 แล้วค านวณค่าประสิทธิภาพบทเรยีนส าเร็จรูปได้ 
90/90 
 (3)  ต่ ากว่าเกณฑ์ คือ ตั้งเกณฑ์ E1 / E2 ไว้ แล้วได้ค่าประสิทธิภาพต่ ากว่า
เกณฑ์ที่ตั้งไว้ ไม่เกิน + 2.5 % 
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2.7  ทฤษฎีการเรียนรู้ของ Bloom 
 

Bloom’s Taxonomy กล่าวถึงการจ าแนกผลการเรียนรู้ตามทฤษฎีของบลูม ซึ่งแบ่งเป็น  
3 ด้าน คือ ด้านพุทธิพิสัย ด้านจิตพิสัย และด้านทักษะพิสัย โดยในแต่ละด้านจะมีการจ าแนกระดับ
ความสามารถจากต่ าสุดไปถึงสูงสุด เช่น ด้านพุทธิพิสัย เริ่มจากความรู้ ความเข้าใจ การน าไปใช้ 
การวิเคราะห์ การสังเคราะห์ การประเมิน นอกจากนี้ยังน าเสนอระดับความสามารถที่มีการปรับปรุง
ใหม่ตามแนวคิดของ Anderson and Krathwohl (2001) เป็นการจ า(Remembering) การเข้าใจ
(Understanding) การป ระยุ กต์ ใช้ (Applying) การวิ เค ราะห์  (Analysing) การป ระเมิ นผล 
(Evaluating) และการสร้างสรรค์ (Creating) ด้านจิตพิสัย จ าแนกเป็น การรับรู้ , การตอบสนอง, 
การสร้างค่านิยม, การจัดระบบ และการสร้างคุณลักษณะจากค่านิยม ด้านทักษะพิสัย จ าแนกเป็น 
ทักษะการเคลื่อนไหวของร่างกาย, ทักษะการเคลื่อนไหวอวัยวะสองส่วนหรือมากกว่าพร้อม ๆ กัน  
ทักษะการสื่อสารโดยใช้ท่าทาง และทักษะการแสดงพฤติกรรมทางการพูด 

Bloom ได้แบ่งการเรียนรู้เป็น 6 ระดับ 
1.  ความรู้ ความจ า (Knowledge) ซึ่งเป็นระดับล่างสุด 
2.  ความเข้าใจ (Comprehension) 
3.  การน าความรู้ไปประยุกต์ (Application) 
4.  การวิเคราะห์ (Analysis) สามารถแก้ปัญหา ตรวจสอบได้ 
5.  การสังเคราะห์ (Synthesis) สามารถน าส่วนต่าง ๆ มาประกอบเป็นรูปแบบใหม่ได้ให้

แตกต่างจากรูปเดิม เน้นโครงสร้างใหม่ 
6.  การประเมินค่า (Evaluation) วัดได้ และตัดสินได้ว่าอะไรถูกหรือผิด ประกอบการ

ตัดสินใจบนพื้นฐานของเหตุผลและเกณฑ์ท่ีแน่ชัด 
ทฤษฎีของ Bloom ได้จ าแนกจุดมุ่งหมายการเรียนรู้ออกเป็น 3 ด้าน  คือ 
1.  พุทธิพิสัย (Cognitive Domain) พฤติกรรมด้านสมองเป็นพฤติกรรมเก่ียวกับสติปัญญา 

ความรู้ ความคิด ความเฉลียวฉลาด ความสามารถในการคิดเรื่ องราวต่าง ๆ อย่างมีประสิทธิภาพ 
ซึ่งเป็นความสามารถทางสติปัญญา พฤติกรรมทางพุทธิพิสัย 6 ระดับ ได้แก่ 

1.1  ความรู้ความจ า ความสามารถในการเก็บรักษามวลประสบการณ์ต่าง ๆ จากการที่
ได้รับรู้ไว้และระลึกสิ่งนั้นได้เมื่อต้องการเปรียบดังเทปบันทึกเสียงหรือวีดิทัศน์ที่สามารถเก็บเสียงและ
ภาพของเรื่องราวต่าง ๆ ได ้ สามารถเปิดฟังหรือ ดูภาพเหล่านั้นได้  เมื่อต้องการ 

1.2  ความเข้าใจเป็นความสามารถในการจับใจความส าคัญของสื่อ และสามารถแสดง
ออกมาในรูปของการแปลความ ตีความ คาดคะเน ขยายความ หรือ การกระท าอ่ืน ๆ  

1.3  การน าความรู้ไปใช้ เป็นขั้นที่ผู้เรียนสามารถน าความรู้ ประสบการณ์ไปใช้ในการ
แก้ปัญหาในสถานการณ์ต่าง ๆ ได้ ซึ่งจะต้องอาศัยความรู้ความเข้าใจ จึงจะสามารถน าไปใช้ได้ 

1.4  การวิเคราะห์ ผู้ เรียนสามารถคิด หรือ แยกแยะเรื่องราวสิ่งต่าง ๆ ออกเป็ น
ส่วนย่อย เป็นองค์ประกอบที่ ส าคัญ ได้  และมองเห็นความสัมพันธ์ของส่วนที่ เกี่ยวข้องกัน 
ความสามารถในการวิเคราะห์จะแตกต่างกันไปแล้วแต่ความคิดของแต่ละคน 

1.5  การสังเคราะห์ ความสามารถในการที่ผสมผสานส่วนย่อย ๆ เข้าเป็นเรื่องราว
เดียวกันอย่างมีระบบ เพ่ือให้เกิดสิ่งใหม่ที่สมบูรณ์และดีกว่าเดิม อาจเป็นการถ่ายทอดความคิดออกมา

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 
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ให้ผู้อ่ืนเข้าใจได้ง่าย การก าหนดวางแผนวิธีการด าเนินงานขึ้นใหม่ หรือ อาจจะเกิดความคิดในอันที่จะ
สร้างความสัมพันธ์ของสิ่งที่เป็นนามธรรมขึ้นมาในรูปแบบ หรือ แนวคิดใหม่ 

1.6  การประเมินค่า เป็นความสามารถในการตัดสิน ตีราคา หรือ สรุปเกี่ยวกับคุณค่า
ของสิ่งต่าง ๆ ออกมาในรูปของคุณธรรมอย่างมีกฎเกณฑ์ที่เหมาะสม ซึ่งอาจเป็นไปตามเนื้อหาสาระใน
เรื่องนั้น ๆ หรืออาจเป็นกฎเกณฑ์ท่ีสังคมยอมรับก็ได้ 

2.  จิตพิสัย (Affective Domain) (พฤติกรรมด้านจิตใจ)ค่านิยม ความรู้สึก ความ
ซาบซึ้ง  ทัศนคติ ความเชื่อ ความสนใจและคุณธรรม  พฤติกรรมด้านนี้อาจไม่เกิดขึ้นทันที ดังนั้น 
การจัดกิจกรรมการเรียนการสอนโดยจัดสภาพแวดล้อมที่เหมาะสม และสอดแทรกสิ่งที่ดีงามอยู่
ตลอดเวลา จะท าให้พฤติกรรมของผู้เรียนเปลี่ยนไปในแนวทางที่พึงประสงค์ได้ 
ด้านจิตพิสัย จะประกอบด้วย พฤติกรรมย่อย ๆ 5 ระดับ ได้แก่ 

2.1  การรับรู้ เป็นความรู้สึกท่ีเกิดข้ึนต่อปรากฏการณ ์หรือสิ่งเร้าอย่างใดอย่างหนึ่ง 
ซึ่งเป็นไปในลักษณะของการแปลความหมายของสิ่งเร้านั้นว่าคืออะไร แล้วจะแสดงออกมาในรูปของ
ความรู้สึกท่ีเกิดข้ึน 

2.2  การตอบสนอง เป็นการกระท าที่แสดงออกมาในรูปของความเต็มใจ ยินยอม และ
พอใจต่อสิ่งเร้านั้น ซึ่งเป็นการตอบสนองที่เกิดจากการเลือกสรรแล้ว 

2.3  การเกิดค่านิยม การเลือกปฏิบัติในสิ่งที่เป็นที่ยอมรับกันในสังคม การยอมรับนับถือ
ในคุณค่านั้น ๆ หรือปฏิบัติตามในเรื่องใดเรื่องหนึ่งจนกลายเป็นความเชื่อแล้วจึงเกิดทัศนคติที่ดีในสิ่งนั้น 
                 2.4  การจัดระบบ การสร้างแนวคิด จัดระบบของค่านิ ยมที่ เกิดขึ้นโดยอาศัย
ความสัมพันธ์ ถ้าเข้ากันได้ก็จะยึดถือต่อไปแต่ถ้าขัดกันอาจไม่ยอมรับอาจจะยอมรับค่านิยมใหม่โดย
ยกเลิกค่านิยมเก่า 
                 2.5  บุคลิกภาพ การน าค่านิยมที่ยึดถือมาแสดงพฤติกรรมที่ เป็นนิสัยประจ าตัว 
ให้ประพฤติปฏิบัติแต่สิ่งที่ถูกต้องดีงามพฤติกรรมด้านนี้ จะเกี่ยวกับความรู้สึกและจิตใจ ซึ่งจะเริ่มจาก
การได้รับรู้จากสิ่งแวดล้อม แล้วจึงเกิดปฏิกิริยาโต้ตอบ ขยายกลายเป็นความรู้สึกด้านต่าง ๆ  จน
กลายเป็นค่านิยม และยังพัฒนาต่อไปเป็นความคิด อุดมคติ ซึ่งจะเป็นควบคุมทิศทางพฤติกรรมของ
คนคนจะรู้ดีรู้ชั่วอย่างไรนั้น ก็เป็นผลของพฤติกรรมด้านนี้ 

3.  ทักษะพิสัย (Psychomotor Domain) (พฤติกรรมด้านกล้ามเนื้อประสาท) พฤติกรรม 
ที่บ่งถึงความสามารถในการปฏิบัติงานได้อย่างคล่องแคล่วช านิช านาญ   ซึ่งแสดงออกมาได้โดยตรง 
โดยมีเวลาและคุณภาพของงานเป็นตัวชี้ระดับของทักษะ 

พฤติกรรมด้านทักษะพิสัย ประกอบด้วย พฤติกรรมย่อย ๆ 5 ขั้น ดังนี้ 
3.1  การรับรู้ เป็นการให้ผู้เรียนได้รับรู้หลักการปฏิบัติที่ถูกต้อง หรือ เป็นการเลือกหา

ตัวแบบที่สนใจ 
3.2  กระท าตามแบบ หรือ เครื่องชี้แนะ เป็นพฤติกรรมที่ผู้เรียนพยายามฝึกตามแบบที่

ตนสนใจและพยายามท าซ้ า เพ่ือที่จะให้เกิดทักษะตามแบบที่ตนสนใจให้ได้ หรือ สามารถปฏิบัติงาน
ได้ตามข้อแนะน า 

3.3  การหาความถูกต้อง พฤติกรรมสามารถปฏิบัติได้ด้วยตนเอง โดยไม่ต้องอาศัย
เครื่องชี้แนะ เมื่อได้กระท าซ้ าแล้ว ก็พยายามหาความถูกต้องในการปฏิบัติ 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 
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3.4  การกระท าอย่างต่อเนื่องหลังจากตัดสินใจเลือกรูปแบบที่เป็นของตัวเองจะกระท า
ตามรูปแบบนั้นอย่างต่อเนื่อง จนปฏิบัติงานที่ยุ่งยากซับซ้อนได้อย่างรวดเร็ว ถูกต้อง คล่องแคล่ว การ
ที่ผู้เรียนเกิดทักษะได้ ต้องอาศัยการฝึกฝนและกระท าอย่างสม่ าเสมอ 

3.5  การกระท าได้อย่างเป็นธรรมชาติ พฤติกรรมที่ได้จากการฝึกอย่างต่อเนื่องจน
สามารถปฏิบัติ ได้คล่องแคล่วว่องไวโดยอัตโนมัติ เป็นไปอย่างธรรมชาติ  ซึ่งถือเป็นความสามารถของ
การปฏิบัติในระดับสูง 
  
2.8  การหาผลสัมฤทธิ์ทางการเรียน 
 

2.8.1  ความหมายของผลสัมฤทธิ์ทางการเรียน 
ผลสัมฤทธิ์ทางการเรียน (Learning  Achievement) เป็นผลที่เกิดจากปัจจัยต่าง ๆ ในการ

จัดการศึกษา นักศึกษาได้ให้ความส าคัญกับผลสัมฤทธิ์ทางการเรียน และเนื่องจากผลสัมฤทธิ์ทางการเรียน
เป็นดัชนีประการหนึ่งที่สามารถบอกถึงคุณภาพการศึกษา (ปริยทิพย์ บุญคง. 2546 : 7) สรุปได้ว่า 
ผลสัมฤทธิ์ทางการเรียนมีความสัมพันธ์กับองค์ประกอบด้านสติปัญญา และองค์ประกอบด้านที่ไม่ใช้
สติปัญญา ได้แก่ องค์ประกอบด้านเศรษฐกิจ สังคม แรงจูงใจ และองค์ประกอบที่ไม่ใช้สติปัญญา 
ด้านอื่น 

Eysenck, Arnold and Meili. (อ้างใน ปริยทิพย์ บุญคง. 2546 : 7) ให้นิยามของค าว่า 
ผลสัมฤทธิ์ทางการเรียน หมายถึง ขนาดของความส าเร็จที่ได้จากการท างานที่ต้องอาศัยความ
พยายามอย่างมาก ซึ่งเป็นผลมาจากการกระท าที่ต้องอาศัยทั้งความสามารถทั้งทางร่างกายและ
สติปัญญา ดังนั้น ผลสัมฤทธิ์ทางการเรียนจึงเป็นขนาดของความส าเร็จที่ได้จากการเรียนโดยอาศัย
ความสามารถเฉพาะตัวบุคคล ผลสัมฤทธิ์ทางการเรียนอาจได้จากกระบวนการที่ไม่ต้องทดสอบ 
เช่น การสังเกต การตรวจการบ้าน หรืออาจได้ในรูปแบบของเกรดจากโรงเรียน ซึ่งต้องอาศัย
กระบวนการที่ซับซ้อนและระยะเวลานานพอสมควร หรืออาจได้จากแบบทดสอบวัดผลสัมฤทธิ์ 
ทางการเรียนทั่วไปซึ่งสอดคล้องกับ ไพศาล หวังพานิช (2536 : 89) ที่ให้ความหมายผลสัมฤทธิ์ 
ทางการเรียน  หมายถึง  คุณลักษณะและความสามารถของบุคคลอันเกิดจากการเรียนการสอนเป็น
การเปลี่ยนแปลงพฤติกรรมและประสบการณ์การเรียนที่เกิดขึ้นจากการฝึกอบรมหรือการสอบ จึงเป็น
การตรวจสอบระดับความสามารถของบุคคลว่าเรียนแล้วมีความรู้เท่าใด สามารถวัดได้โดยการใช้
แบบทดสอบต่าง ๆ เช่น ใช้ข้อสอบวัดผลสัมฤทธิ์ ข้อสอบวัดภาคปฏิบัติ สามารถวัดได้ 2 รูปแบบ  ดังนี้ 

(1)  การวัดด้านปฏิบัติ เป็นการตรวจสอบระดับความสามารถในการปฏิบัติ 
โดยทักษะของผู้เรียน โดยมุ่งเน้นให้ผู้เรียนแสดงความสามารถดังกล่าว ในรูปของการกระท าจริง 
ให้ออกเป็นผลงาน การวัดต้องใช้ข้อสอบภาคปฏิบัติ 

(2)  การวัดด้านเนื้อหา เป็นการตรวจสอบความสามารถเกี่ยวกับเนื้อหา ซึ่งเป็น
ประสบการณ์ เรียน รวมถึงพฤติกรรมความสามารถในด้านต่าง  ๆ สามารถวัดได้โดยใช้แบบ 
วัดผลสัมฤทธิ์  

จากความหมายข้างต้นสรุปได้ว่า ผลสัมฤทธิ์ทางการเรียน หมายถึง ผลการวัด  
การเปลี่ยนแปลงและประสบการณ์การเรียนรู้ ในเนื้อหาสาระที่เรียนมาแล้วว่าเกิดการเรียนรู้เท่าใด  
มีความสามารถชนิดใด โดยสามารถวัดได้จากแบบทดสอบวัดสัมฤทธิ์ในลักษณะต่าง ๆ และการวัดผล
ตามสภาพจริงเพื่อบอกถึงคุณภาพการศึกษาความหมายของการวัดผลสัมฤทธิ์ทางการเรียน 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 
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2.8.2  ความหมายของแบบทดสอบวัดผลสัมฤทธิ์ทางการเรียน  
นักการศึกษาหลายท่านได้ให้ความหมายของแบบทดสอบวัดผลสัมฤทธิ์ทางการเรียนไว้ดังนี้ 

สมนึก ภัททิยธนี (2546 : 78-82) ได้ให้ความหมายของแบบทดสอบวัดผลสัมฤทธิ์ทางการเรียน 
หมายถึง แบบทดสอบวัดสมรรถภาพทางสมองต่าง ๆ ที ่นักเรียนได้รับการเรียนรู้ผ ่านมาแล้ว 
ซึ่งแบ่งได้เป็น  2  ประเภท  คือ แบบทดสอบที่ครูสร้างกับแบบทดสอบมาตรฐาน แต่ เนื่องจาก
ครูต้องท าหน้าที่วัดผลนักเรียน คือเขียนข้อสอบวัดผลสัมฤทธิ์ที่ตนได้สอน ซึ่งเกี่ยวข้องโดยตรงกับ
แบบทดสอบท่ีครูสร้างและมีหลายแบบแต่ที่นิยมใช้มี  6  แบบ ดังนี้ 

2.8.2.1  ข้อสอบแบบอัตนัยหรือความเรียง ลักษณะทั่วไปเป็นข้อสอบที่มีเฉพาะ
ค าถาม แล้วให้นักเรียนเขียนตอบอย่างเสรี เขียนบรรยายตามความรู้ และข้อคิดเห็นแต่ละคน 
 2.8.2.2  ข้อสอบแบบกาถูก-ผิด ลักษณะทั่วไป ถือได้ว่าข้อสอบแบบกาถูก-ผิด คือ 
ข้อสอบแบบเลือกตอบที่มี 2 ตัวเลือก แต่ตัวเลือกดังกล่าวเป็นแบบคงที่และมีความหมายตรงกันข้าม 
เช่น ถูก-ผิด ใช่-ไม่ใช่ จริง-ไม่จริง เหมือนกัน-ต่างกัน เป็นต้น 
 2.8.2.3  ข้อสอบแบบเติมค า  ลักษณะทั่วไปเป็นข้อสอบที่ประกอบด้วยประโยคหรือ
ข้อความที่ยังไม่สมบูรณ์ให้ผู้ตอบเติมค า หรือประโยค หรือข้อความลงในช่องว่างที่เว้นไว้นั้น เพ่ือให้มี
ใจความสมบูรณ์และถูกต้อง 
 2.8.2.4  ข้อสอบแบบตอบสั้น ๆ  ลักษณะทั่วไป ข้อสอบประเภทนี้คล้ายกับข้อสอบ
แบบเติมค า แต่แตกต่างกันที่ข้อสอบแบบตอบสั้น ๆ เขียนเป็นประโยคค าถามสมบูรณ์ (ข้อสอบเติมค า
เป็นประโยคที่ยังไม่สมบูรณ์) แล้วให้ผู้ตอบเป็นคนเขียนตอบ ค าตอบที่ต้องการจะสั้นและกะทัดรัด
ได้ใจความสมบูรณ์ไม่ใช่เป็นการบรรยายแบบข้อสอบอัตนัยหรือความเรียง 
 2.8.2.5  ข้อสอบแบบจับคู่ ลักษณะทั่วไป เป็นข้อสอบเลือกตอบชนิดหนึ่งโดยมีค า
หรือข้อความแยกจากกันเป็น 2 ชุด แล้วให้ผู้ตอบเลือกจับคู่ว่า แต่ละข้อความในชุดหนึ่ง (ตัวยืน ) 
จะคู่กับค า หรือข้อความใดในอีกชุดหนึ่ง (ตัวเลือก) ซึ่งมีความสัมพันธ์กันอย่างใดอย่างหนึ่งตามที่ 
ผู้ออกข้อสอบก าหนดไว้ 
 2.8.2.6  ข้อสอบแบบเลือกตอบ ลักษณะทั่วไป ข้อสอบแบบเลือกตอบนี้จะ
ประกอบด้วย 2 ตอน ตอนน าหรือค าถามกับตอนเลือก ในตอนเลือกนี้จะประกอบด้วยตัวเลือกที่เป็น
ค าตอบถูกและตัวเลือกท่ีเป็นตัวลวง ปกติจะมีค าถามที่ 
 ก าหนดให้นักเรียนพิจารณาแล้วหาตัวเลือกท่ีถูกต้องมากที่สุดเพียงตัวเลือกเดียวจาก
ตัวเลือกอ่ืน ๆ และค าถามแบบเลือกตอบที่ดีนิยมใช้ตัวเลือกที่ใกล้เคียงกัน ดูเผิน ๆ จะเห็นว่าทุกตัวเลือก
ถูกหมดแต่ความจริงมีน้ าหนักถูกมากน้อยต่างกัน 
 พวงรัตน์ ทวีรัตน์ (2543 : 96) ได้กล่าวถึงแบบทดสอบวัดผลสัมฤทธิ์ทางการ
เรียนในท านองเดียวกันว่า หมายถึง แบบทดสอบที่วัดความรู้ของนักเรียนที่ได้เรียนไปแล้ว ซึ่งมักจะ
เป็นข้อค าถามให้นักเรียนตอบด้วยกระดาษและดินสอกับให้นักเรียนปฏิบัติจริง 
 จากความหมายของแบบทดสอบวัดผลสัมฤทธิ์ทางการเรียนที่กล่าวมาแล้ว สรุปได้ว่า
แบบทดสอบวัดผลสัมฤทธิ์ทางการเรียน หมายถึง แบบทดสอบที่วัดความรู้ความสามารถทางการเรียน
ด้านเนื้อหาด้านวิชาการและทักษะต่าง ๆ ของวิชาต่าง ๆ 
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2.8.3  หลักเกณฑ์ในการสร้างแบบทดสอบวัดผลสัมฤทธิ์ทางการเรียน 
ในการสร้างแบบทดสอบวัดผลสัมฤทธิ์ทางการเรียน ผู้วิจัยได้วิเคราะห์จากนักการศึกษา

หลาย ๆ ท่าน ที่กล่าวถึงหลักเกณฑ์ไว้สอดคล้องกัน และได้ล าดับเป็นขั้นตอนดังนี้ 
2.8.3.1  เนื้อหาหรือทักษะที่ครอบคลุมในแบบทดสอบนั้น จะต้องเป็นพฤติกรรมที่

สามารถวัดผลสัมฤทธิ์ได้ 
2.8.3.2  ผลสัมฤทธิ์ทางการเรียนที่ใช้แบบทดสอบวัดนั้นถ้าน าไปเปรียบเทียบกัน

จะต้องให้ทุกคนมีโอกาสเรียนรู้ในสิ่งต่าง ๆ เหล่านั้นได้ครอบคลุมและเท่าเทียมกัน 
2.8.3.3  วัดให้ตรงกับจุดประสงค์ การสร้างแบบทดสอบวัดผลสัมฤทธิ์ทางการเรียน 

ควรจะวัดตามวัตถุประสงค์ทุกอย่างของการสอน และจะต้องมั่นใจว่าได้วัดสิ่งที่ต้องการจะวัดได้จริง 
2.8.3.4  การวัดผลสัมฤทธิ์ทางการเรียน เป็นการวัดความเจริญงอกงามของ

นักเรียน การเปลี่ยนแปลงและความก้าวหน้าไปสู่วัตถุประสงค์ที่วางไว้ ดังนั้น ครูควรจะทราบว่าก่อน
เรียนนักเรียนมีความรู้ความสามารถอย่างไร เมื่อเรียนเสร็จแล้วมีความรู้แตกต่างจากเดิมหรือไม่  
โดยการทดสอบก่อนเรียนและทดสอบหลังเรียน 

2.8.3.5  การวัดผลเป็นการวัดผลทางอ้อม เป็นการยากที่จะใช้ข้อสอบแบบเขียน
ตอบวัดพฤติกรรมตรง ๆ ของบุคคลได้ สิ่งที่วัดได้ คือ การตอบสนองต่อข้อสอบ ดังนั้น การเปลี่ยน
วัตถุประสงค์ให้เป็นพฤติกรรมที่จะสอบ จะต้องท าอย่างรอบคอบและถูกต้อง 

2.8.3.6  การวัดการเรียนรู้ เป็นการยากท่ีจะวัดทุกสิ่งทุกอย่างที่สอนได้ภายในเวลา
จ ากัด สิ่งที่วัดได้เป็นเพียงตัวแทนของพฤติกรรมทั้งหมดเท่านั้น ดังนั้นต้องมั่นใจว่าสิ่งที่วัดนั้นเป็น
ตัวแทนแท้จริง 

2.8.3.7  การวัดผลสัมฤทธิ์ทางการเรียนเป็นเครื่องช่วยพัฒนาการสอนของครู และ
เป็นเครื่องช่วยในการเรียนของเด็ก  

2.8.3.8  ในการศึกษาที่สมบูรณ์นั้น สิ่งส าคัญไม่ได้อยู่ที่การทดสอบแต่เพียงอย่าง
เดียวการทบทวนการสอนของครูก็เป็นสิ่งส าคัญยิ่ง 

2.8.3.9  การวัดผลสัมฤทธิ์ทางการเรียน ควรจะเน้นในการวัดความสามารถในการ
ใช้ความรู้ให้เป็นประโยชน์ หรือการน าความรู้ไปใช้ในสถานการณ์ใหม่ ๆ 

2.8.3.10  ควรใช้ค าถามให้สอดคล้องกับเนื้อหาวิชาและวัตถุประสงค์ที่วัด 
2.8.3.11  ให้ข้อสอบมีความเหมาะสมกับนักเรียนในด้านต่าง ๆ เช่น ความยากง่าย

พอเหมาะ   มีเวลาพอส าหรับนักเรียนในการท าข้อสอบ    
จากที่กล่าวข้างต้น สรุปได้ว่า ในการสร้างแบบทดสอบให้มีคุณภาพ วิธีการสร้าง

แบบทดสอบที่เป็นค าถาม เพ่ือวัดเนื้อหาและพฤติกรรมที่สอนไปแล้วต้องตั้งค าถามที่สามารถวัด
พฤติกรรมการเรียนการสอนได้อย่างครอบคลุมและตรงตามจุดประสงค์การเรียนรู้ 

 

2.8.4  ชนิดของแบบทดสอบวัดผลสัมฤทธิ์ทางการเรียน 
ล้วน สายยศ และอังคณา สายยศ (2538 : 146) ได้ให้ความหมายของแบบทดสอบ

วัดผลสัมฤทธิ์ทางการเรียนไว้ว่า เป็นแบบทดสอบที่วัดความรู้ของนักเรียนหลังจากที่ได้เรียน ไป
แล้วซึ่งมักจะเป็นข้อค าถามให้นักเรียนตอบด้วยกระดาษและดินสอกับให้นักเรียนปฏิบัติจริง  
ซึ่งแบ่งแบบทดสอบประเภทนี้เป็น 2 ประเภท คือ 

2.8.4.1  แบบทดสอบของครู หมายถึง ชุดของข้อค าถามที่ครูเป็นผู้สร้างขึ้น เป็นข้อ
ค าถามท่ีเกี่ยวกับความรู้ที่นักเรียนได้เรียนในห้องเรียน เป็นการทดสอบว่านักเรียนมีความรู้มากแค่ไหน
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บกพร่องในส่วนใดจะได้สอนซ่อมเสริม หรือเป็นการวัดเพ่ือดูความพร้อมที่จะเรียนในเนื้อหาใหม่ 
ทั้งนี้ข้ึนอยู่กับความต้องการของครู 

2.8.4.2  แบบทดสอบมาตรฐาน หมายถึง แบบทดสอบที่สร้างขึ้นจากผู้เชี่ยวชาญใน
แต่ละสาขาวิชา หรือจากครูที่สอนวิชานั้น แต่ผ่านการทดลองหาคุณภาพหลายครั้ง จนมีคุณภาพดีจึง
สร้างเกณฑ์ปกติของแบบทดสอบนั้น สามารถใช้หลักและเปรียบเทียบผลเพ่ือประเมินค่าของการเรียน
การสอนในเรื่องใด ๆ ก็ได้ แบบทดสอบมาตรฐานจะมีคู่มือด าเนินการสอบบอดถึงวิธีการ และยังมี
มาตรฐานในด้านการแปลคะแนนด้วยทั้งแบบทดสอบของครูและแบบทดสอบมาตรฐาน จะมีวิธีการ
ในการสร้างข้อค าถามที่เหมือนกัน เป็นค าถามที่วัดเนื้อหาและพฤติกรรมในด้านต่าง  ๆ ทั้ง 4 ด้าน  
ดังนี้ 

(1)  วัดด้านการน าไปใช้ 
 (2)  วัดด้านการวิเคราะห์ 
 (3)  วัดด้านการสังเคราะห์ 
 (4)  วัดด้านการประเมินค่า 
 
2.9  งานวิจัยที่เกี่ยวข้อง 
 

2.9.1  งานวิจัยในประเทศ 
ธณัฐภรณ์ สนิทมาก (2554 : 44-45) ได้พัฒนาและหาประสิทธิภาพของบทเรียนผ่าน

เครือข่ายอินเทอร์เน็ต และเปรียบเทียบผลสัมฤทธิ์ทางการเรียนก่อนและหลังเรียนด้วยบทเรียนผ่าน
เครือข่ายอินเทอร์เน็ต เรื่องนิพจน์และตัวด าเนินการ นักเรียนชั้นมัธยมศึกษาปีที่ 5 โรงเรียนแก่งคอย 
กลุ่มตัวอย่างได้มาจากการสุ่มตัวอย่างแบบแบ่งกลุ่มจ านวน 40 คน โดยแบบทดสอบวัดผลสัมฤทธิ์
ทางการเรียน มีค่าดัชนีความสอดคล้องเท่ากับ 0.67- 1.00 ค่าความยากง่ายอยู่ระหว่าง 0.20-0.66 
ค่าอ านาจจ าแนกอยู่ระหว่าง 0.38 – 0.60และค่าความเชื่อมั่นเท่ากับ 0.74ผลการวิจัยพบว่าบทเรียนมี
คุณภาพด้านเนื้อหาอยู่ในระดับดี (x̅= 4.02) และด้านเทคนิคการผลิตสื่ออยู่ในระดับดี (x̅ = 4.18)  
บทเรียนมีประสิทธิภาพ 81.50/82.25 ผลสัมฤทธิ์ทางการเรียนเรื่องนิพจน์และตัวด าเนินการ หลัง
เรียนด้วยบทเรียนผ่านเครือข่ายอินเทอร์เน็ตสูงกว่าก่อนเรียน อย่างมีนัยส าคัญทางสถิติที่ระดับ 0.05 

ไพบูลย์ ปัทมวิภาต (2552 : 67-68) ได้พัฒนา หาคุณภาพ ประสิทธิภาพ และเปรียบเทียบ
ผลสัมฤทธิ์ทางการเรียนก่อนเรียนและหลังเรียนด้วยบทเรียนคอมพิวเตอร์ช่วยสอนผ่านเครือข่าย
อินเทอร์เน็ตเพ่ือทบทวนวิชาหลักการเขียนโปรแกรม 2  โดยกลุ่มตัวอย่างคือนักเรียนชั้นมัธยมศึกษาปี
ที่ 4โรงเรียนเทพศิรินทร์ได้มาจากการสุ่มตัวอย่างแบบแบ่งกลุ่มจ านวน 45 คนโดยแบบทดสอบวัด
ผลสัมฤทธิ์ทางการเรียน มีค่าความยากง่ายอยู่ระหว่าง 0.30-0.80ค่าอ านาจจ าแนกอยู่ระหว่าง 0.26 – 
0.74และค่าความเชื่อมั่นเท่ากับ 0.91 ผลการวิจัยพบว่าบทเรียนมีคุณภาพด้านเนื้อหาอยู่ในระดับดี
มาก (x̅= 4.63) และด้านเทคนิคการผลิตสื่ออยู่ในระดับดี (x̅= 4.11)  บทเรียนมีประสิทธิภาพ
82.67/80.56 ผลสัมฤทธิ์ทางการเรียนด้วยบทเรียนคอมพิวเตอร์ช่วยสอนผ่านเครือข่ายอินเทอร์เน็ต
เพ่ือทบทวนหลังเรียนสูงกว่าก่อนเรียน อย่างมีนัยส าคัญทางสถิติที่ระดับ 0.05 ซึ่งเป็นไปตาม
สมมุติฐานที่ตั้งไว้ 
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จุฑารัตน์ ศราวณะวงศ์ (2543 : 38-44)  ได้ท าการวิจัยเรื่อง ผลของการเรียนบนเครือข่าย
ต่อผลสัมฤทธิ์ทางการเรียน เรื่องของการใช้ เครื่องมือช่วยค้นสารสนเทศบนอินเทอร์ เน็ ต  
ของนักศึกษาคณะพยาบาลศาสตร์ มหาวิทยาลัยขอนแก่น วิจัยครั้งนี้มีวัตถุประสงค์เพ่ือศึกษา
ผลสัมฤทธิ์ทางการเรียน และความพึงพอใจในการเรียนบนเครือข่ายเรื่อง การใช้เครื่องมือช่วยค้น
สารสนเทศบนอินเทอร์เน็ตของนักศึกษาที่เรียนวิชาห้องสมุด และวิธีค้นคว้ามีกลุ่มตัวอย่าง 96 คน  
ทดลองจากการเรียนโฮมเพจรายวิชา ที่ท าการปรับปรุงหลายครั้ง จนมีประสิทธิภาพ และค่าดัชนี
ประสิทธิผลเท่ากับ 81.50/85.33  และ 0.59  ก่อนเรียนให้ท าแบบทดสอบก่อนเรียน เมื่อเรียนจบ
บทเรียนก็ท าแบบทดสอบหลังเรียน พร้อมทั้งตอบแบบสอบถามความพึงพอใจในการเรียนบน
เครือข่าย หลังจากนั้นน าข้อมูลมาวิเคราะห์   โดยใช้โปรแกรมส าเร็จรูป  SPSS for windows 
เพ่ือหาค่าร้อยละ ค่าเฉลี่ย  และค่าเบี่ยงเบนมาตรฐาน และทดสอบความแตกต่างก่อนและหลังเรียน 
โดยใช้สถิติ t-test ผลการวิจัยพบว่า ผลสัมฤทธิ์ทางการเรียนก่อนและหลังการทดลองมีค่าเฉลี่ย
ต่างกันร้อยละ 27.7  อย่างมีนัยส าคัญทางสถิติที่ระดับ 0.01  และความพึงพอใจของการเรียนบน
เครือข่ายอยู่ในระดับมาก 

พงษ์พิพัฒน์ สายทอง (2545 : 140-145) ได้ท าการศึกษาวิจัยเรื่อง การพัฒนาบทเรียนผ่าน
ระบบเครือข่าย  วิชาการวิจัยและทฤษฎีเทคโนโลยีการศึกษา  หลักสูตรการศึกษามหาบัณฑิตสาขา
เท ค โน โล ยี ก า ร ศึ ก ษ า  ก ลุ่ ม ตั ว อ ย่ า งที่ ใช้ ใน ก าร วิ จั ย ได้ จ า ก ก า ร เลื อ ก แ บ บ เจ า ะ จ ง 
คือ นิสิตหลักสูตรการศึกษามหาบัณฑิต สาขาวิชาเทคโนโลยีการศึกษา มหาวิทยาลัยมหาสารคาม 
จ านวน 42 คน แบ่งออกเป็นกลุ่มทดลอง 21 คน  กลุ่มควบคุม 21 คน  ผู้วิจัยได้พัฒนาบทเรียนผ่าน
เครือข่าย เพ่ือน ามาใช้ในการทดลอง เพื่อเปรียบเทียบผลสัมฤทธิ์ทางการเรียน และความคงทนในการ
เรียนรู้ของกลุ่มทดลอง  และกลุ่มควบคุม สถิติที่ใช้ในการวิเคราะห์ข้อมูล คือร้อยละ ค่าเฉลี่ย ส่วน
เบี่ยงเบนมาตรฐาน การทดสอบสมมุติฐานใช้ t-test (Independent Sample)  ผลการวิจัยพบว่า 

(1)  บทเรียนผ่านเครือข่ายที่พัฒนาขึ้น มีประสิทธิภาพ 80.15  มีดัชนีประสิทธิผลเท่ากับ 0.49 
(2)  ผู้เรียนที่เรียนด้วยบทเรียนระบบเครือข่าย มีความคงทนในการเรียนรู้หลังการเรียน 
(3)  ผู้เรียนมีความคิดเห็นในระดับเห็นด้วยมาก 
(4)  ผู้เรียนที่เรียนบทเรียนผ่านเว็บ มีคะแนนเฉลี่ยผลสัมฤทธิ์ทางการเรียนหลัง

เรียนสูงกว่า ผู้เรียนที่เรียนด้วยวิธีการสอนปกติ 
(5)  ผู้เรียนที่เรียนด้วยบทเรียนผ่านเว็บ มีความคงทนในการเรียนสูงกว่าผู้เรียนด้วย

วิธีสอนปกติ 
อัจฉรา ศรีสวัสดิ์ (2554 : 77-78) การสร้างบทเรียนออนไลน์โดยใช้การจัดการเรียนรู้แบบ

ใช้ปัญหาเป็นฐาน เรื่องการใช้งาน Microsoft Excel งานวิจัยครั้งนี้มีจุดประสงค์เพ่ือ 1) สร้างและ
ประเมินคุณภาพบทเรียนออนไลน์ โดยใช้การจัดการเรียนรู้โดยใช้ปัญหาเป็นฐาน 2) หาประสิทธิภาพ
ของบทเรียนออนไลน์โดยใช้การจัดการเรียนรู้โดยใช้ปัญหาเป็นฐาน 3) ศึกษาผลสัมฤทธิ์ทางการเรียน
ของนักเรียนที่ได้จากการใช้บทเรียนออนไลน์โดยใช้การจัดการเรียนรู้โดยใช้ปัญหาเป็นฐาน 4) ศึกษา
ความพึงพอใจของนักเรียนที่มีต่อการเรียนโดยใช้การจัดการเรียนรู้โดยใช้ปัญหาเป็นฐาน 5) ประเมิน
กิจกรรมการเรียนของผู้เรียนโดยใช้ประเมินตามสภาพจริง กลุ่มตัวอย่างคือนักเรียนชั้นประถมศึกษา  
ปีที่ 5 โรงเรียนบ้านหน้าเขาใต้ร่มเย็น 1 ภาคเรียนที่ 2 ปีการศึกษา 2544 จ านวน 30 คน ผลการวิจัย
พบว่า บทเรียนออนไลน์โดยใช้การจัดการเรียนรู้แบบใช้ปัญหาที่สร้างขึ้น ซึ่งผ่านการประเมินโดย
ผู้เชี่ยวชาญ ด้านเนื้อหาจ านวน 3 ท่าน ปรากฏว่ามีค่าเฉลี่ยเท่ากับ 4.25 ส่วนเบี่ยงเบนมาตรฐาน

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆท้ังสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกคร้ังที่มีการนำไปใช้
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เท่ากับ 0.40 อยู่ในระดับดี และด้านสื่อการน าเสนอจ านวน 3 ท่าน มีค่าเฉลี่ยเท่ากับ 4.26 ส่วน
เบี่ยงเบนมาตรฐาน เท่ากับ 0.48 อยู่ในระดับดี ผลการประเมินประสิทธิภาพของบทเรียนออนไลน์ที่
สร้างขึ้น มีประสิทธิภาพ เท่ากับ 78.92/76.33 ซึ่งเป็นไปตามเกณฑ์ที่ก าหนดไว้ตามสมมุติฐานคือ 
75/75 ผลสัมฤทธิ์ทางการเรียนของนักเรียนพบว่า คะแนนการทดสอบหลังเรียนมีคะแนนสูงกว่าก่อน
เรียนอย่างมีนัยส าคัญทางสถิติที่ระดับ .01 

 

2.9.2  งานวิจัยในต่างประเทศ 
Oden, R.E. (1982. 355-A) ได้ศึกษาเปรียบเทียบผลสัมฤทธิ์ทางการเรียนและทัศนคติ 

ต่อวิชาคณิตศาสตร์ของนักเรียนเกรด 9 โดยการเรียนจากคอมพิวเตอร์ช่วยสอนและการเรียนจากการ
สอนแบบบรรยาย ผลการศึกษาปรากฏว่านักเรียนที่เรียนจากคอมพิวเตอร์มีคะแนนสูงกว่านักเรียนที่
เรียนจากการสอนแบบบรรยาย อย่างมีนัยส าคัญทางสถิติทั้งคะแนนที่วัดผลสัมฤทธิ์ทางการเรียนและ
วัดทัศนคต ิ

Wright Pamla A. (1984 : 1063-A)  ได้ศึกษาเปรียบเทียบผลสัมฤทธิ์ทางเรียนซ่อมเสริม 
โดยใช้คอมพิวเตอร์ช่วยสอน กลุ่มตัวอย่างเป็นนักเรียนระดับชั้นมัธยมศึกษาในรัฐแคลิฟอร์เนีย 
โดยแบ่งนักศึกษาออกเป็น 3 กลุ่ม ให้กลุ่มทดลองที่ 1 เรียนซ่อมเสริมจากคอมพิวเตอร์ช่วยสอน 
ในระบบ PLATO กลุ่มทดลองที่ 2 เรียนซ่อมเสริมจากคอมพิวเตอร์ช่วยสอนในระบบ  Apple II 
และกลุ่มควบคุมเรียนซ่อมเสริมจากการสอนปกติ ใช้ เวลาในการทดลอง 6 สัปดาห์ในช่วงภาคฤดูร้อน 
ผลการวิจัยปรากฏว่านักเรียนที่เรียนซ่อมเสริมจากคอมพิวเตอร์ช่วยสอนในกลุ่มทดลองทั้ง 2 กลุ่ม 
มีผลสัมฤทธิ์ทางการเรียนสูงกว่านักเรียนที่เรียนซ่อมเสริมจากการสอนปกติอย่างมีนัยส าคัญทางสถิติ 

Baugh (1996 : 3545) ได้กล่าวถึงประโยชน์ของการใช้อินเทอร์เน็ตในโรงเรียนชนบท 
โดยใช้ผู้สอนอาสาในชนบทจ านวน 10 ท่าน เข้ารับการฝึกอบรมการใช้อินเทอร์เน็ต ก่อนน ากลับไปใช้
ในการเรียนการสอนพบว่า อินเทอร์เน็ตเป็นเครื่องมือที่มีคุณค่าอย่างมากส าหรับห้องเรียนในชนบท 
ความรู้ที่ได้จากการใช้อินเทอร์เน็ตของผู้สอนและนักเรียนรู้ เป็นไปในทางบวกสูงสุด โดย ผู้สอนกล่าว
ว่าอินเทอร์เน็ตได้เปิดโลกให้กับนักเรียน อินเทอร์เน็ตสามารถน ามาใช้ได้แม้ในสภาพแวดล้อม 
ที่ไม่เหมาะสม เช่น ในชนบท ดังนั้นจึงควรให้การสนับสนุนและจัดฝึกอบรมให้อย่างเพียงพอและทั่วถึง 

Lowe Bickel (1993 : 46-47) ได้ท าการทดลองใช้บทเรียนโปรแกรมคอมพิวเตอร์ช่วย
สอนทางด้านการเขียนและไวยากรณ์ โดยท าการทดลองเปรียบเทียบกับนักเรียนในวิทยาลัยชุมชน
แอปปาลาเซีย (Appalachia) ในเวอร์จิเนียตะวันตก 2 กลุ่ม กลุ่มแรก จ านวน 20 คน เรียนด้วย
บทเรียนคอมพิวเตอร์ที่สร้างขึ้น และกลุ่มจ านวน 13 คน เรียนด้วยวิธีการสอนแบบทั่วไปในห้องเรียน 
เป็นระยะเวลา 1 ภาคเรียน ผลจากการศึกษาพบว่า กลุ่มนักเรียนที่เรียนด้วยบทเรียนคอมพิวเตอร์
ช่วยสอน มีผลสัมฤทธิ์ทางการเรียนสูงกว่ากลุ่มที่เรียนแบบทั่วไป และนักเรียนที่เรียนกับคอมพิวเตอร์
ช่วยสอนมีความสนุกสนานมากกว่ากลุ่มที่เรียนแบบธรรมดา 

จากงานวิจัยที่เกี่ยวข้องจะเห็นได้ว่าผลสัมฤทธิ์ทางการเรียนของผู้เรียนที่เรียนผ่านสื่อ 
การเรียนการสอนบนเครือข่ายอินเทอร์เน็ต จะมีผลสัมฤทธิ์ทางการเรียนที่สูงกว่าการเรียนปกติ 
เพราะเป็นสื่อที่มีความน่าสนใจและผู้เรียนสามารถทบทวนได้ตลอด นอกจากนั้นยังมีเครื่องมือต่าง ๆ 
จะช่วยอ านวยความสะดวกในการติดต่อสื่อสารกับ ผู้สอนได้ ดังนั้นผู้วิจัยจึงมีความสนใจที่จะพัฒนา
บทเรียนผ่านเครือข่ายอินเทอร์เน็ตขึ้นมาเพ่ือเป็ นเครื่องมือที่ จะช่วยให้การเรียนการสอน 
มีประสิทธิภาพมากยิ่งข้ึน 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆท้ังสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกคร้ังที่มีการนำไปใช้
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บทท่ี 3 

วิธีการด าเนินการวจิัย 
 

การพัฒนาบทเรียนผ่านเครือข่ายอินเทอร์เน็ต เรื่อง โปรแกรมคอมพิวเตอร์กราฟิกเบื้องต้น 
ของนักเรียนชั้นมัธยมศึกษาปีที่ 1 ผู้วิจัยได้ด าเนินการวิจัยโดยมีขั้นตอนดังนี้ 

3.1  ประชากรและกลุ่มตัวอย่าง 
3.2  เครื่องมือที่ใช้ในการวิจัย 
3.3  การด าเนินการทดลองและเก็บรวบรวมข้อมูล 
3.4  การวิเคราะห์ข้อมูล 

 
3.1  ประชากรและกลุ่มตัวอย่าง 
 

3.1.1  ประชากร 
ประชากรที่ใช้ในการวิจัยครั้งนี้ เป็นนักเรียนชั้นมัธยมศึกษาศึกษาปีที่ 1 ภาคเรียนที่ 2 

ปีการศึกษา 2561 โรงเรียนอนุบาลเมืองนครสวรรค์ (เขากบ วิวรณ์สุขวิทยา) สังกัดส านักงานเขตพ้ืนที่
การศึกษาประถมศึกษานครสวรรค์ เขต 1 จ านวน 160 คน 
 

3.1.2  กลุ่มตัวอย่าง  
กลุ่มตัวอย่างที่น ามาศึกษาในการวิจัยครั้งนี้ ได้แก่ นักเรียนระดับชั้นมัธยมศึกษาปีที่ 1 

ภาคเรียนที่  2 ปีการศึกษา 2561 โรงเรียนอนุบาลเมืองนครสวรรค์ (เขากบ วิวรณ์สุขวิทยา) 
สังกัดส านักงานเขตพ้ืนที่การศึกษาประถมศึกษานครสวรรค์ เขต 1 จ านวน 1 ห้อง จ านวน 40 คน 
โดยได้มาจากการสุ่มตัวอย่างแบบแบ่งกลุ่ม (Cluster Random Sampling) จากประชากรเพ่ือหา
ประสิทธิภาพของบทเรียนและเปรียบเทียบผลสัมฤทธิ์ทางการเรียน 
 
3.2  เครื่องมือที่ใช้ในการวิจัย 
 

เครื่องมือที่ใช้ในการวิจัยครั้งนี้ประกอบด้วย 
3.2.1  บทเรียนผ่านเครือข่ายอินเทอร์เน็ต เรื่อง โปรแกรมคอมพิวเตอร์กราฟิกเบื้องต้น 

ของนักเรียนชั้นมัธยมศึกษาปีที่ 1 
 

3.2.2  แบบประเมินคุณภาพของบทเรียนผ่านเครือข่ายอินเทอร์เน็ต เรื่อง โปรแกรม
คอมพิวเตอร์กราฟิกเบื้องต้น ของนักเรียนชั้นมัธยมศึกษาปีที่ 1 
 

3.2.3  แบบทดสอบวัดผลสัมฤทธิ์ทางการเรียนด้วยบทเรียนผ่านเครือข่ายอินเทอร์เน็ต 
เรื่องโปรแกรมคอมพิวเตอร์กราฟิกเบื้องต้น ของนักเรียนชั้นมัธยมศึกษาปีที่ 1 
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การสร้างเครื่องมือที่ใช้ในการวิจัยมีดังต่อไปนี้ 

 

3.2.1  การสร้างบทเรียนผ่านเครือข่ายอินเทอร์เน็ต 
ในการพัฒนาบทเรียนผ่านเครือข่ายอินเทอร์เน็ตเรื่องโปรแกรมคอมพิวเตอร์กราฟิก

เบื้องต้นของนักเรียนชั้นมัธยมศึกษาปีที่  1 ผู้วิจัยได้พัฒนาบทเรียนบนเครือข่ายอินเทอร์เน็ต  
โดยใช้รูปแบบ ADDIE มาปรับปรุงขั้นตอนในการพัฒนาบทเรียนคอมพิวเตอร์ทั้งหมด มนต์ชัย เทียนทอง. 
(2548 : 131) ซึ่งประกอบด้วย 5 ขั้นตอนดังนี้ 

3.2.1.1  ขั้นตอนที่ 1 การวิเคราะห์ (Analysis) 
(1)  ศึกษาทฤษฎี และหลักการสร้างบทเรียนผ่านเครือข่ายอินเทอร์เน็ต 

เรื่อง โปรแกรมคอมพิวเตอร์กราฟิกเบื้องต้น ของนักเรียนชั้นมัธยมศึกษาปีที่ 1 โรงเรียนอนุบาลเมือง
นครสวรรค์(เขากบ วิวรณ์สุขวิทยา) 

(2)  ศึกษาหลักสูตร วิเคราะห์เนื้อหาก าหนดขอบข่าย เรื่อง โปรแกรม
คอมพิวเตอร์กราฟิกเบื้องต้น ชั้นมัธยมศึกษาปีที่ 1 เพ่ือน ามาสร้างบทเรียนผ่านเครือข่ายอินเทอร์เน็ต 

(3)  วิเคราะห์ผลการเรียนรู้ที่คาดหวังก าหนดผลการเรียนรู้ที่คาดหวังใน
การจัดการเรียนรู้เรื่อง โปรแกรมคอมพิวเตอร์กราฟิกเบื้องต้น  ในรายวิชาเทคโนโลยีสารสนเทศ 

(4)  วิ เคราะห์กระบวนการจัดการเรียนรู้   โดยใช้สื่อบทเรียนผ่าน
เครือข่ายอินเทอร์เน็ต โดยให้ผู้สอนเป็นผู้ก ากับและแนะน าผู้เรียนให้สามารถท ากิจกรรมการเรียนการ
สอนตามกระบวนการเรียนรู้ 

(5)  วิเคราะห์กระบวนการประเมินผล ใช้แบบทดสอบในการวัดและ
ประเมินผลด้านความรู้ 

(6)  วิเคราะห์แหล่งการเรียนรู้  สื่อการเรียนรู้  และแหล่งการเรียนรู้ที่ใช้
ได้แก่ บทเรียนผ่านเครือข่ายอินเทอร์เน็ต โปรแกรมคอมพิวเตอร์กราฟิกเบื้องต้น  
 

3.2.1.2  ขั้นตอนที่ 2 การออกแบบ (Design) 
(1)  ก าหนดวัตถุประสงค์การเรียนรู้ ของบทเรียนผ่ านเครือข่ าย

อินเทอร์เน็ต เรื่อง โปรแกรมคอมพิวเตอร์กราฟิกเบื้องต้น ของนักเรียนชั้นมัธยมศึกษาปีที่ 1 โรงเรียน
อนุบาลเมืองนครสวรรค์ (เขากบ วิวรณ์สุขวิทยา)  ให้มีความสอดคล้องกับเนื้อหา ดังนี้ 

(1.1)  ความหมายของกราฟิก 
(1.2)  โปรแกรมกราฟิกประเภทต่าง ๆ 
 (1.3)  วิธีการใช้งานโปรแกรมกราฟิก 
 (1.4)  วิธีการสร้างชิ้นงานกราฟิกด้วยโปรแกรมกราฟิก 
 (1.5)  การน างานกราฟิกไปใช้ร่วมกับโปรแกรมอ่ืน ๆ 
 (2)  ออกแบบบทเรียนผ่านเครือข่ายอินเทอร์เน็ต โดยการออกแบบผัง
งาน (Flow Chart) และสร้างจากแบบร่าง (Story Board) ของบทเรียนซึ่งได้มีการจัดล าดับเนื้อหาที่
วิเคราะห์ออกมาเป็นหน่วยย่อย โดยค านึงถึงการจัดกิจกรรมระหว่างบทเรียนและแบบทดสอบระหว่าง
เรียนมีภาพประกอบพอสมควร และมีเสียงเพ่ือเร้าความสนใจของผู้เรียนเป็นช่วง ๆ ตามวัตถุประสงค์ 
และรูปแบบการน าเสนอบทเรียนผ่านเครือข่ายอินเทอร์เน็ต และออกแบบหน้าจอ มีการทบทวน
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เนื้อหาก่อนเข้าบทเรียน และการทดสอบย่อย มีแบบทดสอบหลังเรียนให้ผู้เรียนได้ท าหลังจากเรียนจบ
บทเรียนทั้งหมดทุกหน่วย 

 (3 )   สร้างบทเรียนผ่ าน เครือข่ ายอิน เทอร์ เน็ ต  เรื่อง โปรแกรม
คอมพิวเตอร์กราฟิกเบื้องต้น ของนักเรียนชั้นมัธยมศึกษาปีที่ 1 

 3.2.1.3  ขั้นตอนที่ 3 การพัฒนา (Development) 
 (1)  น าบทเรียนผ่านเครือข่ายอินเทอร์เน็ต เสนอต่ออาจารย์ที่ปรึกษา
วิทยานิพนธ์และอาจารย์ที่ปรึกษาวิทยานิพนธ์ร่วม เพ่ือตรวจสอบความถูกต้องและความเหมาะสม
ของบทเรียนเพ่ือหาข้อบกพร่องของบทเรียนและองค์ประกอบต่าง ๆ เพ่ือให้ผู้วิจัยได้น ามาปรับปรุง 
และแก้ไขให้สมบูรณ์ 
 (2)  น าบทเรียนผ่านเครือข่ายอินเทอร์เน็ต ที่สร้างเสร็จเสนอต่ออาจารย์
ที่ปรึกษาวิทยานิพนธ์ และอาจารย์ที่ปรึกษาวิทยานิพนธ์ร่วม เพ่ือตรวจสอบอีกครั้งพร้อมปรับปรุง
แก้ไข ก่อนส่งให้ผู้ทรงคุณวุฒิท าการประเมินคุณภาพทางด้านเนื้อหา และทางด้าน เทคโนโลยี
มัลติมีเดีย 
 3.2.1.4  ขั้นตอนที่ 4 การน าไปใช้ (Implementation) 
 (1)  น าบทเรียนผ่านเครือข่ายอินเทอร์เน็ต ที่ได้ปรับปรุงแล้วไปทดสอบ
กับกลุ่มตัวอย่าง แบบ 1 ต่อ 1 โดยใช้กับนักเรียน จ านวน 3 คน ที่ไม่ใช่กลุ่มตัวอย่าง และยังไม่เคย
ผ่านการเรียนในวิชานี้  ซึ่งเรียนในกลุ่มเก่ง ปานกลาง และอ่อน กลุ่มละ 1 คน โดยการสังเกต
พฤติกรรม สัมภาษณ์ และบันทึกสิ่งที่ควรแก้ไข เพ่ือน ามาท าการปรับปรุงแก้ไขบทเรียนผ่านเครือข่าย
อินเทอร์เน็ต 
 (2)  หลังจากท าการทดลองแล้วน าบทเรียนผ่านเครือข่ายอินเทอร์เน็ต 
ที่ปรับปรุงแล้วไปทดลองใช้กับนักเรียนจ านวน 6 คน ที่ไม่ใช่กลุ่มตัวอย่างและยังไม่เคยผ่านการเรียน
ในวิชานี้โดยการสังเกตพฤติกรรม สัมภาษณ์ และบันทึกสิ่งที่ควรแก้ไข เพื่อน ามาท าการปรับปรุงแก้ไข
บทเรียนผ่านเครือข่ายอินเทอร์เน็ต 
 3.2.1.4  ขั้นตอนที่ 5 การประเมินผล (Evaluation) 
 (1)  น าบทเรียนผ่านเครือข่ายอินเทอร์เน็ต เรื่อง โปรแกรมคอมพิวเตอร์
กราฟิกเบื้องต้นที่ปรับปรุงแล้ว ใช้กับนักเรียนที่เป็นกลุ่มตัวอย่าง  
 (2)  เมื่อทดลองสอนจนครบทุกหน่วยการเรียนรู้ ให้ผู้เรียนท าแบบทด
สอลหลังเรียน และน าข้อมูลคะแนนจากการสอบไปวิเคราะห์ต่อไป  
 (3 )  เมื่ อสิ้ นสุดการทดลอง ผู้ วิจัยน าผลคะแนนที่ ได้จากการท า
แบบทดสอบท้ายหน่วยการเรียน และแบบทดสอบหลังเรียนของแต่ละหน่วยการเรียน มาวิเคราะห์หา
ประสิทธิภาพของบทเรียน โดยใช้สูตร E1/E2 (ชัยยงค์ พหมวงศ์. 2542 : 136) 
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ขั้นตอนการพัฒนาบทเรียนผ่านเครือข่ายอินเทอร์เน็ต 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

ภาพที่  3.1  การพัฒนาบทเรียนผ่านเครือข่ายอินเทอร์เน็ต 

ได้บทเรียนผ่านเครือข่ายอินเทอร์เน็ตที่มีประสิทธิภาพ 
 

ผ่าน 

ผ่าน 

เริ่มต้น 

ศึกษาทฤษฎีและหลักการสร้างบทเรียนผ่านเครือข่ายอินเทอร์เน็ต  
และโปรแกรมคอมพิวเตอร์กราฟิกเบื้องต้น 

ศึกษาหลักสูตรเนื้อหาบทเรียน 

วิเคราะห์เนื้อหาและก าหนดจุดประสงค์การเรียนรู ้

ออกแบบหน้าจอและร่างบทเรียนผ่านเครือข่ายอินเทอร์เน็ต 

สร้างบทเรียนบนเครือข่ายอินเทอร์เน็ต 

เสนออาจารย์ที่ปรึกษาวิทยานิพนธ์และอาจารย์ที่ปรึกษาวิทยานิพนธ์ร่วม 

ตรวจสอบ ปรับปรุงแก้ไข ไม่ผ่าน 

เสนอผู้ทรงคุณวุฒิเพ่ือท าการประเมินคุณภาพ 

ประเมินคุณภาพ ปรับปรุงแก้ไข ไม่ผ่าน 

น าบทเรียนไปทดลองใช้กับนักเรียน 3 คนและปรับปรุงแก้ไข 

น าบทเรียนไปทดลองใช้กับนักเรียน 6 คนและปรับปรุงแก้ไข 

น าบทเรียนไปทดลองใช้กับนักเรียน 40 คนและปรับปรุงแก้ไข 

หาประสิทธิภาพของบทเรียนผ่านเครือข่ายอินเทอร์เน็ต 

จบ 
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3.2.2  การสร้างแบบประเมินคุณภาพ บทเรียนผ่านเครือข่ายอินเทอร์เน็ต เรื่อง 
โปรแกรมคอมพิวเตอร์กราฟิกเบื้องต้น มีขั้นตอนดังนี้ 
 3.2.2.1  ก าหนดหัวข้อทางด้านเนื้อหาและเทคนิคการออกแบบ และเทคโนโลยี
มัลติมีเดีย ในการประเมินตามกรอบแนวคิดของการวิจัย 
 3.2.2.2  ก าหนดระดับความคิดเห็น เป็นมาตรฐานประมาณค่าคุณภาพของ
บทเรียนผ่านเครือข่ายอินเทอร์เน็ต โดยใช้กระบวนการสอนแบบร่วมมือ มี 5 ระดับ คือ  
 5  หมายถึง  คุณภาพอยู่ในระดับ  ดีมาก 
 4  หมายถึง  คุณภาพอยู่ในระดับ  ดี 
 3  หมายถึง  คุณภาพอยู่ในระดับ  ปานกลาง 
 2  หมายถึง  คุณภาพอยู่ในระดับ  พอใช้ 
 1  หมายถึง  คุณภาพอยู่ในระดับ  ควรปรับปรุง 
 3.2.2.3  น าแบบประเมินผลประสิทธิภาพที่ได้ เสนออาจารย์ที่ปรึกษาวิทยานิพนธ์
และอาจารย์ที่ปรึกษาวิทยานิพนธ์ร่วม ท าการตรวจสอบเพื่อน าไปปรับปรุงแก้ไขในขั้นตอนต่อไป 
 3.2.2.4  น าแบบประเมินผลประสิทธิภาพของบทเรียนผ่านเครือข่ายอินเทอร์เน็ต 
ที่ได้ท าการปรับปรุงแก้ไขแล้ว ให้ผู้ทรงคุณวุฒิทางด้านเนื้อหาและเทคนิคการออกแบบ และ 
ด้านเทคโนโลยีมัลติมีเดียท าการประเมินต่อไป โดยผู้ทรงคุณวุฒิจะประเมินตามช่องระดับความคิดเห็น 
ที่มีท้ังหมด 5 ระดับ 
 3.2.2.5  น าแบบประเมินคุณภาพบทเรียนผ่านเครือข่ายอินเทอร์เน็ต มาท าการ
วิเคราะห์หาค่าเฉลี่ย (x̅) และส่วนเบี่ยงเบนมาตรฐาน (S) โดยมีเกณฑ์ความหมายของค่าเฉลี่ย ดังแสดง 
ในตารางที่ 3.1  
 
ตารางท่ี 3.1  แสดงระดับเกณฑ์การตีความหมายของการแสดงความคิดเห็น 

เกณฑ์ค่าเฉลี่ย (x̅) ระดับคุณภาพ 

4.50 – 5.00 ดีมาก 

3.50 – 4.49 ดี 

2.50 – 3.49 ปานกลาง 

1.50 – 2.49 พอใช้ 

1.00 – 1.49 ควรปรับปรุง 
 
             การประเมินในแต่ละด้านของเนื้อหา และทางเทคโนโลยีมัลติมีเดีย คะแนนเฉลี่ยที่ได้
จะต้องมีค่าตั้งแต่ 3.5 ขึ้นไป จึงจะถือว่าผ่านเกณฑ์การประเมินจากผู้ทรงคุณวุฒิ 
 
 
 
 
 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 
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ผ่าน 

เริ่มต้น 

ก าหนดหัวข้อและเสนอแบบประเมินคุณภาพด้านเนื้อหาและด้านเทคโนโลยีมัลติมีเดีย 

สร้างแบบประเมินคุณภาพด้านเนื้อหาและด้านเทคโนโลยีมัลติมีเดีย 

เสนออาจารย์ที่ปรึกษาวิทยานิพนธ์และอาจารย์ที่ปรึกษาวิทยานิพนธ์ร่วม 

ตรวจสอบ ปรับปรุงแก้ไข ไม่ผ่าน 

น าแบบประเมินคุณภาพที่สร้างขึ้น เสนอผู้ทรงคุณวุฒิท าการประเมิน 

น าข้อมูลมาวิเคราะห์หาค่าเฉลี่ย, ส่วนเบี่ยงเบนมาตรฐาน 

จบ 

ขั้นตอนการสร้างแบบประเมินคุณภาพบทเรียนผ่านเครือข่ายอินเทอร์เน็ต 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

ภาพที ่ 3.2  การสร้างแบบประเมินคุณภาพบทเรียนผ่านเครือข่ายอินเทอร์เน็ต 
 

3.2.3  การสร้างแบบทดสอบวัดผลสัมฤทธิ์ทางการเรียน 
 การสร้างแบบทดสอบวัดผลสัมฤทธิ์ทางการเรียน เรื่อง โปรแกรมคอมพิวเตอร์กราฟิก
เบื้องต้น ของนักเรียนชั้นมัธยมศึกษาปีที่ 1 จะท าการด าเนินดังนี้ 
 3.2.3.1  ศึกษาหลักสูตรสถานศึกษา โครงสร้าง เกณฑ์การวัดผลและประเมินผล 
รายวิชาเทคโนโลยีสารสนเทศ 
 3.2.3.2  ศึกษาวัตถุประสงค์เชิงพฤติกรรม และการสร้างแบบทดสอบ และวัด
ผลสัมฤทธิ์ทางการเรียน 
 3.2.3.3  วิเคราะห์เนื้อหา และจุดประสงค์การเรียนรู้ วิชาคอมพิวเตอร์ เรื่อง
โปรแกรมคอมพิวเตอร์กราฟิกเบื้องต้น ของนักเรียนชั้นมัธยมศึกษาปีที่ 1 
 3.2.3.4  สร้างแบบทดสอบวัดผลสัมฤทธิ์ทางการเรียนแบบปรนัย 4 ตัวเลือก 
จ านวน 40 ข้อ โดยค านึงถึงเนื้อหารายวิชา มีเกณฑ์การให้คะแนน คือ ตอบถูกได้ 1 คะแนน ตอบผิด
ได้ 0 คะแนน ถ้าไม่ตอบหรือมากกว่า 1 ตัวเลือกในข้อเดียวกันได้ 0 คะแนน 
 3.2.3.5  หาค่าความเที่ยงตรงเชิงเนื้อหา (Content validity) ของแบบทดสอบ
วัดผลสัมฤทธิ์ ทางการเรียน และเสนอต่ออาจารย์ที่ปรึกษาเสนออาจารย์ที่ปรึกษาวิทยานิพนธ์และ
อาจารย์ที่ปรึกษาวิทยานิพนธ์ร่วม 

ได้แบบประเมินคุณภาพบทเรียนผ่านเครือข่ายอินเทอร์เน็ต 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 
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             สูตรการหาค่าดัชนีความสอดคล้องระหว่างข้อสอบ กับจุดประสงค์การเรียนรู้  (พรรณี 
ลีกิจวัฒนะ. 2555 : 195)  
 

IOC =
ƩR

n
 

 
 

เมื่อ      IOC แทน ดัชนีความสอดคล้อง 
   R   แทน ค่าคะแนนรายข้อตามดุลยพินิจของผู้ทรงคุณวุฒิ 
    Ʃ   แทน ผลรวม 
   n  แทน จ านวนผู้ทรงคุณวุฒิ  
 

เกณฑ์การให้คะแนนมีดังนี้  
 +1  คะแนน ส าหรับข้อสอบนั้นสอดคล้องกับจุดประสงค์การเรียนรู้ 

    0  คะแนน ส าหรับขอสอบที่ไม่แน่ใจว่าสอดคล้องกับจุดประสงค์การเรียนรู้ 
      -1  คะแนน ส าหรับข้อสอบนั้นไม่สอดคล้องกับจุดประสงค์การเรียนรู้ 
 

 คัดเลือกแบบทดสอบที่มีค่าดัชนีความสอดคล้องตั้งแต่ 0.5 ขึ้นไป น าไปใช้เป็นแบบทดสอบ
วัดผลสัมฤทธิ์ทางการเรียน 
 
 จากการวิเคราะห์ ค่าดัชนีความสอดคล้อง (IOC) มีความตรงเชิงเนื้อหาของแบบทดสอบ
วัดผลสัมฤทธิ์ที่สร้างขึ้น พบว่ามีค่าดัชนีความสอดคล้อง ( IOC) มีความตรงเชิงเนื้อหาอยู่ระหว่างการ
คัดเลือก 0.38 – 0.76  
 3.2.3.6  น าแบบทดสอบผลสัมฤทธิ์ทางการเรียนมาปรับปรุงแก้ไขข้อบกพร่องแล้ว 
น าเสนอต่ออาจารย์ที่ปรึกษาวิทยานิพนธ์และอาจารย์ที่ปรึกษาวิทยานิพนธ์ร่วม ตรวจสอบอีกครั้ง 
 3.2.3.7  น าแบบทดสอบผลสัมฤทธิ์ทางการเรียนที่ผ่านตามเกณฑ์การตรวจสอบ
ความเที่ยงตรงเชิงเนื้อหา ไปทดลองใช้กับนักเรียนชั้นมัธยมศึกษาปีที่ 1 ที่ไม่ใช่กลุ่มตัวอย่าง  
 3.2.3.8  น าคะแนนที่ได้มาวิเคราะห์หาค่าความยากง่าย (p) และค่าอ านาจจ าแนก (r)  
สูตรการหาค่าความยากง่าย (p) ของข้อสอบ (พรรณี ลีกิจวัฒนะ. 2555 : 207)   

 

p =  
RH + RL

2n
 

 
 เมื่อ      p แทน  ค่าความยากง่าย 
  RH แทน  จ านวนผู้ตอบถูกของข้อนั้นในกลุ่มสูง 
  RL แทน  จ านวนผู้ตอบถูกของข้อนั้นในกลุ่มต่ า 
  n แทน  จ านวนผู้ตอบในแต่ละกลุ่ม (ซึ่งมีจ านวนเท่ากัน)  

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 
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ตารางท่ี  3.2  เกณฑ์ในการพิจารณาเลือกแบบทดสอบส าหรับค่าความยากง่าย (p) 

เกณฑ์ ความหมาย 

0.80 – 1.00 แบบทดสอบที่ง่ายมาก 

0.60 – 0.79 แบบทดสอบที่ง่าย 

0.40 – 0.59 แบบทดสอบที่ปานกลาง 

0.20 – 0.39 แบบทดสอบที่ยาก 

0.00 – 0.19 แบบทดสอบที่ยากมาก 
 

สูตรการหาค่าอ านาจจ าแนก(r) (พรรณี ลีกิจวัฒนะ. 2555 : 209-210)   
 

r =  
RH − RL

n
 

 
เมื่อ      r แทน  ค่าอ านาจจ าแนก 
  RH แทน  จ านวนผู้ตอบถูกของข้อนั้นในกลุ่มสูง 

  RL แทน  จ านวนผู้ตอบถูกของข้อนั้นในกลุ่มต่ า 
  n แทน  จ านวนผู้ตอบในแต่ละกลุ่ม (ซึ่งมีจ านวนเท่ากัน) 
 

ตารางท่ี  3.3  เกณฑ์ในการพิจารณาเลือกแบบทดสอบส าหรับค่าอ านาจจ าแนก (r) 
ค่า r ตีความหมาย ผลการพิจารณา 

0.40 – 1.00 อ านาจจ าแนกสูง เป็นข้อสอบที่มีคุณภาพดีมาก 

0.30 – 0.39 อ านาจจ าแนกปานกลาง เป็นข้อสอบที่มีคุณภาพดีพอสมควร 

0.20 – 0.29 อ านาจจ าแนกค่อนข้างต่ า เป็นข้อสอบที่มีคุณภาพพอใช้ 

0.00 – 0.19 อ านาจจ าแนกต่ า เป็นข้อสอบที่ใช้ไม่ได้ 
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 3.2.3.9  หาค่าความเชื่อถือได้ของแบบทดสอบทั้งฉบับที่ได้คัดเลือกไว้  โดยใช้สูตร 
KR-20 ของ Kuder Richardson (พรรณี ลีกิจวัฒนะ. 2555 : 202)   

 

rtt =  
k

(k − 1)
{1 −

∑ pq

S2
} 

 
 เมื่อ     rtt แทน  ค่าความเชื่อถือได้ 
  k แทน  จ านวนข้อของเครื่องมือวัด 
  Ʃ แทน  ผลรวม 
  p แทน  สัดส่วนของผู้ตอบถูกในแต่ละข้อ 
  q แทน  สัดส่วนของผู้ตอบผิดในแต่ละข้อ 
  S2 แทน  ความแปรปรวนของคะแนนทั้งฉบับ 
 

ผลการวิเคราะห์หาคุณภาพของแบบทดสอบวัดผลสัมฤทธิ์ทางการเรียน ในงานวิจัย
นี้พบว่า มีค่าความยากง่าย (p) ระหว่าง 0.38-0.76 มีค่าอ านาจจ าแนก (r) ระหว่าง 0.29-0.76 
และมีค่าความเชื่อถือได้ (rtt) เท่ากับ 0.87 ซึ่งเป็นแบบทดสอบที่ออกตามวัตถุประสงค์เชิงพฤติกรรม 
 3.2.3.10  น าแบบทดสอบไปวัดผลสัมฤทธิ์ทางการเรียนด้วยบทเรียนผ่านเครือข่าย
อินเทอร์เน็ต ใช้จริงกับกลุ่มตัวอย่าง 
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ขั้นตอนการสร้างแบบทดสอบวัดผลสัมฤทธิ์ทางการเรียน 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

ภาพที ่ 3.3  ผังงานขั้นตอนการสร้างแบบทดสอบวัดผลสัมฤทธิ์ทางการเรียน 
 

ผ่าน 

ผ่าน 

เริ่มต้น 

ศึกษาเนื้อหาและหลักสูตร 

วิเคราะห์เนื้อหาและจุดประสงค์การเรียนรู้ 

สร้างแบบทดสอบวัดผลสัมฤทธิ์ทางการเรียน 

เสนออาจารย์ที่ปรึกษาวิทยานิพนธ์และอาจารย์ที่ปรึกษาวิทยานิพนธ์ร่วม 

ตรวจสอบ ปรับปรุงแก้ไข ไม่ผ่าน 

เสนอแบบทดสอบให้ผู้ทรงคุณวุฒิด้านเนื้อหาพิจารณา 
เพ่ือหาค่าความเที่ยงตรงด้านเนื้อหา 

ตัดทิ้งหรือ
ปรับปรุงแก้ไข 

ไม่ผ่าน 

ทดลองใช้กับนักเรียนที่เคยเรียนเนื้อหามาแล้วจ านวน 40 คน 

หาค่าความยากง่าย(p) และค่าอ านาจจ าแนก(r)  
คัดเลือกแบบทดสอบที่เหมาะสม เพ่ือวัดผลสัมฤทธิ์ทางการเรียน 

น าแบบทดสอบหาค่าความเชื่อมั่น (rtt) วิธี KR-20 

ได้แบบวัดผลสัมฤทธิ์ทางการเรียน 

จบ 

คัดเลือกข้อสอบที่มีค่า 
IOC ≥ 0.5 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 
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3.3  การด าเนินการทดลองและเก็บรวบรวมข้อมูล 
 

3.3.1  แบบแผนการทดลอง 
การวิจัยในครั้งนี้  เป็นการวิจัยเพ่ือพัฒนาบทเรียนผ่านเครือข่ายอินเทอร์เน็ต เรื่อง 

โปรแกรมคอมพิวเตอร์กราฟิกเบื้องต้น ของนักเรียนชั้นมัธยมศึกษาปีที่ 1 โดยใช้แบบการวิจัยแบบ
ก ลุ่ ม เดี ย ว มี ก า รวั ด ก่ อ น  แ ล ะห ลั ง ให้ สิ่ งท ด ล อ ง  (one group pretest-posttest design) 
(พรรณี ลีกิจวัฒนะ. 2555 : 289) ซึ่งมีรูปแบบดังนี ้
 
ตารางท่ี  3.5  แบบแผนการทดลอง 

กลุ่ม วัดก่อน สิ่งทดลอง วัดหลัง 

E T1 X T2 
 

ความหมายของสัญลักษณ์ท่ีใช้ในแบบแผนการทดลอง 
E แทน กลุ่มทดลอง 
T1 แทน การวัดก่อนเรียน  (pretest) 
X แทน การให้สิ่งทดลอง  (บทเรียนผ่านเครือข่ายอินเทอร์เน็ต)  
T2 แทน การวัดหลังเรียน  (posttest) 
 

ผู้วิจัยได้ด าเนินการทดลองใช้บทเรียนผ่านเครือข่ายอินเทอร์เน็ต และเก็บรวบรวมข้อมูล 
มีรายละเอียดดังนี้ 
 1. จัดเตรียมห้องเรียน 1 ห้องเรียน ซึ่งมีคอมพิวเตอร์ที่สามารถใช้งานอินเทอร์เน็ตได้ 
จ านวน 40 เครื่อง 
 2. ตรวจสอบความพร้อมของห้องเรียนที่ใช้ในการทดลอง รวมทั้งเครื่องมือที่ใช้ใน
การทดลอง 
 3. จัดเตรียมกลุ่มทดลอง ซึ่งเป็นนักเรียนในระดับชั้นมัธยมศึกษาปีที่ 1 จ านวน 40 
คน และเป็นนักเรียนที่ไม่เคยเรียนเนื้อหาวิชาเทคโนโลยีสารสนเทศ เรื่อง โปรแกรมคอมพิวเตอร์
กราฟิกเบื้องต้น  
 4. ด าเนินการทดลอง โดยให้นักเรียนเข้าใช้บทเรียนผ่านเครือข่ายอินเทอร์เน็ต ให้
นักเรียนท าแบบทดสอบก่อนเรียนเป็นรายบุคคลบันทึกผลคะแนนที่ได้จากการท าแบบทดสอบไว้ เพ่ือ
น ามาวิเคราะห์ข้อมูล 
 5. นักเรียนเรียนเนื้อหาในบทเรียนผ่านเครือข่ายอินเทอร์เน็ต เมื่อศึกษาจบแต่ละ
หน่วยการเรียน นักเรียนท าแบบฝึกหัดท้ายหน่วยการเรียน 
 6. เมื่อนักเรียนศึกษาเนื้อหาครบทุกหน่วยการเรียน นักเรียนท าแบบทดสอบวัดผล
สัมฤทธิ์ทางการเรียน 
 7. เมื่อสิ้นสุดการทดลอง ผู้วิจัยน าผลคะแนนที่ได้จากการท าแบบทดสอบก่อนเรียน 
แบบฝึกหัดท้ายหน่วยการเรียน และแบบทดสอบวัดผลสัมฤทธิ์ทางการเรียนมาวิเคราะห์ข้อมูล 
 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 
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3.4  การวิเคราะห์ข้อมูล 
 

การวิจัยเพ่ือพัฒนาบทเรียนผ่านเครือข่ายอินเทอร์เน็ต ผู้วิจัยมีการวิเคราะห์ข้อมูล โดยใช้
สถิติต่าง ๆ ดังนี้ 

 

3.4.1  การหาคุณภาพของบทเรียนผ่านเครือข่ายอินเทอร์เน็ต ด้วยการหาค่าเฉลี่ย (X) และ 
ค่าส่วนเบี่ยงเบนมาตรฐาน  

การค านวณหาค่าเฉลี่ย (X) (พรรณี ลีกิจวัฒนะ. 2555 : 245) ใช้สูตร 
  

                         X =
∑ x

n
 

 
 เมื่อ     X แทน  ค่าเฉลี่ย 
  ∑ x แทน  ผลรวมของคะแนนในชุดข้อมูล 
  n แทน  จ านวนข้อมูลทั้งหมด 

 
การค านวณหาส่วนเบี่ยงเบนมาตรฐาน  (พรรณี ลีกิจวัฒนะ. 2555 : 248) ใช้สูตร 

  

                         S = √
∑(x−x)2

(n−1)
 

 
 เมื่อ     S แทน  ส่วนเบี่ยงเบนมาตรฐาน 
  Ʃ แทน  ผลรวม 
  x แทน  คะแนนแต่ละตัวในชุดข้อมูล 
  x แทน  ค่าเฉลี่ยคะแนนทั้งหมด 
  n แทน  จ านวนข้อมูลทั้งหมด 
 

            3.4.2  การวิเคราะห์หาค่าประสิทธิภาพของบทเรียนผ่านเครือข่ายเพ่ือทบทวน โดยใช้สูตร  
E1: E2  ซ่ึง E1 เป็นประสิทธิภาพของกระบวนการ และ E2 เป็นประสิทธิภาพของผลลัพธ์ 

ประสิทธิภาพของกระบวนการ  (E1) 
 

         1001 




 X

E                         

เมื่อ    E1   แทน  ประสิทธิภาพของกระบวนการ 
 ∑ x  แทน  คะแนนรวมของผู้เรียนที่ได้จากการท าแบบทดสอบระหว่างเรียน 
 A  แทน  คะแนนเต็มของแบบทดสอบระหว่างเรียนทุกหน่วยรวมกัน 
 N  แทน  จ านวนนักเรียนทั้งหมด 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 
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ประสิทธิภาพของผลลัพธ์  (E2) 
 

                1002 




 F

E  

 
เมื่อ    E2   แทน  ประสิทธิภาพของผลลัพธ์ 
 ∑ F  แทน  คะแนนรวมของนักเรียนที่ได้จากการท าแบบทดสอบหลังเรียน 
 B  แทน  คะแนนเต็มของแบบทดสอบระหว่างเรียนทุกหน่วยรวมกัน 
 N  แทน  จ านวนนักเรียนทั้งหมด 
 

3.4.3  การเปรียบเทียบผลสัมฤทธิ์ทางการเรียน ก่อนเรียนกับหลังเรียน เพ่ือหาค่าสถิติ 
t-test dependent samples  (พรรณี ลีกิจวัฒนะ. 2555 : 274) ใช้สูตร 
  

                         t =
∑ D

√n ∑ D2 − (∑ D)2   

n−1

 

 
เมื่อ    t  แทน  ค่าสถิติที่จะใช้เปรียบเทียบกับค่าวิกฤติ เพ่ือทราบความมีนัยส าคัญ 
 ∑ D  แทน  ผลรวมของผลต่างระหว่างคะแนนที่ได้จากการสอบวัดผลสัมฤทธิ์

ทางการเรียนก่อนเรียนกับหลังเรียน 
 ∑ D2  แทน  ผลรวมของผลต่างระหว่างคะแนนที่ได้จากการสอบวัดผลสัมฤทธิ์

ทางการเรียนก่อนเรียนกับหลังเรียนก าลังสอง 
        (∑ D)2  แทน  ผลรวมของผลต่างระหว่างคะแนนที่ได้จากการสอบวัดผลสัมฤทธิ์

ทางการเรียนก่อนเรียนกับหลังเรียนก าลังสอง 
 n   แทน  จ านวนนักเรียนทั้งหมด 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 
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               บทท่ี 4 
ผลการวิเคราะห์ข้อมูล 

 
การวิจัยครั้งนี้ เป็นการวิจัยเพ่ือพัฒนา และหาคุณภาพ ประสิทธิภาพ และเปรียบเทียบ

ผลสัมฤทธิ์ทางการเรียนของนักเรียน ด้วยบทเรียนผ่านเครือข่ายอินเทอร์เน็ต เรื่อง โปรแกรม
คอมพิวเตอร์กราฟิกเบื้องต้น ของนักเรียนชั้นมัธยมศึกษาปีที่ 1 โดยกลุ่มตัวอย่างที่ใช้ในการวิจัยครั้งนี้ 
ผู้ วิจั ย ได้คัด เลื อกกลุ่ ม โดยวิธี การสุ่ มตั วอย่ างแบบแบ่ งกลุ่ ม  (Cluster Random Sampling)  
จ านวน 1 กลุ่ม มีผลของการวิจัยและการวิเคราะห์ข้อมูลไดด้ังนี้ 
 
4.1  ผลการพัฒนาและวิเคราะห์หาคุณภาพบทเรียนผ่านเครือข่ายอินเทอร์เน็ต 
 

ผลการพัฒนาบทเรียนผ่านเครือข่ายอินเทอร์เน็ต เรื่อง โปรแกรมคอมพิวเตอร์กราฟิก
เบื้องต้นของนักเรียนชั้นมัธยมศึกษาปีที่ 1 ผู้วิจัยพัฒนาขึ้นด้วยโปรแกรม Moodle ภายใต้ชื่อโดเมน 
คือ www.kruyongyutt.com การน าเสนอบทเรียนผ่านเครือข่ายอินเทอร์เน็ต มีคุณสมบัติดังต่อไปนี้ 
 

4.1.1  ผลการพัฒนาบทเรียนผ่านเครือข่ายอินเทอร์เน็ต 
1.  ส่วนนักเรียน ประกอบด้วย 
1.1  การลงทะเบียน เป็นส่วนบันทึกประวัติของนักเรียน โดยการลงทะเบียน 

online  
1.2  การเข้าสู่ระบบ เป็นส่วนที่นักเรียนป้อนรหัสผู้ใช้ และรหัสผ่านเพ่ือเข้าสู่

บทเรียน  
1.3  เมนสู่วนตัวของนักเรียน แสดงประวัติ สามารถแก้ไขปรับปรุงได ้
2.  ส่วนของผู้สอน ประกอบด้วย 
2.1  ข้อมูลของนักเรียน ประกอบด้วย หน้าแสดงสมาชิก รายงานคะแนนการท า

แบบทดสอบ หน้าแสดงรายชื่อนักเรียนที่ก าลังเข้าใช้ บทเรียนผ่านเครือข่ายอินเทอร์เน็ต สถิติการเข้า
เรียนในแต่ละครั้งของนักเรียน   

2.2  การจัดระบบหน่วยการเรียนรู้ ประกอบด้วย การเพิ่มเนื้อหาในหน่วยการเรียน
โดยที่เนื้อหาสามารถเชื่อมโยงกับเนื้อหาภายนอกบทเรียนได้ กิจกรรมประจ าหน่วยการเรียนรู้ และ
แบบฝึกหัดประจ าหน่วย    

3.  เครื่องมือสนับสนุนการเรียนการสอนประกอบด้วย 
3.1  ห้องสนทนาประจ ากลุ่ม  
3.2  กระดานข่าวรายงาน 
4.  ส่วนของบทเรียน ประกอบด้วย 
4.1  แนะน าบทเรียน วัตถุประสงค์ของบทเรียน  
4.2  แบบทดสอบก่อนเรียน โดยมีการจัดเก็บในระบบฐานข้อมูล 
4.3  เนื้อหาของแต่ละหน่วยการเรียนรู้ โดยน าเสนอในรูปแบบมัลติมีเดียมีข้อความ 

ภาพนิ่ง ภาพเคลื่อนไหว เสียง และการมีปฏิสัมพันธ์กับนักเรียน 
เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 
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4.4  แบบฝึกหัดท้ายหน่วยการเรียน 
4.5  แบบทดสอบหลังเรียน โดยมีการจัดเก็บในระบบฐานข้อมูล 

 

 
 

ภาพที่  4.1  หน้าแรกของบทเรียนผ่านเครือข่ายอินเทอร์เน็ต 
 

4.1.2  ผลการวิเคราะห์หาคุณภาพบทเรียนผ่านเครือข่ายอินเทอร์เน็ต 
การวิเคราะห์คุณภาพบทเรียนผ่านเครือข่ายอินเทอร์เน็ต เรื่อง โปรแกรมคอมพิวเตอร์

กราฟิกเบื้องต้น ของนักเรียนชั้นมัธยมศึกษาปีที่  1 ผู้ วิจัยได้ด า เนินการโดยให้ผู้ทรงคุณวุฒิ 
เป็นผู้ประเมิน แบ่งออกเป็น 2 ด้าน คือ ด้านเนื้อหาและเทคนิคการออกแบบ และด้านเทคโนโลยี
มัลติมีเดีย ซึ่งมีผลการประเมินแสดงตารางที่ 4.1 และตารางท่ี 4.2 ตามล าดับ ดังต่อไปนี้ 
 
ตารางท่ี  4.1  ค่าเฉลี่ย ค่าเบี่ยงเบนมาตรฐาน และระดับคุณภาพของบทเรียนผ่านเครือข่าย   

อินเทอร์เน็ต จ าแนกเป็นรายด้าน 

ด้าน 
 

S ระดับคุณภาพ 

1. เนื้อหาและเทคนิคการออกแบบ 4.71 0.46 ดีมาก 
2. เทคโนโลยีมัลติมีเดีย 4.46 0.58 ดี 

รวม 4.59 0.52 ดีมาก 
 

จากตารางที่  4.1 ผลการประเมินคุณภาพบทเรียนผ่านเครือข่ายอินเทอร์เน็ต เรื่อง 
โปรแกรมคอมพิวเตอร์กราฟิกเบื้องต้น ของนักเรียนชั้นมัธยมศึกษาปีที่ 1 จากผู้ทรงคุณวุฒิ พบว่าใน
ภาพรวมอยู่ในระดับดีมาก  (x̅ = 4.59 , S = 0.52) และเมื่อพิจารณาเป็นรายด้าน พบว่าด้านเนื้อหา
และเทคนิคการออกแบบอยู่ในระดับดีมาก (x̅ = 4.71 , S = 0.46) และด้านเทคโนโลยีมัลติมีเดียอยู่
ในระดับดี (x̅ = 4.46 , S = 0.58) 
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ตารางท่ี  4.2  ค่าเฉลี่ย ค่าเบี่ยงเบนมาตรฐาน และระดับคุณภาพของบทเรียนผ่านเครือข่าย  
อินเทอร์เน็ต ด้านเนื้อหาและเทคนิคการออกแบบ 

ด้านเนื้อหาและเทคนิคการออกแบบ  S ระดับคุณภาพ 
1.  ด้านเนื้อหา 
1.1  เนื้อหาบทเรียนสอดคล้องกับวัตถุประสงค์เชิงพฤติกรรม 4.67 0.58 ดีมาก 
1.2  บทเรียนเปิดโอกาสให้นักเรียนมีส่วนร่วมในการเรียนตลอดการเรียน 4.67 0.58 ดีมาก 
1.3  บทเรียนมีความยากง่ายเหมาะสมกับนักเรียน 4.67 0.58 ดีมาก 
1.4 การใช้ภาษาสามารถสื่อความหมายได้ชัดเจน 5.00 0.00 ดีมาก 
1.5 บทเรียนมีการยกตัวอย่างในปริมาณ และโอกาสที่เหมาะสม 4.67 0.58 ดีมาก 
1.6 การน าเสนอเนื้อหาเหมาะสมกับการเรียนรู้ของนักเรียน 4.33 0.58 ดี 

รวม 4.67 0.48 ดีมาก 
2. ด้านกราฟิก และการออกแบบ 
2.1 การออกแบบหน้าจอมีความสวยงาม 5.00 0.00 ดีมาก 
2.2 ตัวอักษรที่ใช้มีความเหมาะสม 5.00 0.00 ดีมาก 
2.3 รูปภาพประกอบสามารถสื่อความหมาย และมีความ
สอดคล้องกับเนื้อหา มีความชัดเจน 

4.67 0.58 ดีมาก 

2.4 เสียงประกอบมีความเหมาะสม ชัดเจน 4.67 0.58 ดีมาก 
2.5 ความเหมาะสมของเวลาในการน าเสนอบทเรียน 4.67 0.58 ดีมาก 
2.6 มีส่วนชี้แนะหรือให้ความช่วยเหลือเมื่อนักเรียนต้องการ 4.67 0.58 ดีมาก 

รวม 4.78 0.39 ดีมาก 
3. ด้านเทคนิค 
3.1 บทเรียนใช้หลักของการออกแบบการสอนที่ดี 4.33 0.58 ดี 
3.2 บทเรียนมีการออกแบบทางเทคนิคท่ีดี 4.67 0.58 ดีมาก 
3.3 การพัฒนาโปรแกรมมีความคิดสร้างสรรค์ ใช้แนวคิดใหม่ ๆ 4.33 0.58 ดี 

รวม 4.67 0.58 ดีมาก 
รวมทั้งหมด 4.71 0.48 ดีมาก 

             
จากตารางที่ 4.2 พบว่า คุณภาพของบทเรียนผ่านเครือข่ายอินเทอร์เน็ต เรื่อง โปรแกรม

คอมพิวเตอร์กราฟิกเบื้องต้น ด้านเนื้อหาและเทคนิคการออกแบบมีคุณภาพอยู่ในระดับดีมาก 
(  = 4.71, S = 0.48) เมื่อพิจารณารายข้อโดยพิจารณาจากข้อที่มีค่าเฉลี่ยมากได้แก่เนื้อหาบทเรียน
สอดคล้องกับวัตถุประสงค์เชิงพฤติกรรมมีคุณภาพอยู่ในระดับดีมาก (  = 4.67, S = 0.58) และการ
ใช้ภาษาสามารถสื่อความหมายได้ชัดเจน มีคุณภาพอยู่ในระดับดีมาก (  = 5.00, S = 0.00)  
เมื่อพิจารณารายข้อ โดยพิจารณาจากข้อที่มีค่าเฉลี่ยน้อยได้แก่ การน าเสนอเนื้อหาที่เหมาะสมกับการ
เรียนรู้ของนักเรียน มีคุณภาพอยู่ในระดับดี (  = 4.33, S = 0.58) และบทเรียนใช้หลักของการ
ออกแบบการสอนที่ดี มีคุณภาพอยู่ในระดับดี (  =  4.33, S = 0.58) 
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ตารางท่ี  4.3  ค่าเฉลี่ย ค่าเบี่ยงเบนมาตรฐาน และระดับคุณภาพของบทเรียนผ่านเครือข่าย 
อินเทอร์เน็ต ด้านเทคโนโลยีมัลติมีเดีย 

ด้านเทคโนโลยีมัลติมีเดีย  S ระดับคุณภาพ 

1. ด้านตัวอักษร 
1.1 ขนาดของตัวอักษรที่ใช้ อ่านง่าย และชัดเจน 4.33 0.58 ดี 
1.2 ความเหมาะสมของสีตัวอักษร และสีของพ้ืนที่ใช้ 4.67 0.58 ดีมาก 
1.3 รูปแบบตัวอักษรที่ใช้ สวยงาม 4.67 0.58 ดีมาก 
1.4 ความถูกต้องของข้อความตามหลักภาษา 4.67 0.58 ดีมาก 
1.5 ความเหมาะสมของการจัดวางตัวอักษรหรือข้อความ 
ในแต่ละกรอบ 

4.67 0.58 ดีมาก 

รวม 4.60 0.58 ดีมาก 
2. ด้านภาพ 
2.1 ขนาดของภาพที่ใช้เหมาะสม 4.67 0.58 ดีมาก 
2.2 สีและความชัดเจนของภาพที่ใช้ความเหมาะสมของภาพที่
ใช้ในการสื่อความหมาย 

4.33 0.58 ดี 

2.3 สีและความชัดเจนของภาพที่ใช้ 4.67 0.58 ดีมาก 
2.4 ความสมดุลของการจัดวางภาพในแต่ละกรอบ 4.33 0.58 ดี 
2.5 ความเหมาะสมของจ านวนภาพ 4.33 0.58 ดี 

รวม 4.47 0.58 ดีมาก 
3. ด้านเสียง 
3.1 ระดับความดังของเสียงสม่ าเสมอ 4.67 0.58 ดีมาก 
3.2 ระดับความดังของเสียงดนตรีที่ใช้ 4.67 0.58 ดีมาก 
3.3 เปิดโอกาสให้นักเรียนโต้ตอบกับบทเรียน 4.33 0.58 ดี 
3.4 การควบคุมบทเรียนท าได้ง่ายและสะดวก 4.67 0.58 ดีมาก 
3.5 ความเหมาะสมของการเชื่อมโยงเนื้อหาภายในหน่วยการ
เรียน 

4.33 0.58 ดี 

3.6 ความเหมาะสมของการเชื่อมโยงระหว่างบทเรียนแต่ละ
หน่วยการเรียน 

4.67 0.58 ดีมาก 

รวม 4.56 0.58 ดีมาก 
4. ด้านปฏิสัมพันธ์ 
4.1 ความเหมาะสมของการให้ข้อมูลย้อนกลับ และการ
เสริมแรง 

4.33 0.58 ดี 

4.2 รูปแบบการโต้ตอบกับบทเรียนเป็นมาตรฐานเดียวกัน 4.33 0.58 ดี 
รวม 4.33 0.58 ดี 
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ด้านเทคโนโลยีมัลติมีเดีย  S ระดับคุณภาพ 

5. ด้านอ่ืน ๆ 
5.1 การออกแบบจอภาพแต่ละกรอบเป็นมาตรฐานเดียวกัน 4.33 0.58 ดี 
5.2 การออกแบบจอภาพน่าสนใจ และดึงดูดความสนใจ 4.33 0.58 ดี 
5.3 ความเหมาะสมของการผสมผสานสื่อประเภทข้อความ  
ภาพ และเสียง ในบทเรียน 

4.33 0.58 ดี 

รวม 4.33 0.58 ดี 
รวมทั้งหมด 4.46 0.58 ดี 

 
             จากตารางที่ 4.3 พบว่า คุณภาพของบทเรียนผ่านเครือข่ายอินเทอร์เน็ต เรื่อง โปรแกรม
คอมพิวเตอร์กราฟิกเบื้องต้น ด้านเทคโนโลยีมัลติมีเดียมีคุณภาพอยู่ในระดับดี (  = 4.46, S = 0.58)
เมื่อพิจารณารายข้อ โดยพิจารณาจากข้อที่มีค่าเฉลี่ยมากได้แก่ รูปแบบตัวอักษรที่ใช้ สวยงาม 
มีคุณภาพอยู่ในระดับดีมาก (  = 4.67, S = 0.58) ขนาดของภาพที่ใช้เหมาะสม มีคุณภาพอยู่ใน
ระดับดีมาก (  = 4.67, S = 0.58) สีและความชัดเจนของภาพที่ใช้มีคุณภาพอยู่ในระดับดีมาก 
(  = 4.67 , S = 0.58) และเมื่อพิจารณารายข้อโดยพิจารณาจากข้อที่มีค่าเฉลี่ยน้อยได้แก่ 
ความสมดุลของการจัดวางภาพในแต่ละกรอบมีคุณภาพอยู่ในระดับดี (  = 4.33, S = 0.58) 
ความเหมาะสมของการเชื่อมโยงเนื้อหาภายในหน่วยการเรียนมีคุณภาพอยู่ในระดับดี (  = 4.33, 
S = 0.58) และความเหมาะสมของการให้ข้อมูลย้อนกลับและการเสริมแรงมีคุณภาพอยู่ในระดับดี 
(  = 4.33, S = 0.58) 
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4.2  ผลการวิเคราะห์หาประสิทธิภาพของบทเรียนผ่านเครือข่ายอินเทอร์เน็ต 
 

ผลการวิเคราะห์ข้อมูลเพ่ือประสิทธิภาพของบทเรียนผ่านเครือข่ายอินเทอร์เน็ต โดยการน า
ผลคะแนนจากแบบทดสอบท้ายหน่วยการเรียน และผลคะแนนจากแบบทดสอบหลังเรียน  
มาเปรียบเทียบโดยแล้วท าการหาประสิทธิภาพของกระบวนการ (E1) และประสิทธิภาพของผลลัพธ์ 
(E2) โดยก าหนดเกณฑ์ E1 / E2  ไม่ต่ ากว่า 80/80 น าผลลัพธ์ที่ได้มาวิเคราะห์ข้อมูลทางสถิติดังนี้ 
 

ตารางท่ี 4.4 ผลการวิเคราะห์ประสิทธิภาพของบทเรียนผ่านเครือข่ายอินเทอร์เน็ต  

คะแนน นักเรียน คะแนนเต็ม 
คะแนนที่ได้ 

ค่าเฉลี่ย ค่าร้อยละ 
ระหว่างเรียน  40 30 24.10 80.33 (E1) 
หลังเรียน  40 30 24.03 80.08 (E2) 
 

จากตารางที่ 4.4  พบว่า บทเรียนผ่านเครือข่ายอินเทอร์เน็ต เรื่อง โปรแกรมคอมพิวเตอร์
กราฟิกเบื้องต้น มีประสิทธิภาพของกระบวนการ (E1) เท่ากับ 80.33 และประสิทธิภาพของผลลัพธ์ 
(E2) เท่ากับ 80.08 ซึ่งเป็นไปตามเกณฑ์ (E1/E2) ไม่น้อยกว่า 80/80  
 
4.3  ผลการวิเคราะห์ข้อมูลเพ่ือเปรียบเทียบผลสัมฤทธิ์ทางการเรียน ก่อนเรียนกับหลัง

เรียน ด้วยบทเรียนผ่านเครือข่ายอินเทอร์เน็ต 
 

การวิเคราะห์เปรียบเทียบผลสัมฤทธิ์ทางการเรียนของนักเรียน ก่อนเรียนกับหลังเรียนด้วย
บทเรียนผ่านเครือข่ายอินเทอร์เน็ต เรื่อง โปรแกรมคอมพิวเตอร์กราฟิกเบื้องต้น โดยผู้วิจัยได้ทดลอง
ใช้กับกลุ่มตัวอย่าง ผลการวิเคราะห์แสดง ดังรายละเอียดต่อไปนี้ 
 
ตารางท่ี  4.5  ผลการเปรียบเทียบผลสัมฤทธิ์ทางการเรียนของนักเรียนที่เรียนด้วยบทเรียนผ่าน 
    เครือข่ายอินเทอร์เน็ต จากคะแนนแบบทดสอบก่อนเรียนและหลังเรียน  

คะแนนสอบ นักเรียน คะแนนเต็ม  S t 
ก่อนเรียน 40 30 10.05 4.19 

19.06** 
หลังเรียน 40 30 24.03 3.27 

  **นัยส าคัญทางสถิติท่ีระดับ .01 
 
             จากตารางที่ 4.5 พบว่า ผลการวิเคราะห์เปรียบเทียบผลสัมฤทธิ์ทางการเรียนของนักเรียนก่อน
เรียนและหลังเรียน ที่เรียนด้วยบทเรียนผ่านเครือข่ายอินเทอร์เน็ต เรื่อง โปรแกรมคอมพิวเตอร์กราฟิก
เบื้องต้นของนักเรียน พบว่าคะแนนเฉลี่ยก่อนเรียนของนักเรียน มีค่าเท่ากับ 10.05 คะแนน และ คะแนน
เฉลี่ยหลังเรียนของนักเรียน มีค่าเท่ากับ 24.03 คะแนน น ามาหาค่าสถิติโดยการทดสอบค่าที (t-test) 
ชนิดสองกลุ่มไม่เป็นอิสระต่อกัน ได้เท่ากับ 19.06** แสดงว่าผลสัมฤทธิ์ทางการเรียนรู้ของนักเรียนที่
เรียนด้วยบทเรียนผ่านเครือข่ายอินเทอร์เน็ตมีคะแนนหลังเรียนสูงกว่าก่อนเรียน อย่างมีนัยส าคัญ 
ทางสถิติท่ีระดับ .01 ซึ่งเป็นไปตามสมมติฐานที่ตั้งไว้ 
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บทท่ี 5 
สรุปผลการวิจัย อภิปรายผล และข้อเสนอแนะ 

 
การวิจัยครั้งนี้ เป็นการวิจัยเพ่ือพัฒนาและหาคุณภาพ ประสิทธิภาพ และเปรียบเทียบ

ผลสัมฤทธิ์ทางการเรียนก่อนเรียนและหลังเรียน ด้วยบทเรียนผ่านเครือข่ายอินเทอร์เน็ต เรื่อง 
โปรแกรมคอมพิวเตอร์กราฟิกเบื้องต้น ของนักเรียนชั้นมัธยมศึกษาปีที่ 1 ซึ่งสรุปผลการวิจัย อภิปราย
ผลและข้อเสนอแนะ ได้ดังนี้ 

5.1  สรุปผลการวิจัย 
5.2  อภิปรายผล 
5.3  ข้อเสนอแนะ  

 
5.1  สรุปผลการวิจัย 
 

5.1.1  วัตถุประสงค์ของการวิจัย 
เพ่ือพัฒนาบทเรียนผ่านเครือข่ายอินเทอร์เน็ต เรื่อง โปรแกรมคอมพิวเตอร์กราฟิกเบื้องต้น 

ของนักเรียนชั้นมัธยมศึกษาปีที่ 1 ที่มีคุณภาพและประสิทธิภาพ และเพ่ือเปรียบเทียบผลสัมฤทธิ์
ทางการเรียนของนักเรียน ที่เรียนด้วยบทเรียนผ่านเครือข่ายอินเทอร์เน็ต เรื่อง โปรแกรมคอมพิวเตอร์
กราฟิกเบื้องต้น ของนักเรียนชั้นมัธยมศึกษาปีที่ 1 ระหว่างก่อนเรียนกับหลังเรียน 
 

5.1.2  สมมติฐานการวิจัย 
ผลสัมฤทธิ์ทางการเรียนของนักเรียนที่เรียนด้วยบทเรียนผ่านเครือข่ายอินเทอร์เน็ต เรื่อง 

โปรแกรมคอมพิวเตอร์กราฟิกเบื้องต้น ของนักเรียนชั้นมัธยมศึกษาปีที่  1 หลังเรียนสูงกว่า 
ก่อนเรียน 
 

5.1.3  วิธีด าเนินการวิจัย 
1.  ประชากรและกลุ่มตัวอย่าง 
ประชากร ได้แก่ นักเรียนชั้นมัธยมศึกษาปีที่ 1 ภาคเรียนที่ 2 ปีการศึกษา 2561 โรงเรียน

อนุบาลเมืองนครสวรรค์ (เขากบ วิวรณ์สุขวิทยา) สังกัดส านักงานเขตพ้ืนที่การศึกษาประถมศึกษา
นครสวรรค์เขต 1 จ านวน 160 คน 

กลุ่มตัวอย่าง ได้แก่ นักเรียนชั้นมัธยมศึกษาศึกษาปีที่ 1 ภาคเรียนที่ 2 ปีการศึกษา 2561 
โรงเรียนอนุบาลเมืองนครสวรรค์ (เขากบ วิวรณ์สุขวิทยา) สังกัดส านักงานเขตพ้ืนที่การศึกษา
ประถมศึกษานครสวรรค์เขต 1 จ านวน 1 ห้อง จ านวน 40 คน โดยได้มาจากการสุ่มตัวอย่างแบบ
แบ่งกลุ่ม (Cluster Random Sampling) จากประชากรเพ่ือหาประสิทธิภาพของบทเรียนและ
เปรียบเทียบผลสัมฤทธิ์ทางการเรียน 

2.  เครื่องมือที่ใช้ในการวิจัย 
2.1  บทเรียนผ่านเครือข่ายอินเทอร์เน็ต เรื่อง โปรแกรมคอมพิวเตอร์กราฟิกเบื้องต้น 
2.2  แบบประเมินคุณภาพของบทเรียนผ่านเครือข่ายอินเทอร์เน็ต เรื่อง โปรแกรม

คอมพิวเตอร์กราฟิกเบื้องต้น ด้านเนื้อหาและเทคนิคการออกแบบ และด้านเทคโนโลยีมัลติมีเดีย 
เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 
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                  2.3  แบบทดสอบวัดผลสัมฤทธิ์ทางการเรียน เรื่อง โปรแกรมคอมพิวเตอร์กราฟิก
เบื้องต้น เป็นแบบทดสอบแบบปรนัย ชนิดเลือกตอบ 4 ตัวเลือก จ านวน 30 ข้อ ซึ่งมีค่าดัชนีความ
สอดคล้อง (IOC) อยู่ระหว่าง 0.67-1.00 ค่าความยากง่ายอยู่ระหว่าง 0.38-0.76 ค่าอ านาจจ าแนกอยู่
ระหว่าง 0.29-0.76 และค่าความเชื่อม่ันเท่ากับ 0.87 

3.  การทดลองและเก็บรวบรวมข้อมูล 
การวิจัยครั้งนี้ ผู้วิจัยได้ด าเนินการทดลอง และเก็บรวบรวมข้อมูลโดยน าบทเรียนผ่าน

เครือข่ายอินเทอร์เน็ต เรื่อง โปรแกรมคอมพิวเตอร์กราฟิกเบื้องต้น ของนักเรียนชั้นมัธยมศึกษา 
ปีที่ 1 ไปใช้กับนักเรียนที่ก าลังศึกษาในภาคเรียนที่ 2 ปีการศึกษา 2561 โรงเรียนอนุบาลเมือง
นครสวรรค์ (เขากบ วิวรณ์สุขวิทยา) สังกัดส านักงานเขตพ้ืนที่การศึกษาประถมศึกษานครสวรรค์ 
เขต 1 ผู้วิจัยได้ก าหนดขั้นตอนในทดลองและเก็บรวบรวมข้อมูลดังนี้ 

4.  การหาคุณภาพของบทเรียน 
น าบทเรียนผ่านเครือข่ายอินเทอร์เน็ต เรื่อง โปรแกรมคอมพิวเตอร์กราฟิกเบื้องต้น ให้

ผู้ทรงคุณวุฒิตรวจสอบ และประเมินคุณภาพด้านเนื้อหาและเทคนิคการออกแบบ จ านวน 3 ท่าน 
และด้านเทคโนโลยีมัลติมีเดีย จ านวน 3 ท่าน แล้วน าข้อมูลที่ได้มาวิเคราะห์ข้อมูลทางสถิติ โดยการหา
ค่าเฉลี่ย และส่วนเบี่ยงเบนมาตรฐาน 

5.  การทดลองเพ่ือหาประสิทธิภาพบทเรียน 
5.1  น าบทเรียนผ่านเครือข่ายอินเทอร์เน็ต ที่ได้ปรับปรุงแล้วไปทดสอบกับกลุ่มตัวอย่าง

แบบ 1 ต่อ 1 โดยใช้กับนักเรียน จ านวน 3 คน ที่ไม่ใช่กลุ่มตัวอย่าง และยังไม่เคยผ่านการเรียนในวิชา
นี้ ซึ่งเรียนในกลุ่มเก่ง ปานกลาง และอ่อน กลุ่มละ 1 คน โดยการสังเกตพฤติกรรม สัมภาษณ์ และ
บันทึกสิ่งที่ควรแก้ไข เพ่ือน ามาท าการปรับปรุงแก้ไขบทเรียนผ่านเครือข่ายอินเทอร์เน็ต  

5.2  หลังจากท าการทดลองแล้วน าบทเรียนผ่านเครือข่ายอินเทอร์เน็ต ที่ปรับปรุงแล้ว
ไปทดลองใช้กับนักเรียนจ านวน 6 คน ที่ไม่ใช่กลุ่มตัวอย่าง และยังไม่เคยผ่านการเรียนในวิชานี้ โดย
การสังเกตพฤติกรรม สัมภาษณ์ และบันทึกสิ่งที่ควรแก้ไข เพ่ือน ามาท าการปรับปรุงแก้ไขบทเรียนผ่าน
เครือข่ายอินเทอร์เน็ต 

5.3  น าบทเรียนผ่านเครือข่ายอินเทอร์เน็ต ที่ปรับปรุงแล้ว ใช้กับนักเรียนกลุ่มตัวอย่าง
จริง จ านวน 40 คน โดยท าแบบทดสอบก่อนเรียน จากนั้นแบ่งนักเรียนออกเป็นกลุ่มย่อย และท า
กิจกรรมที่ผู้สอนเตรียมไว้ตามเอกสารที่ผู้สอนเตรียมไว้ ท าแบบฝึกหัดระหว่างเรียนในแต่ละหน่วยจน
ครบทุกหน่วยการเรียนแล้ว จึงท าแบบทดสอบหลังเรียน แล้วน าคะแนนมาวิเคราะห์หาประสิทธิภาพ
ของบทเรียน  

6.  การทดลองเพ่ือเปรียบเทียบผลสัมฤทธิ์ทางการเรียน 
น าแบบทดสอบก่อนเรียนไปให้กลุ่มตัวอย่างที่เลือกไว้ท าก่อนเข้าสู่บทเรียนผ่านเครือข่าย

อินเทอร์เน็ต จากนั้นให้กลุ่มตัวอย่างได้ศึกษาบทเรียนผ่านเครือข่ายอินเทอร์เน็ต ท าตามกิจกรรมที่
ผู้ วิจัยจัดการเรียนการสอนไว้ เมื่อนักเรียนศึกษาครบทุกหน่วยการเรียนรู้แล้ว ให้ นักเรียน 
ท าแบบทดสอบหลังเรียน แล้วน าคะแนนที่ได้มาวิเคราะห์ข้อมูลเปรียบเทียบผลสัมฤทธิ์ทางการเรียน 

 
 
 
 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 
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7.  การวิเคราะห์ข้อมูล 
7.1  วิเคราะห์คุณภาพของบทเรียนทางด้านเนื้อหาและเทคนิคการออกแบบ และด้าน

เทคโนโลยีมัลติมีเดีย โดยใช้สถิติค่าเฉลี่ย ( ) และส่วนเบี่ยงเบนมาตรฐาน (S) 
7.2  วิเคราะห์ประสิทธิภาพของบทเรียนผ่านเครือข่ายอินเทอร์เน็ต โดยใช้สูตร E1/E2  

ซึ่งก าหนดเกณฑ์ไม่ต่ ากว่า 80/80 

7.3  การเปรียบเทียบผลสัมฤทธิ์ทางการเรียนของนักเรียน ก่อนเรียนกับหลังเรียนด้วย
บทเรียนผ่านเครือข่ายอินเทอร์เน็ต เรื่อง โปรแกรมคอมพิวเตอร์กราฟิกเบื้องต้น โดยใช้การทดสอบค่าที 
ชนิดไม่เป็นอิสระต่อกัน (t-test dependent samples) 
 

5.1.4  สรุปผลการวิจัย 
จากการด าเนินการวิจัยสามารถสรุปผลวิจัยได้ดังนี้ 
1.  คุณภาพของบทเรียนผ่านเครือข่าย เรื่อง โปรแกรมคอมพิวเตอร์กราฟิกเบื้องต้น 

ภาพรวมมีคุณภาพอยู่ในระดับดีมาก (  = 4.59, S = 0.52) เมื่อพิจารณารายด้านพบว่า ด้านเนื้อหา
และเทคนิคการออกแบบมีคุณภาพอยู่ในระดับดีมาก (  = 4.71, S = 0.46) ด้านเทคโนโลยี
มัลติมีเดียมีคุณภาพอยู่ในระดับดี  (  = 4.46, S = 0.58) 
            2.  บทเรียนผ่านเครือข่ายอินเทอร์เน็ต เรื่อง โปรแกรมคอมพิวเตอร์กราฟิก ของนักเรียน
ชั้นมัธยมศึกษาปีที่ 1 ที่สร้างขึ้นมีประสิทธิภาพของกระบวนการ (E1) และประสิทธิภาพของผลลัพธ์ 
(E2) เท่ากับ 80.33/80.08 เป็นไปตามเกณฑ์ที่ก าหนดไว้คือไม่ต่ ากว่า 80/80 
            3 .  นักเรียนมีผลสัมฤทธิ์ทางการเรียนด้วยบทเรียนผ่านเครือข่ายอินเทอร์ เน็ ต  
เรื่อง โปรแกรมคอมพิวเตอร์กราฟิกเบื้องต้น สูงกว่าก่อนเรียนอย่างมีนัยส าคัญทางสถิติที่ระดับ .01  
 
5.2  อภิปรายผล 
 

ในการวิจัยเรื่องการพัฒนาบทเรียนผ่านเครือข่ายอินเทอร์เน็ต เรื่อง โปรแกรมคอมพิวเตอร์
กราฟิกเบื้องต้น ของนักเรียนชั้นมัธยมศึกษาปีที่ 1 สามารถอภิปรายผลได้ดังนี้ 
 

5.2.1  ด้านคุณภาพของบทเรียน  
 ผลการวิจัยพบว่าบทเรียนผ่านเครือข่ายอินเทอร์เน็ต เรื่อง โปรแกรมคอมพิวเตอร์กราฟิก
เบื้ อ งต้ น  ข อ งนั ก เรี ย น ชั้ น มั ธ ย ม ศึ ก ษ าปี ที่  1  มี คุ ณ ภ าพ โด ย รวม อยู่ ใน ร ะดั บ ดี ม าก 
อาจเนื่องจากว่าผู้วิจัยได้พัฒนาบทเรียนผ่านเครือข่ายอินเทอร์เน็ต เรื่อง โปรแกรมคอมพิวเตอร์
กราฟิกเบื้องต้น ทั้งนี้เนื่องจากบทเรียนผ่านเครือข่ายอินเทอร์เน็ตที่ผู้วิจัยสร้างขึ้นผ่านขั้นตอนในการ
สร้างเครื่องมือตามหลักการออกแบบสื่อการสอนแบบ ADDIE Model ของ Roderic, Slims (อ้างใน  
มนต์ชัย เทียนทอง. 2544 : 130-134) ซึ่งเริ่มต้นจากการวิเคราะห์ การออกแบบ การพัฒนา 
การน าไปใช้ และการประเมินผล ท าให้ผู้วิจัยสามารถพัฒนาบทเรียนผ่านเครือข่ายอินเทอร์เน็ตได้
อย่างเป็นระบบแบบแผน สามารถออกแบบบทเรียน และน าเสนอได้เหมาะสมกับเนื้อหา รวมถึง
ปรับปรุงแก้ไขตามข้อเสนอแนะของอาจารย์ที่ปรึกษาวิทยานิพนธ์ อาจารย์ที่ปรึกษาวิทยานิพนธ์ร่วม 
และผู้ทรงคุณวุฒิ โดยท าการวิเคราะห์เนื้อหา แบ่งเนื้อหาเป็นหน่วยการเรียนรู้ ก าหนดจุดประสงค์ 
การเรียนรู้ ศึกษาเนื้อหาทุกหน่วยการเรียนรู้ จัดเรียงล าดับเนื้อหาจากง่ายไปหายาก มีขั้นตอนการ
น าเสนอเนื้อหาที่เหมาะสม มีการตรวจสอบข้อบกพร่องโดยผู้ทรงคุณวุฒิเพ่ือน ามาปรับปรุงแก้ไขให้มี
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ความสมบูรณ์ยิ่งขึ้น ตามหลักการหาคุณภาพสื่อของ ไพโรจน์ ตีรณธนากุล และคณะ.(2546 : 197-
214) ท าให้สื่อออนไลน์มีคุณภาพด้านเนื้อหาและเทคนิคการออกแบบอยู่ในระดับดีมาก (  = 4.71, 
S = 0.46) และด้านเทคโนโลยีมัลติมีเดียมีการออกแบบองค์ประกอบของหน้าจอที่ เหมาะสม 
ขนาดของตัวอักษรที่ใช้ อ่านง่าย และชัดเจน มีความเหมาะสมของสีตัวอักษร และสีของพ้ืนที่ใช้ 
รูปแบบตัวอักษรที่ใช้ สวยงาม มีความถูกต้องของข้อความตามหลักภาษา ภาพที่ใช้สื่อความหมาย 
ด้านปฏิสัมพันธ์มีการเปิดโอกาสให้นักเรียนโต้ตอบกับบทเรียน การควบคุมบทเรียนท าได้ง่ายและ
สะดวกมีความเหมาะสมของการเชื่อมโยงเนื้อหาภายในหน่วยการเรียน มีความเหมาะสมของการ
เชื่อมโยงระหว่างบทเรียนแต่ละหน่วยการเรียน มีการให้ข้อมูลย้อนกลับแล้วสื่อความหมายได้ชัดเจน 
จึงท าให้บทเรียนมีคุณภาพทางด้านเทคโนโลยีมัลติมีเดียอยู่ในระดับดี (  = 4.46, S = 0.58) 
ซึ่งสอดคล้องกับงานวิจัยของ สิริพร แซ่ลี้.(2558) พบว่าคุณภาพด้านเทคโนโลยีมัลติมีเดียอยู่ในระดับดี 
อาจเนื่องจากว่าด้านตัวอักษรมีขนาดของตัวอักษรที่ใช้ อ่านง่ายและชัดเจน มีความเหมาะสมของสี
ตัวอักษรและสีของพ้ืนที่ใช้ รูปแบบตัวอักษรที่ใช้ สวยงาม มีความถูกต้องของข้อความตามหลักภาษา 
การจัดวางตัวอักษรหรือข้อความในแต่ละกรอบมีความเหมาะสม ด้านภาพมีขนาดของภาพที่ใช้
เหมาะสม สีและความชัดเจนของภาพที่ใช้มีความเหมาะสม ภาพที่ใช้สื่อความหมายมีความสมดุลของ
การจัดวางภาพในแต่ละกรอบ และมีความเหมาะสมของจ านวนภาพ ด้านเสียงมีความเหมาะสมของ
ระดับเสียงบรรยายและระดับความดังของเสียงบรรยายมีความสม่ าเสมอ ด้านปฏิสัมพันธ์มีการเปิด
โอกาสให้นักเรียนโต้ตอบกับบทเรียนการควบคุมบทเรียนท าได้ง่าย และสะดวก มีความเหมาะสมของ
การเชื่อมโยงเนื้อหาภายในหน่วยการเรียน มีความเหมาะสมของการเชื่อมโยงระหว่างบทเรียนแต่ละ
หน่วยการเรียน มีการให้ข้อมูลย้อนกลับ และการเสริมแรง และรูปแบบการโต้ตอบกับบทเรียน 
เป็นมาตรฐานเดียวกันจึงท าให้บทเรียนมีคุณภาพทางด้านเทคโนโลยีมัลติมีเดียอยู่ในระดับดี 
(  = 4.46 , S = 0.58) 
 

5.2.2  ด้านประสิทธิภาพของบทเรียน 
ผลการหาประสิทธิภาพของบทเรียนผ่านเครือข่ายอินเทอร์ เน็ต  เรื่อง โปรแกรม

คอมพิวเตอร์กราฟิกเบื้องต้น ของนักเรียนชั้นมัธยมศึกษาปีที่ 1  มีค่าประสิทธิภาพของกระบวนการ
และประสิทธิภาพของผลลัพธ์ (E1/E2) เท่ากับ 80.33/80.08 ซ่ึงเป็นไปตามที่สมมติฐานที่ก าหนด 
จะเห็นว่าคะแนนรวมของประสิทธิภาพของกระบวนการสูงกว่าประสิทธิภาพของผลลัพธ์ เนื่องมาจาก
นักเรียนเมื่อเรียนจบแล้วในแต่หน่วยการเรียนจะได้ท าแบบฝึกหัด และแบบทดสอบท้ายหน่วยการ
เรียนรู้ ดังนั้นนักเรียนจะสามารถท าแบบทดสอบได้คะแนนสูงกว่าการทดสอบหลังเรียน เพราะมี
ความรู้สะสมมาตั้งแต่เริ่มเรียนในหน่วยที่ 1 เมื่อนักเรียนสอบหลังเรียนจากเรื่องทั้งหมดจึงท าให้
นักเรียนเกิดการลืมเนื้อหาได้ สอดคล้องกับแนวคิดของกมลรัตน์ หล้าสุวงษ์ (2528 : 254) ที่กล่าวไว้
ว่า หนึ่งในสามของปัจจัยที่มีอิทธิพลต่อการจ า คือ ระยะเวลา หากทิ้งระยะหลังจากการเรียนรู้ไปนาน 
ๆ ก็จะท าให้จ าในสิ่งที่เรียนรู้ได้น้อย หรือบางครั้งอาจลืมไปเลยก็ได้ อีกทั้งบทเรียนที่พัฒนาขึ้น 
สามารถเข้าศึกษาเนื้อหาตามความต้องการของตนเอง หากไม่เข้าใจก็กลับมาเรียนซ้ าเดิมโดยไม่มี
ข้อจ ากัดเรื่องเวลา ซึ่งสอดคล้องกับแนวคิดของ Thorndike ที่กล่าวว่าการฝึกหัดหรือกระท าบ่อย ๆ 
ด้วยความเข้าใจจะท าให้ความรู้นั้นคงทนถาวร ถ้าไม่ได้กระท าซ้ าบ่อย ๆ การเรียนรู้นั้นจะไม่คงทน
ถาวร และในที่สุดอาจลืมได้ ซึ่งสอดคล้องกับงานวิจัยของ กัลยา ค ายอด (2554 : 53-55) ได้พัฒนา
บทเรียนผ่านเครือข่ายอินเทอร์เน็ตเพ่ือทบทวน เรื่อง การสร้างและใช้งานตาราง ซึ่งมีประสิทธิภาพ 
E1/E2= 81.25/80.63 และสอดคล้องกับงานวิจัยของธณัฐภรณ์ สนิทมาก (2555 : 146-152) ที่พัฒนา
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บทเรียนผ่านเครือข่ายอินเทอร์เน็ตเรื่อง นิพจน์ และตัวด าเนินการ ระดับมัธยมศึกษาปีที่ 5 โรงเรียน
แก่งคอย จังหวัดสระบุรีซึ่งมีประสิทธิภาพ E1/E2 = 81.50/82.25 ซึ่งพบว่าผลการเรียนรู้ระหว่าง
เรียนมีค่ามากกว่าผลการเรียนรู้หลังเรียนเช่นกัน 
 

   

5.2.3  ด้านเปรียบเทียบผลสัมฤทธิ์ทางการเรียนของนักเรียน 
ผลสัมฤทธิ์ทางการเรียนของนักเรียนก่อนเรียนกับหลังเรียนด้วยบทเรียนผ่านเครือข่าย

อินเทอร์เน็ต เรื่องโปรแกรมคอมพิวเตอร์กราฟิกเบื้องต้น ของนักเรียนชั้นมัธยมศึกษาปีที่ 1 พบว่า
ผลสัมฤทธิ์ทางการเรียนของนักเรียนหลังเรียนสูงกว่าก่อนเรียน อย่างมีนัยส าคัญทางสถิติที่ระดับ .01 
โดยก่อนเรียนมีค่าเท่ากับ 10.05 และหลังเรียนมีค่าเท่ากับ 24.03 ทั้งนี้เพราะในแบบทดสอบก่อน
เรียน นักเรียนส่วนใหญ่ยังไม่มีความรู้เนื้อหาที่จะท าแบบทดสอบ การตอบค าถามจึงเป็นไปในแบบเดา
ค าตอบ หลังจากเรียนเนื้อหาในแต่ละหน่วยครบจนจบแล้ว นักเรียนจึงท าแบบทดสอบหลังเรียน 
ซึ่งในขณะนั้นนักเรียนมีความรู้ ความเข้าใจเนื้อหาอย่างดี และเกิดการเรียนรู้แล้ว ผลคะแนนสอบหลัง
เรียนจึงสูงกว่าก่อนเรียน อีกทั้งบทเรียนผ่านเครือข่ายอินเทอร์เน็ตที่พัฒนาขึ้นนั้นมีการออกแบบที่
ถูกต้องตามหลักการและทฤษฎีการพัฒนาบทเรียนให้นักเรียนสามารถเรียนรู้ได้  มีภาพนิ่ ง  
ภาพเคลื่อนไหว และเสียงที่ดึงดูดความสนใจ รวมทั้งแบบทดสอบผลสัมฤทธิ์ได้รับการตรวจสอบความ
ถูกต้อง และทดสอบหาค่าความเที่ยงตรง ค่าความเชื่อมั่น ความยากง่าย ท าให้นักเรียนเกิดการเรียนรู้
และความเข้าใจเนื้อหาได้เป็นอย่างดี ซึ่งสอดคล้องกับงานวิจัยของอัจฉรา อุรัชโนประกร (2552 : 57) 
ที่ได้ท าวิจัย เรื่อง การสร้างบทเรียนออนไลน์โดยวิธีการเรียนแบบผสมผสาน พบว่าผลสัมฤทธิ์ทางการ
เรียนของนักเรียนหลังเรียนด้วยวิธีการเรียนแบบผสมผสานสูงกว่าก่อนเรียนอย่างมีนัยส าคัญทางสถิติที่
ระดับ 0.01 และสอดคล้องกับงานวิจัยของ วิไลวรรณ อ่ าค าสรง (2537 : บทคัดย่อ)  ได้ศึกษา
เปรียบเทียบผลสัมฤทธิ์ โดยวิธีการสอนแบบคอมพิวเตอร์ช่วยสอนกับวิธีการสอนแบบบรรยายที่มี
ผลสัมฤทธิ์ทางการเรียน และความคงทนในการเรียนรู้ในวิชา การบัญชีห้างหุ้นส่วน กลุ่มตัวอย่างเป็น
นักศึกษาระดับประกาศนียบัตรวิชาชีพปีที่ 3 สาขาบัญชี สถาบันเทคโนโลยีราชมงคล วิทยาเขตบพิตร
พิมุข ทุ่ งมหาเมฆ จ านวน 38 คนกลุ่มละ 19 คน โดยกลุ่มทดลองสอนโดยวิธีการสอนแบบ
คอมพิวเตอร์ช่วยสอนและกลุ่มควบคุมสอนโดยวิธีการสอนแบบบรรยาย ผลการวิจัยปรากฏว่า
ผลสัมฤทธิ์ทางการเรียน โดยวิธีการสอนแบบคอมพิวเตอร์ช่วยสอนสูงกว่าผลสัมฤทธิ์ทางการเรียน โดย
วิธีการสอนแบบบรรยาย อย่างมีนยัส าคัญทางสถิติที่ระดับ .01 
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5.3  ข้อเสนอแนะ 
  
           5.3.1  ข้อเสนอแนะในการน าผลวิจัยไปใช้ 
           1.  สามารถน ากระบวนการพัฒนาบทเรียนผ่านเครือข่ายอินเทอร์เน็ต มาใช้พัฒนาบทเรียน
ในรายวิชาอ่ืน ๆ ที่มีในหลักสูตรของสถานศึกษาได้ 
           2.  การน าบทเรียนผ่านเครือข่ายอินเทอร์เน็ต เรื่อง โปรแกรมคอมพิวเตอร์กราฟิกเบื้องต้น 
ไปใช้งานนั้น ผู้สอนควรศึกษาวิธีการใช้งานโดยละเอียด และอธิบายวิธีการใช้งานให้นักเรียนเข้าใจเป็น
ขั้นตอน เพ่ือการใช้งานที่มีประสิทธิภาพ 
 
 

           5.3.2  ข้อเสนอแนะในการวิจัยครั้งต่อไป 
           1.  ควรมีการประเมินคุณภาพแผนการจัดการเรียนรู้บทเรียนผ่านเครือข่ายอินเทอร์เน็ต 
เรื่อง โปรแกรมคอมพิวเตอร์กราฟิกเบื้องต้น เพ่ือตรวจสอบคุณภาพของแผนการเรียนรู้ก่อนน าไปใช้
จัดการเรียนการสอน 
           2.  ควรวัดระดับความพึงพอใจของนักเรียนที่มีต่อบทเรียนผ่านเครือข่ายอินเทอร์เน็ต เรื่อง
โปรแกรมคอมพิวเตอร์กราฟิกเบื้องต้น เพ่ือพัฒนาบทเรียนให้ตรงกับความต้องการของนักเรียน 
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ภาคผนวก ก 
ตัวอย่างหนังสือราชการประกอบการด าเนินการวิจัย 
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ภาคผนวก ข 

รายนามผู้ทรงคุณวุฒิ 
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รายนามผู้ทรงคุณวุฒิในการตรวจและประเมินคุณภาพบทเรียนผ่านเครือข่ายอินเทอร์เน็ต 
เรื่อง โปรแกรมคอมพิวเตอร์กราฟิกเบื้องต้น ของนักเรียนชั้นมัธยมศึกษาปีท่ี 1 

แบ่งออกเป็น 2 ด้าน คือ ด้านเนื้อหาและเทคนิคการออกแบบ และด้านเทคโนโลยีมัลติมีเดีย ดังนี้ 
 
ด้านเนื้อหา จ านวน 3 ท่าน ได้แก่ 
1.  อาจารย์พริ้มไพร  วงศ์ชมพู  อาจารย์ประจ าภาควิชาคอมพิวเตอร์  
        คณะวิทยาศาสตร์และเทคโนโลยี 
                                                 มหาวิทยาลัยราชภัฏเชียงใหม่ 
2.  นางเกศกมล ผ่องฉวี   ครู วิทยฐานะ ครูช านาญการพิเศษ 
                                                 โรงเรียนวัดไร่ขิงวิทยา อ.เมือง จ.นครปฐม 
3.  นายประภาส สุภาษี     ครู วิทยฐานะ ครูช านาญการพิเศษ 

       โรงเรียนวัฒโนทัยพายัพ อ.เมือง จ.เชียงใหม่  
 

ด้านเทคโนโลยีมัลติมีเดีย จ านวน 3 ท่าน ได้แก่ 
1.  อาจารย์เอกวิทย ์ สิทธิวะ            สาขาวิชาเทคโนโลยีมัลติมีเดีย 
                                                 คณะวิทยาศาสตร์และเทคโนโลยี 

                                                              มหาวทิยาลัยราชภัฏนครสวรรค์ 
2.  นางสาวสุภาภรณ์ ธรรมสรางกูร ครู วิทยฐานะ ครูช านาญการพิเศษ 

      โรงเรียนบุญวาทย์วิทยาลัย อ.เมือง จ.ล าปาง   
3.  นางชลลดา จารุภา   ครู วิทยฐานะ ครูช านาญการพิเศษ 
                                                  โรงเรียนวัดเขาวัง (แสง ช่วงสุวนิช) 
      อ.เมือง จ.ราชบุรี 
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รายนามผู้ทรงคุณวุฒิในการตรวจและประเมินแบบทดสอบวัดผลสัมฤทธิ์ทางการเรียน 
บทเรียนผ่านเครือข่ายอินเทอร์เน็ต เรื่อง โปรแกรมคอมพิวเตอร์กราฟิกเบื้องต้น  

ของนักเรียนชั้นมัธยมศึกษาปีท่ี 1 จ านวน 3 ท่าน ได้แก่ 
 
              1.  อาจารย์เอกวิทย์  สิทธิวะ            สาขาวิชาเทคโนโลยีมัลติมีเดีย 
                                                   คณะวิทยาศาสตร์และเทคโนโลยี 
                                                              มหาวทิยาลัยราชภัฏนครสวรรค์ 
           2.  นางสาวสุภาภรณ์ ธรรมสรางกูร ครู วิทยฐานะ ครูช านาญการพิเศษ 

      โรงเรียนบุญวาทย์วิทยาลัย อ.เมือง จ.ล าปาง   
            3.  นางชลลดา จารภุา   ครู วิทยฐานะ ครูช านาญการพิเศษ 

                                                  โรงเรียนวัดเขาวัง (แสง ช่วงสุวนิช) 
      อ.เมือง จ.ราชบุรี 
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ภาคผนวก ค 

ตัวอย่างบทเรียนผ่านเครือข่ายอินเทอร์เน็ต 
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ภาพที่  ค.1  หน้าเว็บของบทเรียน http://www.kruyongyutt.com/web/ 

 

ภาพที่  ง.2  หน้าจอสมัครสมาชิก 
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ภาพที่  ค.3  หน้า login เข้าสู่ระบบ 

 

ภาพที่  ค.4  หน้าจอเลือกบทเรียน 
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ภาพที่  ค.5  หน้าจอแรกของบทเรียน 

 

 

 

ภาพที่  ค.6  หน้าจอแบบทดสอบก่อนเรียน 
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ภาพที่  ค.7  หน้าจอเริ่มท าแบบทดสอบก่อนเรียน 

 

 

 

ภาพที่  ค.8  หน้าจอหน่วยการเรียนรู้ที่ 1 
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ภาพที่  ค.9  หน้าจอเข้าสู่บทเรียนที่ 1 

 

ภาพที่  ค.10  หน้าจอเข้าสู่บทเรียนที่ 2 
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ภาพที่  ค.11  หน้าจอเข้าสู่บทเรียนที่ 3 

 

 

ภาพที่  ค.12  หน้าจอหน่วยเรียนรู้ที่ 2 
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ภาพที่  ค.13  หน้าจอหน่วยการเรียนรู้ 

 

 

 

ภาพที่  ค.14  หน้าจอแบบทดสอบหลังเรียน 
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ภาคผนวก ง 
ผลการประเมินคุณภาพและประสิทธิภาพของบทเรียนผ่านเครือข่ายอินเทอร์เน็ต 
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ผลการหาประสิทธิภาพของบทเรียนผ่านเครือข่ายอินเทอร์เน็ต  
เร่ือง โปรแกรมคอมพิวเตอร์กราฟฟิกเบื้องต้น   

ของนักเรียนชั้นมัธยมศึกษาปีที่ 1 

ตารางท่ี  ง.3  คะแนนที่ได้จากการท าแบบฝึกหัดระหว่างเรียนและแบบทดสอบหลังเรียน 
        เพ่ือหาประสิทธิภาพของบทเรียนผ่านเครือข่ายอินเทอร์เน็ต 

คนที่ 
คะแนนแบบฝึกหัดระหว่างเรียน (E1) 

คะแนนเต็ม 30 คะแนน 
คะแนนแบบทดสอบหลังเรียน (E2) 

คะแนนเต็ม 30 คะแนน 

1 22 22 
2 23 20 
3 27 27 
4 26 24 
5 24 26 
6 24 23 
7 28 29 
8 26 24 
9 19 21 
10 20 22 
11 25 23 
12 23 24 
13 26 26 
14 16 17 
15 27 27 
16 20 22 
17 23 22 
18 26 24 
19 26 23 
20 25 27 
21 23 19 
22 28 25 
23 24 22 
24 27 25 

  

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 
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ตารางท่ี  ง.3  (ต่อ) 

คนที่ 
คะแนนแบบฝึกหัดระหว่างเรียน (E1) 

คะแนนเต็ม 30 คะแนน 
คะแนนแบบทดสอบหลังเรียน (E2) 

คะแนนเต็ม 30 คะแนน 
25 24 24 
26 27 27 
27 25 25 
28 26 26 
29 27 27 
30 28 28 
31 29 29 
32 21 21 
33 21 21 
34 26 26 
35 27 27 
36 18 18 
37 29 29 
38 27 27 
39 26 26 
40 16 16 
∑ 964 961 
X 24.10 24.03 

ร้อยละ 80.33 80.08 
E1/E2 = 80.33/80.08 

 
จากตารางที่  ง.3  คะแนนการหาประสิทธิภาพของบทเรียนผ่านเครือข่ายอินเทอร์เน็ต 

เรื่อง โปรแกรมคอมพิวเตอร์กราฟฟิกเบื้องต้น ของนักเรียนชั้นมัธยมศึกษาปีที่ 1  พบว่าค่าที่ค านวณ
ได้จากแบบฝึกระหว่างเรียน (E1) และค่าที่ค านวณได้จากแบบทดสอบหลังเรียน (E2) มีค่าเฉลี่ยอยู่ที่ 
24.10/24.03  คิดเป็นร้อยละ 80.33/80.08 แสดงว่าชุดการสอนที่ผู้วิจัยสร้างขึ้นมีประสิทธิภาพสูง
กว่าเกณฑ์ท่ีก าหนด 
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ภาคผนวก จ 
แบบทดสอบวัดผลสัมฤทธิ์ทางการเรียน 
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แบบทดสอบวัดผลสัมฤทธิ์ทางการเรียน เร่ือง โปรแกรมคอมพิวเตอร์กราฟิกเบื้องต้น 
 

1. คอมพิวเตอร์กราฟิก หมายถึง ข้อใด? 

  

ก. ศิลปะหรือศาสตร์แขนงหนึ่ง 
ข. ภาพเขียน สัญลักษณ ์ภาพถ่าย 
ค. การสร้างและการจัดการภาพกราฟิกโดยใช้คอมพิวเตอร์ 
ง. การสร้างงานโดยใช้สมาร์ทโฟน 

2. โปรแกรม Photoshop ใช้ส าหรับท าอะไร ? 

  

ก. ใช้ส าหรับตัดต่อวีดิโอ 
ข. ใช้ส าหรับเขียนโปรแกรม 
ค. ใช้ส าหรับถ่ายภาพ 
ง. ใช้ส าหรับตกแต่งภาพถ่ายและภาพกราฟิก 

3. เมนู File หมายถึงอะไร ? 

  

ก. รวมค าส่ังท่ีใช้ส าหรับแก้ไขภาพ 
ข. รวมค าสั่งที่ใช้จัดการกับไฟล์รูปภาพ 
ค. รวมค าส่ังท่ีใช้ปรับแต่งภาพ 
ง. รวมค าส่ังท่ีใช้จัดการกับเลเยอร์ 

4. เมนู Edit หมายถึงอะไร ? 

  ก. รวมค าสั่งที่ใช้ส าหรับแก้ไขภาพ 
ข. รวมค าส่ังท่ีใช้จัดการกับไฟล์รูปภาพ 
ค. รวมค าส่ังท่ีใช้ปรับแต่งภาพ 
ง. รวมค าส่ังท่ีใช้จัดการกับเลเยอร์ 

5. เมนู Image หมายถึงอะไร ? 

  

ก. รวมค าส่ังท่ีใช้ส าหรับแก้ไขภาพ 
ข. รวมค าส่ังท่ีใช้จัดการกับไฟล์รูปภาพ 
ค. รวมค าสั่งที่ใช้ปรับแต่งภาพ 
ง. รวมค าส่ังท่ีใช้จัดการกับเลเยอร์ 
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6. 

 
 
ข้อใดคือไฟล์ท่ีใช้เก็บภาพแบบราสเตอร์คุณภาพสูง เช่น ภาพกราฟิกท่ีน าไป
ท างานด้านสิ่งพิมพ ์? 

 

ก. ไฟล์ .jpg 
ข. ไฟล์ .gif 
ค. ไฟล์ .tiff 
ง. ไฟล์ .psd 

7. ถ้านักเรียนต้องการกลับมาแก้ไขงานท่ีนักเรียนยังท าไม่เสร็จ ต้องเลือกบันทึก
งานเป็นนามสกุลอะไร ? 

  

ก. JPEG (*JPEG,*JPE,*JPG) 
ข. Photoshop (*PSD,*PDD) 
ค. Photoshop PDF (*PDF,*PDP) 
ง. CompuServe GIF (*GIF) 

8. ถ้านักเรียนต้องการน ารูปภาพท่ีตกแต่งเรียบร้อยแล้วไปลงเว็บไซต์ต่างๆ 
นักเรียนต้องเลือกบันทึกงานเป็นนามสกุลอะไร ? 

  

ก. JPEG (*JPEG,*JPE,*JPG) 
ข. Photoshop (*PSD,*PDD) 
ค. Photoshop PDF (*PDF,*PDP) 
ง. ไม่มีข้อถูก 

9. ภาพกราฟิกประเภทใด มีส่วนโค้ง เว้า มุม แสง ความลึก มีลักษณะการมองภาพ
ท่ีเหมือนจริง ? 

  

ก. 1 มิติ 
ข. 2 มิติ 
ค. 3 มิต ิ
ง. 4 มิติ 
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10. ค าส่ังใด คือ การบันทึกไฟล์ข้อมูลส าหรับท าส าเนา เพื่อไม่ให้ทับไฟล์เดิม ? 

  

ก. File > Save As 
ข. Insert > Save As 
ค. View > Save 
ง. Edit > Save 

11. ไฟล์ภาพกราฟิกแบบใด เป็นภาพนิ่งพื้นหลังโปร่งใส ? 

  

ก. BMP 
ข. PNG 
ค. JPG 
ง. PSD 

12. หากต้องการคัดลอก ต้องกดค าส่ังใด ? 

  

ก. Ctrl + C 
ข. Ctrl + V 
ค. Ctrl + Z 
ง. Ctrl + B 

13. การเติมสีสันหรือปรับแก้ไขสีในรูปควรใช้ค าส่ังอะไร ? 

  

ก. Image > Photo filter… 
ข. Image > Color lookup… 
ค. Image > Curves... 
ง. Image > Color Balance... 

14. ระบบสีแบบใดที่ตามหลักการเป็นการแสดงผลทางคอมพิวเตอร์ ? 

  

ก. ระบบส ีCMYK 
ข. ระบบสี RGB 
ค. ระบบส ีLAB 
ง. ระบบสี HSB 
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15. ระบบสีใดที่เป็นระบบสีมาตรฐานเหมาะกับงานพิมพ์ เช่น ป้ายไวนิล แผ่นพับ ? 

  

ก. ระบบสี CMYK 
ข. ระบบส ีRGB 
ค. ระบบส ีLAB 
ง. ระบบสี HSB 

 
16. 

 
จุดเล็กๆ หลายๆจุดที่มาเรียงตัวกัน เป็นภาพกราฟิก ซึ่งจุดเล็กๆนั้น เราเรียกว่า
อะไร ? 

  

ก. บิตแมพ 
ข. เวคเตอร์ 
ค. พิกเซล 
ง. จุดภาพ 

17. หากคลิกขวา Layer ท่ีชื่อ Background และเลือก Duplicate Layer.. จะเกิด
อะไรขึ้น ? 

  

ก. วิธีเพ่ิมภาพพื้นหลัง 
ข. เปิดภาพ Background 
ค. วิธีนี้เป็นการ Copy Layer ที่ชื่อ Background 
ง. วิธีเพ่ิม Layer 

18. ข้อใดเป็นนามสกุลภาพเคลื่อนไหว ? 

  

ก. JPG 
ข. GIF 
ค. PNG 
ง. PSD 
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19. เมื่อคลิกลงบนพื้นหลังท่ีต้องการ จะปรากฏเส้นประล้อมรอบพื้นท่ี ๆ ท่ีเราเลือก
ไว้ นั้นหมายความว่าอะไร ? 

  

ก. ก าลังเลือกพื้นที่นั้นอยู ่
ข. ก าลังตัดภาพ 
ค. เลือกพื้นท่ีท่ีไม่มีอยู่ 
ง. เลือกอุปกรณ์ 

20. ข้อใดต่อไปนี้ คือ ขั้นตอนการบันทึกรูปภาพให้พื้นรูปภาพเป็นแบบ
ภาพเคลื่อนไหว? 

  

ก. File -> Open… 
ข. File -> Save 
ค. File -> Save As… 
ง. File -> Save for Web… 

 
21. 

 
เมื่อต้องการสร้าง Selection เป็นรูปสี่เหลี่ยมให้กับรูปภาพท่ีเราต้องการต้อง
เลือกใช้เครื่องมือใด ? 

  

ก. Rectangular Marquee Tool 
ข. Elliptical Marquee Tool 
ค. Single Rom Marquee Tool 
ง. Single Column Marquee Tool 

22. เมื่อคลิกเมาส์ท่ีเมนู Select -> Inverse เพ่ือกระท าสิ่งใด ? 

  

ก. เพ่ือท าการขยายขนาดส่วนท่ีเราได้เลือกไว้ 
ข. เพ่ือท าการกลับส่วนที่เราได้เลือกไว้เป็นตรงกันขา้ม 
ค. เพ่ือท าการลดขนาดส่วนท่ีเราได้เลือกไว้ 
ง. เพ่ือท าการยกเลิกส่วนท่ีเราได้เลือกไว้ 
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23. การเทสีลงในส่วนของกรอบภาพควรใช้เคร่ืองมือใด ? 

  

ก. Gradient Tool 
ข. 3D Material Drop Tool 
ค. History Brush 
ง. Paint Bucket Tool 

24. Toolbox คืออะไร ? 

  

ก. กล่องที่รวบรวมเครื่องมือในการวาด ตกแต่ง แก้ไขภาพ 
ข. กลุ่มหน้าต่างท่ีรวมคุณสมบัติของเคร่ืองมือ 
ค. การซ้อนทับกันของภาพเป็นชั้น ๆ 
ง. แถบส าหรับควบคุมโปรแกรม 

25. ข้อใด ไม่ใช่  ความสามารถของโปรแกรม Photoshop ? 

  

ก. รีทัช ลบสิวและริ้วรอย 
ข. ตัดต่อภาพ 
ค. ตกแต่งภาพ 
ง. ตัดต่อ VDO หนังสั้น 

 
26. 

 
การเปิดไฟล์รูปภาพ ปกติแล้วควรใช้ค าสั่งใด ? 

  

ก. ใช้ค าสั่ง File -> Open 
ข. ใช้ค าสั่ง File -> New 
ค. ใช้ค าสั่ง File -> Save 
ง. ใช้ค าสั่ง File -> Save As 

27. ใช้เครื่องมือใดต่อไปนี้เพื่อลากตามเส้นของภาพท่ีต้องการตัดต่อเพื่อลบพ้ืนหลังท่ี
มีสีตัดกันอย่างชัดเจน ? 

  

ก. Quick Selection Tools 
ข. Magic wand Tool 
ค. History Brush 
ง. Paint Bucket Tool 
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28. การปรับย่อ/ขยายขนาดรูปภาพ สามารถใช้ปุ่มลัดใด ? 

  

ก. กด Ctrl + V 
ข. กด Ctrl + T 
ค. กด Ctrl + C 
ง. กด Ctrl + S 

29. ข้อใดคือเครื่องมือส าหรับเลือกพื้นท่ีเป็นตัวอักษรในแนวนอนแบบพิมพ์ปกติ ? 

  

ก. Horizontal Type Tool 
ข. Vertical Type Tool 
ค. Horizontal Type Mask Tool 
ง. Vertical Type Mask Tool 

30. หากต้องการตกแต่งภาพด้วยเทคนิคพิเศษ เช่น แปลงภาพถ่ายเป็นภาพวาด
การ์ตูน ต้องไปท่ีค าส่ังใด ? 

  

ก. Selection 
ข. Filter 
ค. Transform 
ง. Liquify 

31. การปรับขนาดของภาพใช้เมนูใด? 

  

ก. Image > Image Size 
ข. Image > Picture 
ค. Image > Size 
ง. Image > Rotate 

  

32. ระบบส ีGrayscale มักจะใช้กับภาพแบบใด?  

  

ก. ภาพกราฟิกส าหรับลงเว็บไซต์ 
ข. ภาพส าหรับงานพิมพ์ไวนิล 
ค. ภาพส าหรับงานพิมพ์ขาว-ด า 
ง. ภาพกราฟิกแบบเคลื่อนไหว 
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33. Resolution คืออะไร ? 

  

ก. ความสูงของภาพ 
ข. ความยาวของภาพ 
ค. ความละเอียดของภาพ 
ง. ความกว้างและความยาวของภาพ 

  

34. การตั้งค่าขนาดของภาพเป็นขนาด A4 ในโปรแกรม Adobe Photoshop ต้อง
เลือกข้อใด? 

  

ก. Web 
ข. International Paper 
ค. Clibboard 
ง. Flim & Viedio 

  

35. กลุ่มของหน้าต่างท่ีรวบรวมคุณสมบัติการท างานของเคร่ืองมือ  เรียกว่าอะไร ? 

  

ก. Toolbox 
ข. Palette 
ค. Layers 
ง. menu 

  

36. การเพ่ิมหรือสร้างเลเยอร์ใหม่ ควรคลิกท่ีไอคอนใด ? 

  

ก. Duplicate Layer 
ข. Move Layer 
ค. Create a new Layer 
ง. Lock and Unlock Layer 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆท้ังสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกคร้ังที่มีการนำไปใช้



91 
 

  

37. ข้อคือหน้าท่ีของ Elliptical Marquee Tool ? 

  

ก. ใช้สร้างหรือเลือกพื้นท่ีในลักษณะเป็นพ้ืนท่ีสี่เหลี่ยม 
ข. ใช้สร้างหรือเลือกพื้นที่ในลักษณะเป็นพื้นที่วงกลมหรือวงรี 
ค. ใช้สร้างหรือเลือกพื้นท่ีในแนวนอน 
ง. ใช้สร้างหรือเลือกพื้นท่ีในแนวตั้ง 

  

38. ข้อใดคือเอฟเฟคใน Layer Style ท่ีเราใช้ส าหรับเติมสีเส้นกรอบให้กับวัตถุ ? 

  

ก. Drop Shadow 
ข. Outer Glow 
ค. Satin        
ง. Stroke 

  

39. เคร่ืองมือใดที่ใช้สร้างรูปดาวหรือหัวใจ ? 

  

ก. Rectangle Tool  
ข. Ellipse Tool  
ค. Polygon Tool  
ง. Custom Tool 

  

40. ข้อใดคือเอฟเฟคใน Layer Style ท่ีเราใช้ส าหรับใส่เงาให้กับวัตถุ ? 

  

ก. Drop Shadow 
ข. Outer Glow 
ค. Satin 
ง. Stroke 

  

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆท้ังสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกคร้ังที่มีการนำไปใช้
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ภาคผนวก ฉ 
ผลการประเมินความสอดคล้อง ความยากง่าย อ านาจจ าแนก และความเชื่อมั่น 

ของแบบทดสอบวัดผลสมัฤทธิท์างการเรียน 
 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆท้ังสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกคร้ังที่มีการนำไปใช้



93 
 

ผลการประเมินความสอดคล้องของข้อค าถามกับจุดประสงค์การเรียนรู้ 
ของแบบทดสอบวัดผลสมัฤทธิท์างการเรียน 

 
ตารางท่ี  ฉ.1  ผลการประเมินความสอดคล้อง (IOC) ของแบบวัดผลฤทธิ์ทางการเรียน 

ข้อที่ 
ความคิดเห็นของผู้ทรงคุณวุฒิ 

IOC ความหมาย 
คนที่ 1 คนที่ 2 คนที่ 3 

1 1 1 1 1.00 ตรงตามวัตถุประสงค์ 

2 0 1 1 0.67 ตรงตามวัตถุประสงค์ 

3 1 1 1 1.00 ตรงตามวัตถุประสงค์ 

4 1 1 1 1.00 ตรงตามวัตถุประสงค์ 

5 1 1 1 1.00 ตรงตามวัตถุประสงค์ 

6 1 1 1 1.00 ตรงตามวัตถุประสงค์ 

7 1 1 1 1.00 ตรงตามวัตถุประสงค์ 

8 1 1 1 1.00 ตรงตามวัตถุประสงค์ 

9 0 1 1 0.67 ตรงตามวัตถุประสงค์ 

10 1 1 1 1.00 ตรงตามวัตถุประสงค์ 

11 1 1 1 1.00 ตรงตามวัตถุประสงค์ 

12 1 1 1 1.00 ตรงตามวัตถุประสงค์ 

13 0 1 1 0.67 ตรงตามวัตถุประสงค์ 

14 1 1 1 1.00 ตรงตามวัตถุประสงค์ 

15 1 1 1 1.00 ตรงตามวัตถุประสงค์ 

16 1 1 1 1.00 ตรงตามวัตถุประสงค์ 

17 1 1 1 1.00 ตรงตามวัตถุประสงค์ 

18 1 1 1 1.00 ตรงตามวัตถุประสงค์ 

19 1 1 1 1.00 ตรงตามวัตถุประสงค์ 

20 1 1 1 1.00 ตรงตามวัตถุประสงค์ 

21 1 1 1 1.00 ตรงตามวัตถุประสงค์ 
  

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆท้ังสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกคร้ังที่มีการนำไปใช้
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ตารางท่ี  ฉ.1  (ต่อ) 

ข้อที่ 
ความคิดเห็นของผู้ทรงคุณวุฒิ 

IOC ความหมาย 
คนที่ 1 คนที่ 2 คนที่ 3 

22 1 1 1 1.00 ตรงตามวัตถุประสงค์ 

23 1 1 1 1.00 ตรงตามวัตถุประสงค์ 

24 1 1 1 1.00 ตรงตามวัตถุประสงค์ 

25 1 1 1 1.00 ตรงตามวัตถุประสงค์ 

26 1 1 1 1.00 ตรงตามวัตถุประสงค์ 

27 1 1 1 1.00 ตรงตามวัตถุประสงค์ 

28 1 1 1 1.00 ตรงตามวัตถุประสงค์ 

29 1 1 1 1.00 ตรงตามวัตถุประสงค์ 

30 1 1 1 1.00 ตรงตามวัตถุประสงค์ 

31 1 1 1 1.00 ตรงตามวัตถุประสงค์ 

32 1 1 1 1.00 ตรงตามวัตถุประสงค์ 

33 1 1 1 1.00 ตรงตามวัตถุประสงค์ 

34 1 1 1 1.00 ตรงตามวัตถุประสงค์ 

35 1 1 1 1.00 ตรงตามวัตถุประสงค์ 

36 1 1 1 1.00 ตรงตามวัตถุประสงค์ 

37 1 1 1 1.00 ตรงตามวัตถุประสงค์ 

38 1 1 1 1.00 ตรงตามวัตถุประสงค์ 

39 1 1 1 1.00 ตรงตามวัตถุประสงค์ 

40 1 1 1 1.00 ตรงตามวัตถุประสงค์ 
 

  
  

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆท้ังสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกคร้ังที่มีการนำไปใช้
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ผลการหาความยากง่าย อ านาจจ าแนก และความเชื่อมั่น 

ของแบบทดสอบวัดผลสมัฤทธิท์างการเรียน 
 

ตารางท่ี  ฉ.2  ค่าความยากง่าย  (p)  ค่าอ านาจจ าแนก  (r)  ของข้อสอบผ่านการวิเคราะห์ความ 

           เที่ยงตรงเชิงเนื้อหามาแล้วจ านวน 40 ข้อ 

ข้อที่ p 
ความหมายค่าความ

ยากง่าย 
r 

ความหมายค่า
อ านาจจ าแนก 

ประเมิน 

1 0.77 ค่อนข้างง่าย 0.48 จ าแนกสูง ผ่านเกณฑ*์ 
2 0.73 ค่อนข้างง่าย 0.41 จ าแนกสูง ผ่านเกณฑ*์ 
3 0.57 ปานกลาง 0.47 จ าแนกสูง ผ่านเกณฑ*์ 
4 0.67 ค่อนข้างง่าย 0.70 จ าแนกสูง ผ่านเกณฑ*์ 
5 0.57 ปานกลาง 0.47 จ าแนกสูง ผ่านเกณฑ*์ 
6 0.63 ค่อนข้างง่าย 0.78 จ าแนกสูง ผ่านเกณฑ*์ 
7 0.73 ค่อนข้างง่าย 0.68 จ าแนกสูง ผ่านเกณฑ*์ 
8 0.63 ค่อนข้างง่าย 0.72 จ าแนกสูง ผ่านเกณฑ*์ 
9 0.73 ค่อนข้างง่าย 0.68 จ าแนกสูง ผ่านเกณฑ*์ 
10 0.73 ค่อนข้างง่าย 0.60 จ าแนกสูง ผ่านเกณฑ*์ 
11 0.80 ง่ายมาก 0.56 จ าแนกปานกลาง ผ่านเกณฑ*์ 
12 0.80 ง่ายมาก 0.56 จ าแนกสูง ผ่านเกณฑ*์ 
13 0.70 ค่อนข้างง่าย 0.77 จ าแนกสูง ผ่านเกณฑ*์ 
14 0.63 ค่อนข้างง่าย 0.78 จ าแนกสูง ผ่านเกณฑ*์ 
15 0.60 ค่อนข้างง่าย 0.67 จ าแนกปานกลาง ผ่านเกณฑ*์ 
16 0.63 ค่อนข้างง่าย 0.72 จ าแนกสูง ผ่านเกณฑ*์ 
17 0.80 ง่ายมาก 0.56 จ าแนกสูง ผ่านเกณฑ*์ 
18 0.77 ค่อนข้างง่าย 0.36 จ าแนกสูง ผ่านเกณฑ*์ 
19 0.67 ค่อนข้างง่าย 0.77 จ าแนกสูง ผ่านเกณฑ*์ 
20 0.60 ค่อนข้างง่าย 0.77 จ าแนกสูง ผ่านเกณฑ*์ 
21 0.67 ค่อนข้างง่าย 0.53 จ าแนกสูง ผ่านเกณฑ*์ 

  

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆท้ังสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกคร้ังที่มีการนำไปใช้
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ตารางท่ี  ฉ.2  (ต่อ) 
ข้อที่ ค่าความ

ยากยาก
ง่าย 

แปลความหมาย 
ความยากง่าย 

ค่าอ านาจ
จ าแนก 

แปลความหมาย
อ านาจจ าแนก 

ประเมิน 

22 0.63 ค่อนข้างง่าย 0.78 จ าแนกสูง ผ่านเกณฑ*์ 
23 0.73 ค่อนข้างง่าย 0.41 จ าแนกสูง ผ่านเกณฑ*์ 
24 0.70 ปานกลาง 0.58 จ าแนกสูง ผ่านเกณฑ*์ 
25 0.73 ค่อนข้างง่าย 0.68 จ าแนกสูง ผ่านเกณฑ*์ 
26 0.63 ค่อนข้างง่าย 0.78 จ าแนกสูง ผ่านเกณฑ*์ 
27 0.77 ค่อนข้างง่าย 0.48 จ าแนกสูง ผ่านเกณฑ*์ 
28 0.63 ค่อนข้างง่าย 0.72 จ าแนกสูง ผ่านเกณฑ*์ 
29 0.73 ค่อนข้างง่าย 0.68 จ าแนกสูง ผ่านเกณฑ*์ 
30 0.63 ปานกลาง 0.78 จ าแนกสูง ผ่านเกณฑ*์ 
31 0.73 ค่อนข้างง่าย 0.68 จ าแนกสูง ผ่านเกณฑ*์ 
32 0.73 ค่อนข้างง่าย 0.68 จ าแนกสูง ผ่านเกณฑ*์ 
33 0.57 ปานกลาง 0.47 จ าแนกสูง ผ่านเกณฑ*์ 
34 0.73 ค่อนข้างง่าย 0.38 จ าแนกปานกลาง ผ่านเกณฑ*์ 
35 0.70 ค่อนข้างง่าย 0.52 จ าแนกสูง ผ่านเกณฑ*์ 
36 0.73 ค่อนข้างง่าย 0.38 จ าแนกปานกลาง ผ่านเกณฑ*์ 
37 0.57 ปานกลาง 0.47 จ าแนกสูง ผ่านเกณฑ*์ 
38 0.77 ค่อนข้างง่าย 0.48 จ าแนกสูง ผ่านเกณฑ*์ 
39 0.67 ค่อนข้างง่าย 0.70 จ าแนกสูง ผ่านเกณฑ*์ 
40 0.57 ปานกลาง 0.47 จ าแนกสูง ผ่านเกณฑ*์ 

 
 

 
 
 
 
 
 
 
 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆท้ังสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกคร้ังที่มีการนำไปใช้
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ภาคผนวก ช 
ผลการเปรียบเทียบผลสัมฤทธิ์ทางการเรียน 

  

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆท้ังสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกคร้ังที่มีการนำไปใช้
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ผลการเปรียบเทียบผลสัมฤทธิ์ทางการเรียนของนักเรียนก่อนเรียนและหลังเรียน 
เร่ือง โปรแกรมคอมพิวเตอร์กราฟิกเบื้องต้น ของนักเรียนชั้นมัธยมศึกษาปีที ่1 

 
ตารางท่ี  ช.1  คะแนนที่ได้จากการท าแบบวัดผลสัมฤทธิ์ทางการเรียน ก่อนและหลังเรียน 

คนที่ 
คะแนนก่อนเรียน 

คะแนนเต็ม  30  คะแนน 
คะแนนหลังเรียน 

คะแนนเต็ม  30  คะแนน 
1 6 22 
2 10 20 
3 7 27 
4 13 24 
5 9 26 
6 6 23 
7 20 29 
8 9 24 
9 5 21 
10 12 22 
11 13 23 
12 6 24 
13 12 26 
14 9 17 
15 7 27 
16 14 22 
17 7 22 
18 5 24 
19 8 23 
20 14 27 
21 7 19 
22 16 25 
23 5 22 
24 23 25 

  

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 

ไม่ว่ากรณีใดๆท้ังสิ้น อีกทั้งห้ามมิให้ดัดแปลงเนื้อหา และต้องอ้างอิงถึงเจ้าของเอกสารทุกคร้ังที่มีการนำไปใช้
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ตารางท่ี  ช.1  (ต่อ) 

คนที่ 
คะแนนก่อนเรียน 

คะแนนเต็ม  30  คะแนน 
คะแนนหลังเรียน 

คะแนนเต็ม  30  คะแนน 
25 10 24 
26 6 27 
27 14 25 
28 9 26 
29 11 27 
30 12 28 
31 11 29 
32 9 21 
33 14 21 
34 9 26 
35 8 27 
36 5 18 
37 16 29 
38 5 27 
39 8 26 
40 12 16 
รวม 402 961 
เฉลี่ย 10.05 24.03 

S 4.19 3.27 
 

จากตารางที่  ช.1  พบว่าคะแนนก่อนเรียนและหลังเรียนด้วยบทเรียนผ่านเครือข่าย
อินเทอร์เน็ต เรื่อง โปรแกรมคอมพิวเตอร์กราฟิกเบื้องต้น ของนักเรียนชั้นมัธยมศึกษาปีที่ 1 มีค่าเฉลี่ย
คะแนนก่อนเรียนเท่ากับ 10.05 และค่าเฉลี่ยคะแนนหลังเรียน เท่ากับ 24.03 เมื่อน าไปวิเคราะห์ 
ทางสถิติ (t-test dependent sample) ปรากฏว่านักเรียนมีคะแนนหลังเรียนสูงกว่าก่อนเรียน 
อย่างมีนัยส าคัญทางสถิติที่ระดับ .01 

 
 
 
 
 

เอกสารนี้เป็นเอกสารที่สงวนไว้สำหรับการใช้งานเพื่อการศึกษาเท่านั้น ไม่อนุญาตให้นำไปใช้ประโยชน์ด้านการค้า 
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ประวัติผู้เขียน 
 

ชื่อ-สกุล     นายยงยุทธ ธวัชวงษ์ 

วัน-เดือน-ปีเกิด    17 เมษายน 2527 

สถานที่เกิด    นครสวรรค์ 

สถานที่ท างานปัจจุบัน   โรงเรียนอนุบาลเมืองนครสวรรค์ (เขากบ วิวรณ์สุขวิทยา) 

ต าแหน่ง ข้าราชการครู 

ประวัติการศึกษา                  ปี 2550  
 ส าเร็จการศึกษาวิทยาศาสตรบัณฑิต (วท.บ.) 
 สาขาวิทยาการคอมพิวเตอร์ คณะวิทยาศาสตร์ 
 มหาวิทยาลัยราชภัฏอุบลราชธานี 

 ปี 2554 
 ส าเร็จการศึกษาหลักสูตรประกาศนียบัตรบัณฑิตวิชาชีพครู 
 คณะครุศาสตร์ มหาวิทยาลัยราชภัฏนครสวรรค์ 
 โดยได้รับทุนส่งเสริมการผลิตครูที่มีความรู้ความสามารถพิเศษ 
 ทางวิทยาศาสตร์และคณิตศาสตร์ (สควค.) 
 จากสถาบันส่งเสริมการสอนวิทยาศาสตร์และเทคโนโลยี (สสวท.) 

 ปี 2562 
 ส าเร็จการศึกษาวิทยาศาสตรมหาบัณฑิต (วท.ม.) 
 สาขาวิชาการศึกษาวิทยาศาสตร์ (คอมพิวเตอร์) 
 คณะครุศาสตร์อุตสาหกรรมและเทคโนโลยี 
 สถาบันเทคโนโลยีพระจอมเกล้าเจ้าคุณทหารลาดกระบัง 
 โดยได้รับทุนส่งเสริมการผลิตครูที่มีความรู้ความสามารถพิเศษ 
 ทางวิทยาศาสตร์และคณิตศาสตร์ (สควค.) 
 จากสถาบันส่งเสริมการสอนวิทยาศาสตร์และเทคโนโลยี (สสวท.) 
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